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En esta sección se muestra un ejemplo de la configuración del sistema de la cámara.

Descripción general

Configuración del sistema

ECM-MS2
Micrófono

SELP28135G
SEL1635Z
SELP18200
Objetivo

UWP-D11, 
UWP-D12
Paquete de 
micrófono 
inalámbrico

HVL-LBPC
Luz de vídeo

PXW-FS7

RMT-845
Control remoto de 
infrarrojos (suministrado)

LA-EA3, 
LA-EA4
Adaptador de 
montura A

IFU-WLM3
Módulo LAN inalámbrico USB 
(suministrado)

VCT-FS7
Adaptador para los 
hombros

Series S/N/H/G
Tarjeta de memoria XQD

MRW-E80
Lector de tarjetas 
XQD

HXR-IFR5
Unidad de 
interfaz

BC-U1, BC-U2
Cargador de batería
(BC-U1 suministrada)

BP-U30, BP-U60, 
BP-U60T, BP-U90
Batería 
(BP-U30 suministrada)

Adaptador de CA 
(suministrado)1)

XDCA-FS7
Unidad de 
extensión

BP-L80S, BP-FL75
Batería

Adaptador 
inalámbrico
CBK-WA100

AXS-R5
Grabadora 
de 
memoria 
portátil

1) MPA-AC1 (modelo exclusivo para EE. UU. y Canadá)
AC-NB12A (modelo no disponible en EE. UU. y Canadá)

Control remoto de la 
empuñadura (suministrado)

SMAD-P3
Adaptador de 
la zapata de 
interfaces 
múltiples

XLR-K2M
Kit de 
Adaptador 
de XLR



Para obtener más información acerca del uso y las funciones de cada componente, consulte la página a la que 
se haga referencia.

1. Asa (página 8)

2. Conector del visor (página 21)

3. Conector REMOTE (página 24)

4. Interruptor INPUT1 (LINE/MIC/
MIC+48V) (página 43)

5. Interruptor INPUT2 (LINE/MIC/
MIC+48V) (página 43)

6. Acoplamiento de la empuñadura 
(página 24)

7. Conector del módulo LAN inalámbrico 
USB

8. Indicador de grabación (página 95)
Parpadea cuando la capacidad restante del 
soporte de grabación o de la batería es baja.

9. Gancho para cinta métrica
El gancho para cinta métrica está situado en el 
mismo plano que el sensor de imagen. Para 
medir la distancia entre el camcorder y el sujeto 
de forma precisa, utilice este gancho como 
punto de referencia. Puede unir el extremo de la 
cinta métrica al gancho para medir la distancia 
desde el sujeto.

10. Botón WB SET (ajuste del balance de 
blancos) (página 42)

11. Pasador de bloqueo del objetivo 
(página 23)

12. Botón de liberación del objetivo 
(página 23)

13. Zapata para accesorios

14. Botón de grabación del asa START/STOP
El botón de grabación no se puede utilizar 
cuando la palanca de bloqueo está en la posición 
de bloqueo.

15. Palanca de zoom del asa (página 67)

16. Zapata de interfaz múltiple

Para obtener más información acerca de los 
accesorios compatibles con la zapata de interfaz 
múltiple, póngase en contacto con su 
representante de ventas.

Ubicación y función de los componentes

WB
 SE
T
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Acople de la zapata para accesorios
1 Levante el borde delantero del muelle de la zapata y 

tire del muelle en la dirección opuesta a la flecha que 
se encuentra grabada en este.

2 Sitúe la zapata para accesorios en la montura de la 
zapata para accesorios, alineando los salientes de la 
zapata con los puntos correspondientes de la montura, 
y apriete los cuatro tornillos.

3 Introduzca el muelle de la zapata en la dirección de la 
flecha de modo que la parte en forma de U encaje en 
el extremo de la zapata para accesorios.

Extracción de la zapata para accesorios
Extraiga la zapata para accesorios tal y como se 
describe en el paso 1 de la sección “Acople de la 
zapata para accesorios”, afloje los cuatro tornillos 
y extraiga la zapata para accesorios.

Acoplamiento de la placa de protección del 
módulo LAN inalámbrico
1 Extraiga el tornillo de acoplamiento al asa.
2 Acople la placa de protección y apriete el tornillo.
 

Extracción del asa
Retire los cuatro tornillos de acoplamiento del asa 
y extraiga el asa del camcorder.

Colocación de la tapa protectora del conector del 
asa (suministrada)
Cuando utilice el camcorder sin el asa, proteja el 
conector con la tapa protectora del conector.

Protección de los terminales de los conectores
Acople la cubierta en conectores que no se 
utilicen para proteger los terminales de los 
conectores.

Muelle de la zapata

Zapata para accesorios

Muelle de la 
zapata

Zapata para 
accesorios

1 2
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1. Botón START/STOP

2. Dial ND FILTER (página 41)

3. Botones ASSIGN (asignables) del 1 al 3 
(página 45)

4. Botón PUSH AUTO IRIS (página 41)

5. Botón PUSH AUTO FOCUS (página 39)

6. Interruptor FOCUS (página 38)

7. Botón DISPLAY (página 13)

8. Botón FULL AUTO (página 37)

9. Interruptor POWER (página 18)

10. Dial IRIS (página 45)

11. Botón STATUS CHECK (página 15)

12. Interruptor HOLD (página 95)

13. Interruptor CH1 LEVEL CONTROL 
(página 43)

14. Dial CH1 INPUT LEVEL (página 43)

15. Interruptor CH2 LEVEL CONTROL
(página 43)

16. Dial CH2 INPUT LEVEL (página 43)

17. Botón SLOT SELECT (selección de la 
tarjeta de memoria XQD) (página 29)

18. Botón CANCEL/BACK (página 56)

19. Botón MENU (página 58)

20. Botón THUMBNAIL (página 55)

21. Botón derecho
Se utiliza para definir valores numéricos y 
mover el cursor hacia la derecha en las pantallas 
de miniaturas y menús. 

22. Dial SEL/SET (seleccionar/definir)
Gire el dial para mover el cursor hacia arriba y 
hacia abajo para seleccionar elementos o ajustes 
del menú. Pulse para aplicar el elemento 
seleccionado.

23. Botón izquierdo
Se utiliza para definir valores numéricos y 
mover el cursor hacia la izquierda en pantallas 
con miniaturas y menús.

24. Botón SHUTTER (página 41)

25. Interruptor WHT BAL (selección de 
memoria de balance de blancos) 
(página 42)

26. Botón WHT BAL (balance de blancos) 
(página 42)

27. Interruptor GAIN (selección de ganancia) 
(página 41)

28. Botón ISO/Gain (página 41)
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1. Conector para auriculares (página 39)

2. Ranura A de la tarjeta XQD (página 29)

3. Ranura de tarjeta UTILITY SD 
(página 30)

4. Indicador de acceso XQD (A) (página 29)

5. Indicador de acceso de la tarjeta SD 
(página 30)

6. Indicador de acceso XQD (B) (página 29)

7. Conector USB
Conéctese a un ordenador con un cable USB 
para acceder a los soportes de grabación en una 
ranura de tarjeta XQD del camcorder.

8. Ranura B de la tarjeta XQD (página 29)

9. Altavoz integrado (página 39)

10. Botón de liberación de la tapa de soportes 
(página 29)

11. Conector de la unidad de extensión 
(página 31)

12. Indicador de grabación posterior 
(página 37)

13. Conector DC IN (página 19)

14. Botón BATT RELEASE (liberación de la 
batería) (página 18)

15. Batería (página 18)

16. Acoplamiento de la batería (página 18)

17. Sensor del receptor del control remoto de 
infrarrojos (página 34)

18. Micrófono interno (página 43)
Micrófono de narración para grabar el sonido 
ambiental.

19. Conector INPUT1 (entrada de audio 1) 
(página 43)

20. Conector INPUT2 (entrada de audio 2) 
(página 43)

21. Conector SDI OUT 1 (página 99)

22. Conector SDI OUT 2 (página 99)

23. Conector HDMI OUT (página 99)

Parte inferior
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1. Orificio para los tornillos del trípode (1/4 
pulgadas, 3/8 pulgadas)
Compatible con tornillos 1/4-20UNC y 3/8-
16UNC.
Acople la unidad a un trípode (opcional, 
longitud de tornillos 5,5 mm o inferior).

Para obtener más información acerca de la 
conexión del visor (suministrado) y el ocular, 
consulte la página 21.

1. Dial CONTRAST

2. Botón PEAKING

3. Botón ZEBRA

4. Interruptor MIRROR

5. Ganchos de conexión del ocular

Para obtener más información acerca de la 
conexión del ocular (suministrado), consulte la 
página 22.

1. Dial de ajuste dióptrico

2. Copa ocular

Para obtener más información, consulte el manual 
de funcionamiento del objetivo.

Para obtener más información acerca de la 
conexión del control remoto de la empuñadura 
(suministrado), consulte la página 24.

1. Palanca de zoom

2. Botón ASSIGN (asignable) 4

3. Dial asignable

4. Botón ASSIGN (asignable) 6

5. Botón START/STOP de grabación

6. Selector múltiple

7. Botón de rotación de la empuñadura

8. Botón ASSIGN (asignable) 5

Visor

Ocular

Objetivo (solo PXW-FS7K)

Control remoto de la empuñadura
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1. Botón DATA CODE
No se utiliza en esta versión.

2. Botón TC RESET

3. Botón SCAN/SLOW

4. Botón ./> (PREV/NEXT)

5. Botón PLAY

6. Botón STOP

7. Botón DISPLAY

8. Transmisor del control remoto

9. Botón START/STOP

10. Palanca de zoom

11. Botón PAUSE

12. Botón MODE
No se utiliza en esta versión.

13. Botón b/B/v/V/ENTER

Para obtener más información sobre la conexión 
de una unidad de extensión (opcional), consulte la 
página 31.

1. Botón BATT RELEASE

2. Conector de la batería

3. GENLOCK IN

4. DC IN

5. DC OUT

6. Indicador de grabación 

7. REF OUT

8. TC IN/OUT

9. Interruptor TC IN/OUT

10. RAW OUT

Control remoto de infrarrojos Unidad de extensión (opcional)
12



Durante la filmación (grabación/en espera) y la reproducción, el estado y la configuración del camcorder 
se superponen sobre la imagen mostrada en el visor.
Puede mostrar/ocultar la información con el botón DISPLAY.
También puede elegir si desea mostrar u ocultar cada elemento independientemente (página 81).
En el visor se muestra la imagen con relación de aspecto 17:9 capturada por el sensor de imagen. En los 
formatos de grabación de 16:9, las partes oscuras que aparecen en los bordes izquierdo y derecho no se 
graban.

Información mostrada en la pantalla durante la filmación

1. Indicador del modo del obturador/
velocidad del obturador (página 41)

2. Indicador del filtro ND (página 41)

3. Indicador de ganancia (página 41)
Se muestra como valor EI cuando Base Setting 
(página 91) >Shooting Mode en el menú 
System está ajustado en “Cine EI”.

4. Indicador de posición de enfoque
Muestra la posición de enfoque (si se acopla un 
objetivo compatible con la pantalla de 
configuración del enfoque). 

5. Modo de grabación, icono de la ranura A/
B e indicadores de estado

Visualización de la pantalla

Pantalla del visor

S&Q / zRec Grabación en modo 
movimiento a cámara 
lenta y rápida y 
velocidad de fotogramas 
alta

S&Q / Stby Modo movimiento a 
cámara lenta y rápida, y 
velocidad de fotogramas 
alta en espera

/ zRec Grabación

/ Stby En espera

/ z
Grabación de memoria 
intermedia de imágenes

/ zCache
Memoria intermedia de 
imágenes en espera
13



6. Icono de la ranura B e indicadores de 
estado

7. Indicador de grabación RAW externo 
(página 50)

8. Indicador de profundidad de campo

9. Indicador de temperatura de color 
(página 42)

10. Indicador de velocidad de fotogramas 
S&Q Motion (página 86)

11. Indicador de capacidad de batería 
restante/tensión de DC IN (página 19)

12. Indicador de formato de grabación 
(tamaño de imagen) (página 92)
Muestra el tamaño de imagen para grabaciones 
en tarjetas de memoria XQD.

13. Indicador de formato de grabación 
(velocidad de fotogramas y método de 
exploración)

14. Indicador de formato de grabación 
(códec) (página 40)
Muestra el nombre del formato de grabación en 
tarjetas de memoria XQD.

15. Indicador LUT de monitor/gamma 
(página 70, página 79)
Muestra el ajuste gamma. Cuando Shooting 
Mode (página 91) está ajustado en “Cine EI,” 
muestra el ajuste gamma o LUT del monitor 
para la grabación de vídeos en tarjetas de 
memoria XQD.

16. Indicador de formato de salida externo 
(página 78)

17. Indicador de bloqueo de código de tiempo 
externo
Muestra “EXT-LK” cuando está bloqueado con 
el código de tiempo de un dispositivo externo.

18. Indicador de estado de la conexión Wi-Fi 
(página 51)
Se muestra cuando la función Wi-Fi está 
ajustada en “Enable”. Cuando el IFU-WLM3 no 
está conectado al camcorder,  no se 
muestra.

19. Indicador de estado GPS (página 49)
Muestra el estado del GPS.

20. Indicador de enfoque asistido (página 39)
Muestra un fotograma de detección (marcador 
de la zona de enfoque) que indica el área para la 
detección del enfoque, y una barra de nivel 
(indicador de enfoque asistido) que indica el 
grado de enfoque dentro de dicha área.

21. Indicador de señal de vídeo (página 16)
Muestra una forma de onda, vectorscopio e 
histograma.

22. Indicador de capacidad restante/estado 
del soporte de la ranura A/B (página 30)
Soporte de grabación cuando el lado izquierdo 
del icono está iluminado en color naranja.
Soporte de reproducción cuando el indicador 
verde de la parte superior derecha del icono está 
encendido. 

23. Indicador de nivel de burbuja
Muestra el nivel horizontal y la pendiente 
anterior-posterior en intervalos de ±1° hasta 
±20°.

24. Medidor del nivel de audio

25. Indicador de nombre del clip (página 55)

26. Indicador de enfoque (página 39)

27. Indicador de datos de tiempo (página 44)

28. Indicador de tarjeta SD

29. Indicador de estado del control de salida 
SDI (página 99)

30. Indicador de modo de balance de blancos 
(página 42)

31. Indicador de modo AE (página 40)

32. Indicador de diafragma automático 
(página 40)

33. Indicador de AGC (página 41)

34. Indicador de obturador automático 
(página 41)

35. Indicador de modo de enfoque

36. Indicador de modo de estabilización de la 
imagen

37. Indicador de posición del zoom
Muestra la posición del zoom en el rango de 0 
(gran angular) a 99 (telefoto) (si se acopla un 
objetivo compatible con la pantalla de 
configuración de zoom).

zRec Grabación

Stby En espera

W:P Modo predeterminado

W:A Modo memoria A

W:B Modo memoria B
14



38. Indicador de posición del diafragma
Muestra la posición del diafragma (si se acopla 
un objetivo compatible con la pantalla de 
configuración del diafragma).

Información mostrada en la pantalla durante la 
reproducción
La siguiente información se superpone sobre la 
imagen reproducida.

1. Número del clip/Número total de clips

2. Modo de reproducción

3. Indicador de capacidad restante la batería

4. Indicador de formato de reproducción 
(tamaño de imagen)

5. Indicador de formato de reproducción 
(velocidad de fotogramas)

6. Indicador de formato de reproducción 
(códec)

7. Indicador de estado de la conexión Wi-Fi 
(página 51)
Se muestra cuando la función Wi-Fi está 
ajustada en “Enable”. Cuando el IFU-WLM3 
no está conectado al camcorder,  no se 
muestra.

8. Indicador de soporte

9. Indicador de nivel de audio
Muestra el nivel de audio durante la grabación.

10. Indicador de datos de tiempo
Cuando Display On/Off > Timecode en el menú 
VF está ajustado en “On”, se muestran los datos 
de tiempo al pulsar el botón DISPLAY.

Para mostrar la pantalla de estado:
• Pulse el botón STATUS CHECK.

Para cambiar a la pantalla de estado:
• Gire el dial SEL/SET.
• Mueva el selector múltiple arriba/abajo.

Para ocultar la pantalla de estado:
• Pulse el botón STATUS CHECK.

Pantalla de estado de la cámara
Muestra la configuración del obturador 
electrónico de la cámara y el estado del objetivo.

Pantalla de estado

ISO/Gain/EI<H> Ajuste de ISO/Gain/EI<H>

ISO/Gain/EI<M> Ajuste de ISO/Gain/EI<M>

ISO/Gain/EI<L> Ajuste de ISO/Gain/EI<L>

Shutter Ajuste del obturador (Speed/
Angle/ECS/Off)

Iris Valor F-stop obtenido del objetivo

Zebra1 Ajuste Zebra1 On/Off y nivel

Zebra2 Ajuste Zebra2 On/Off y nivel

Gamma Ajuste de Gamma Select

White Modo de balance de blancos y 
ajustes

Focal Length Valor de la distancia focal 
obtenida desde el objetivo

AE Level Ajuste de nivel AE

AE Speed Ajuste de velocidad de control AE

AGC Limit Ajuste de ganancia máxima de la 
función AGC

A.SHT Limit La velocidad más rápida del 
obturador en la función de 
obturador automático

AE Mode Ajuste del modo AE (Backlight/
Standard/Spotlight)
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Pantalla de estado del audio
Muestra el ajuste de entrada, el medidor del nivel 
de audio y el ajuste del filtro de reducción de 
ruido para cada canal.

Pantalla de estado del sistema
Muestra los ajustes de la señal de vídeo.

Pantalla de estado de la salida de vídeo
Muestra los ajustes de salida de vídeo, SDI y 
HDMI.

Pantalla de estado de los botones asignables
Muestra las funciones asignadas a cada uno de los 
botones asignables.

Medidor del nivel 
CH1

Medidor de nivel de audio del 
canal 1

CH1 Source Fuente de entrada del canal 1

CH1 Ref./Sens. Nivel de referencia de entrada del 
canal 1

CH1 Wind Filter Ajuste del filtro de reducción del 
ruido en el micrófono del canal 1

Medidor del nivel 
CH2

Medidor de nivel de audio del 
canal 2

CH2 Source Fuente de entrada del canal 2

CH2 Ref./Sens. Nivel de referencia de entrada del 
canal 2

CH2 Wind Filter Ajuste del filtro de reducción del 
ruido en el micrófono del canal 2

Medidor del nivel 
CH3

Medidor de nivel de audio del 
canal 3

CH3 Source Fuente de entrada del canal 3

CH3 Wind Filter Ajuste del filtro de reducción del 
ruido en el micrófono del canal 3

Medidor del nivel 
CH4

Medidor de nivel de audio del 
canal 4

CH4 Source Fuente de entrada del canal 4

CH4 Wind Filter Ajuste del filtro de reducción del 
ruido en el micrófono del canal 4

Audio Input Level Ajuste del nivel de entrada de 
audio

Monitor CH Ajuste del canal del monitor

HDMI Output CH Ajuste de la combinación del 
canal de audio de salida HDMI

Headphone Out Ajuste del tipo de salida de 
auriculares

Country Ajuste de región NTSC o PAL

Rec Format Formato para grabaciones en 
tarjetas de memoria XQD

Picture Size Tamaño de imagen para 
grabaciones en tarjetas de 
memoria XQD

Frame Rate Velocidad de fotogramas para 
grabaciones en tarjetas de 
memoria XQD

Rec Function Se habilita un formato de 
grabación y unos ajustes 
especiales

Simul Rec Estado de encendido/apagado de 
Simul Rec

Picture Cache Rec Estado de encendido/apagado de 
Picture Cache Rec

Video Light Set Indicador de encendido/apagado 
de luz de vídeo HVL-LBPC

SDI1 Tamaño de la imagen de salida
Espacio de color
Salida de visualización de la 
pantalla
Gamma

SDI2 Tamaño de la imagen de salida
Espacio de color
Salida de visualización de la 
pantalla
Gamma

HDMI Tamaño de la imagen de salida
Espacio de color
Salida de visualización de la 
pantalla
Gamma

REF Tamaño de la imagen de salida

RAW Tamaño de la imagen de salida

1 Función asignada al botón 
ASSIGN 1

2 Función asignada al botón 
ASSIGN 2

3 Función asignada al botón 
ASSIGN 3

4 Función asignada al botón 
ASSIGN 4

5 Función asignada al botón 
ASSIGN 5

6 Función asignada al botón 
ASSIGN 6

IRIS Dial Función asignada al dial IRIS

Assignable Dial Función asignada al dial asignable
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Pantalla de estado de la batería
Muestra información sobre la batería y sobre la 
fuente DC IN.

Pantalla de estado de los soportes
Muestra la capacidad y el tiempo de grabación 
restantes de los soportes de grabación (tarjetas de 
memoria XQD A y B). 

Pantalla de ajustes del botón Rec
Muestra los ajustes de los botones START/STOP 
del camcorder y el asa (página 38).

Detected Battery Tipo de batería

Remaining Capacidad restante (%)

Charge Count Número de recargas

Capacity Capacidad restante (Ah)

Voltage Tensión (V)

Manufacture Date Fecha de fabricación de la batería

Video Light 
Remaining

Muestra la capacidad restante de 
la batería de la luz de vídeo.

Power Source Fuente de alimentación

Supplied Voltage Tensión de la fuente de 
alimentación

Información del 
soporte A

Muestra el icono del soporte 
cuando el soporte de grabación se 
ha introducido en la ranura A.

Protección del 
soporte A

Muestra el icono de bloqueo 
cuando el soporte de grabación 
introducido en la ranura A está 
protegido (bloqueado).

Nota

Las tarjetas de memoria XQD no 
se pueden proteger con el 
camcorder.

Medidor de la 
capacidad restante 
del soporte A

Muestra la capacidad de grabación 
restante del soporte de grabación 
introducido en la ranura A, 
expresado en forma de porcentaje 
en un gráfico de barras.

Tiempo de 
grabación restante 
del soporte A

Muestra un cálculo del tiempo de 
grabación restante del soporte de 
grabación introducido en la ranura 
A, expresado en minutos según las 
condiciones de grabación actuales.

Información del 
soporte B

Muestra el icono del soporte 
cuando el soporte de grabación se 
ha introducido en la ranura B. 

Protección del 
soporte B

Muestra el icono de bloqueo 
cuando el soporte de grabación 
introducido en la ranura B está 
protegido (bloqueado). 

Nota

Las tarjetas de memoria XQD no 
se pueden proteger con el 
camcorder.

Medidor de la 
capacidad restante 
B

Muestra la capacidad de grabación 
restante del soporte de grabación 
introducido en la ranura B, 
expresado en forma de porcentaje 
en un gráfico de barras.

Tiempo de 
grabación restante 
del soporte B

Muestra un cálculo del tiempo de 
grabación restante del soporte de 
grabación introducido en la ranura 
B, expresado en minutos según las 
condiciones de grabación actuales.

Información de la 
tarjeta SD

Muestra el icono de soportes 
cuando se ha introducido alguno 
en la ranura de la tarjeta UTILITY 
SD. 

Protección de la 
tarjeta SD

Muestra el icono de bloqueo 
cuando el soporte introducido en 
la ranura de la tarjeta UTILITY 
SD está protegido (bloqueado). 

Medidor de la 
capacidad restante 
de la tarjeta SD

Muestra la capacidad restante del 
soporte introducido en la ranura 
de la tarjeta UTILITY SD, 
expresado en forma de porcentaje 
en un gráfico de barras.

Capacidad 
restante de la 
tarjeta SD

Muestra la capacidad restante del 
soporte introducido en la ranura 
de la tarjeta UTILITY SD, 
expresado en unidades de GB.

Vida útil de la 
tarjeta SD

Muestra la vida útil de 
funcionamiento del soporte en la 
ranura de la tarjeta UTILITY SD 
en forma de porcentaje.

Rec Button Muestra las ranuras para la 
grabación controladas por el botón 
de grabación START/STOP.

Handle Rec 
Button

Muestra las ranuras para la 
grabación controladas por el botón 
de grabación START/STOP del 
asa.
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Puede utilizar una batería o una fuente de 
alimentación de CA mediante un adaptador de 
CA.
Por su seguridad, utilice solo las baterías y los 
adaptadores de CA Sony que se enumeran a 
continuación.

Baterías de iones de litio
BP-U30 (suministrado)
BP-U60
BP-U60T
BP-U90

Cargadores de baterías
BC-U1 (suministrado)
BC-U2

Adaptador de CA (suministrado)
MPA-AC1 (modelo exclusivo para EE. UU. y 
Canadá)
AC-NB12A (modelo no disponible en EE. UU. y 
Canadá)

No guarde las baterías en lugares expuestos a la 
luz solar directa, cerca de fuegos ni a temperatura 
elevadas.

Notas

• El camcorder no recibirá alimentación de un cargador 
de batería BC-U1/BC-U2 que se utilice como fuente de 
alimentación externa.

• Cuando se utilice conectado a una toma de corriente, 
utilice el adaptador de CA suministrado.

• Ajuste siempre el interruptor POWER (Alimentación) 
en la posición de apagado antes de desconectar o 
conectar una batería o un adaptador de CA. En 
determinados casos, si el dispositivo se desconecta o se 
conecta con el interruptor POWER (Alimentación) en 
la posición de encendido, es posible que la 
videocámara no sea capaz de iniciarse. Si la 
videocámara no se puede iniciar, ajuste el interruptor 
POWER (Alimentación) en la posición de apagado y 
extraiga la batería o desconecte el adaptador de CA 
temporalmente; a continuación, espere unos 
30 segundos antes de volver a intentar conectarlos. (Si 
el adaptador de CA está desconectado o conectado 
mientras la videocámara funciona gracias a la batería, 
o viceversa, el dispositivo se puede desconectar o 
conectar con el interruptor POWER (Alimentación) en 
la posición de encendido sin problemas).

Para colocar la batería, conéctela en el 
acoplamiento (página 10) empujándolo hasta el 
tope y a continuación deslícela hacia abajo para 
que quede bloqueada en la posición final.

Para extraer la batería, mantenga pulsado el botón 
BATT RELEASE (página 10), deslícela hacia 
arriba y a continuación, tire de ella para sacarla 
del acoplamiento.

Notas

• Antes de colocar una batería, cárguela con los 
cargadores de baterías BC-U1 o BC-U2 específicos.

• Si carga la batería inmediatamente después de 
utilizarla y cuando todavía está caliente, es posible que 
no se recargue completamente.

Preparación

Fuente de alimentación

Precaución

Utilización de una batería

Botón BATT 
RELEASE
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Comprobación de la capacidad restante
Durante la filmación y la reproducción con 
batería, la capacidad de batería restante se 
muestra en el visor (página 13).

El camcorder indica la capacidad restante al 
calcular el tiempo de uso disponible con la batería 
si el uso es continuado y con el ritmo de consumo 
de energía actual.

Uso de una unidad de extensión
Cuando se utiliza la unidad de extensión XDCA-
FS7, se muestra la tensión de la batería o la 
capacidad de batería restante en función de la 
batería usada.

Nota

La batería del camcorder no se puede utilizar cuando la 
unidad XDCA-FS7 también está conectada al 
camcorder. Deberá acoplar la batería a la XDCA-FS7 o 
conectar el camcorder a una toma de alimentación 
externa.

Si el nivel de carga de la batería es bajo
Si la carga restante de la batería desciende por 
debajo de un nivel determinado durante el 
funcionamiento (Low BATT state), aparecerá un 
mensaje de batería baja, el indicador de grabación 
comenzará a parpadear y se escuchará un pitido 
de advertencia.
Si la carga restante de batería desciende por 
debajo del nivel al que el funcionamiento ya no 
puede continuar (BATT Empty state), aparecerá 
un mensaje de batería agotada.
Sustituya la batería por una batería cargada.

Cambio de los niveles de advertencia
El nivel Low BATT está ajustado en el 10% de la 
carga total de la batería y el nivel de BATT Empty 
está ajustado en el 3% de manera predeterminada. 
Puede cambiar la configuración del nivel de 
advertencia en Camera Battery Alarm 
(página 97) en el menú System.

Si el camcorder se conecta a una toma de 
corriente este se podrá utilizar sin preocuparse de 
la necesidad de recargar la batería.

Conecte el adaptador de CA al conector DC IN 
del camcorder y, a continuación, conecte el cable 
de alimentación (suministrado) a la toma de 
corriente.

Si disminuye la tensión de salida del 
adaptador de CA
Si la tensión de salida del adaptador de CA 
desciende por debajo de un determinado nivel 
durante el funcionamiento (DC Low Voltage1 
state), aparecerá un mensaje informándole de que 
la tensión ha disminuido, el indicador de 
grabación comenzará a parpadear y se escuchará 
un pitido.
Si la tensión de salida del adaptador de CA 
desciende por debajo del nivel mínimo requerido 
para el funcionamiento (DC Low Voltage2 state), 
aparecerá un mensaje informándole de que la 
tensión de salida del adaptador de CA es 
demasiado baja.
En ese caso, es posible que el adaptador de CA 
esté defectuoso. Si es necesario, verifique el 
adaptador de CA.

    Icono Capacidad restante

Entre 91% y 100%

Entre 71% y 90%

Entre 51% y 70%

Entre 31% y 50%

Entre 11% y 30%

Entre 0% y 10%

Utilización de la alimentación por 
CA

Conector DC IN

Adaptador de CA

Cable de alimentación

A la toma de corriente
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Cambio de los niveles de advertencia
El nivel DC Low Voltage1 está ajustado en 
11,5 V y el nivel DC Low Voltage2 está ajustado 
en 11,0 V de manera predeterminada de fábrica. 
Puede cambiar la configuración del nivel de 
advertencia en Camera DC IN Alarm (página 97) 
en el menú System.

Adaptadores de CA
• No conecte ni utilice un adaptador de CA en 

espacios reducidos, como por ejemplo, entre 
una pared y un mueble.

• Conecte el adaptador de CA a la toma de 
corriente más cercana. Si se produce algún 
problema durante el uso, desconecte 
inmediatamente el cable de alimentación de la 
toma de corriente.

• No provoque un cortocircuito en las piezas 
metálicas del enchufe del adaptador de CA. Si 
lo hace, provocará un fallo de funcionamiento.

• La batería no se puede cargar mientras está 
conectada al camcorder aunque el adaptador de 
CA esté conectado.

Notas

• El soporte de micrófono viene acoplado de fábrica.
• Acople o retire el soporte de micrófono mientras el 

camcorder está apagado.
• Acople o retire el soporte de micrófono con la tapa de 

la montura acoplada de manera que no se dañe el 
sensor de imagen.

1 Introduzca el soporte de micrófono en 
el asa.

2 Introduzca la pieza de cierre en la 
cavidad y apriete el tornillo para fijar el 
soporte.

Acople de dispositivos

Acople del soporte de micrófono

Pieza de 
cierre
20



Extracción del soporte de micrófono
Extraiga la pieza de cierre y siga los pasos del 
procedimiento de acople del soporte de 
micrófono en orden inverso.

Nota

Acople o retire el visor mientras el camcorder esté 
apagado.

1 Afloje la abrazadera del visor e inserte 
el visor en el saliente de la parte frontal 
del asa.

2 Ajuste el posicionamiento izquierdo/
derecho del visor, apriete la abrazadera 
y, a continuación, conecte el cable del 
visor al conector del visor del 
camcorder.

Nota

Compruebe que el visor esté conectado de forma segura. 
El visor puede caerse durante la filmación si la 
abrazadera está suelta.

Ajuste del ángulo del visor
Incline el visor hacia arriba/abajo para ajustar el 
ángulo del visor.

Puede ajustar el ángulo de manera que el visor 
esté orientado hacia el sujeto. Si se ajusta el 
interruptor MIRROR (página 47) en B/T, se 
invierten los lados izquierdo y derecho de la 
imagen en la pantalla LCD, pero la imagen se 
grabará en la orientación correcta.

Ajuste del contraste del visor
Gire el dial CONTRAST para ajustar el contraste.

Puede ajustar el brillo en el visor mediante VF 
Setting >Brightness (página 81) en el menú VF.

Extracción del visor
Afloje la abrazadera del visor y siga los pasos del 
procedimiento de acoplamiento del visor en 
orden inverso.

Acople del visor

Abrazadera
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Nota

Acople o retire el ocular mientras el camcorder está 
apagado.

1 Acople las abrazaderas de metal del 
ocular a los ganchos de conexión del 
ocular en el visor.

2 Pulse la placa de fijación en la parte 
inferior del ocular en la dirección de la 
flecha para fijar el ocular en posición.

Apertura del ocular

Pulse el botón indicado por la flecha.

Abra el ocular hacia arriba cuando se desconecta 
el bloqueo. El visor se puede ver directamente 
cuando el ocular se abre.

Extracción del ocular
Desconecte el bloqueo del ocular y extraiga el 
ocular del visor.

Acople del ocular

Ganchos de conexión del ocular

Placa de 
fijación
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Objetivos recomendados
SELP28135G
SEL1635Z
SELP18200

Para obtener más información acerca de los 
objetivos compatibles con el camcorder, póngase en 
contacto con el servicio de asistencia técnica de 
Sony.

No deje el objetivo orientado directamente al sol. 
La luz directa del sol puede penetrar a través del 
objetivo, enfocarse en el camcorder y provocar un 
incendio.

Notas

• Acople o retire los objetivos mientras el camcorder 
esté apagado.

• Los objetivos son componentes de precisión. No 
coloque los objetivos sobre una superficie dejando la 
montura de estos orientada hacia abajo. Acople la tapa 
de la montura del objetivo suministrada.

Acoplamiento en un trípode
Utilice los orificios para los tornillos del trípode 
del camcorder cuando la acople a un trípode. 
Utilizar el soporte para trípode en el objetivo 
podría ocasionar daños.

Acople de un objetivo de montura E

1 Extraiga la tapa del objetivo y la 
cubierta del camcorder y el objetivo.

2 Alinee la marca de la montura del 
objetivo (blanca) con el camcorder, 
introduzca con cuidado el objetivo y, a 
continuación, gire el objetivo en el 
sentido de las agujas del reloj.

Suena un clic cuando el objetivo se bloquea 
en su posición.

Acople de un objetivo de montura A
Para utilizar un objetivo de montura A, acople un 
adaptador de montura de objetivos (opcional) y, a 
continuación, acople el objetivo de montura A.

Notas

• Cuando utilice un objetivo de montura A, el diafragma 
se ajusta en manual.

• Cuando se ajusta el enfoque en AF con un LA-EA2 o 
LA-EA4 acoplado, el diafragma se ajusta en F3.5 o 
totalmente abierto.

Extracción de un objetivo
Extraiga un objetivo a través del siguiente 
procedimiento.

1 Mantenga pulsado el botón de 
liberación del objetivo y gire el objetivo 
en sentido contrario a las agujas del 
reloj.

2 Tire del objetivo hacia afuera en 
dirección de avance.

Nota

Si no se va a acoplar otro objetivo inmediatamente, 
ajuste la montura del objetivo en la zona de la cavidad de 
la montura del objetivo y gírelo en el sentido de las 
agujas del reloj.

Acople de un objetivo

Precaución

Marca de la montura 
(blanca)
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Ajustes de diafragma para objetivos con 
interruptor Auto Iris
• Cuando la función Auto Iris del objetivo se 

ajusta en AUTO, el diafragma se ajusta 
automáticamente y también se puede ajustar 
manualmente desde el camcorder.

• Cuando la función Auto Iris del objetivo se 
ajusta en MANUAL, el diafragma solo se puede 
ajustar usando el anillo del objetivo. El 
funcionamiento del diafragma desde el 
camcorder no tiene ningún efecto.

Ajustes de enfoque para objetivos con 
interruptor FOCUS
• Cuando el interruptor de enfoque del objetivo se 

ajusta en AF/MF o AF, el enfoque se ajusta 
automáticamente y también se puede ajustar 
manualmente desde el camcorder.

• Cuando el interruptor de enfoque del objetivo se 
ajusta en Full MF o MF, el enfoque solo se 
puede ajustar usando el anillo del objetivo. El 
funcionamiento del enfoque desde el camcorder 
no tiene ningún efecto.

Nota

Acople o retire el control remoto de la empuñadura 
mientras el camcorder esté apagado.

1 Conecte el brazo al acoplamiento de la 
empuñadura y apriete el tornillo.

2 Conecte el cable del control remoto de 
la empuñadura al conector REMOTE 
del camcorder.

Acople del control remoto de la 
empuñadura
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Notas

• Compruebe que el brazo y el control remoto de la 
empuñadura estén conectados de manera segura. 
Pueden caerse durante la filmación si los tornillos 
están sueltos.

• No apoye el peso del camcorder sujetando solamente 
el control remoto de la empuñadura.

Ajuste de la posición del control remoto 
de la empuñadura
Ajuste el ángulo del brazo (1).
Afloje los dos tornillos de la parte posterior del 
brazo con una moneda o un objeto similar, ajuste 
la longitud del brazo (2) y, a continuación, 
apriete los dos tornillos.
Pulse el botón de rotación de la empuñadura 
(página 11) para ajustar el ángulo del control 
remoto de la empuñadura (3).

Extracción del control remoto de la 
empuñadura

1 Desconecte el cable del control remoto 
de la empuñadura del conector 
REMOTE del camcorder.

2 Extraiga el brazo del camcorder.

La pantalla de ajustes iniciales aparece en el visor 
la primera vez que se enciende el camcorder o 
después de que la batería de reserva se haya 
descargado completamente.
Ajuste la fecha y la hora del reloj interno en esta 
pantalla.

Time Zone
Time Zone ajusta la diferencia horaria desde UTC 
(Tiempo Universal Coordinado). Cambie el 
ajuste según sea necesario.

Ajuste de la fecha y la hora
Gire el dial SEL/SET (página 9) para seleccionar 
elementos y ajustes y, a continuación, pulse el 
dial SEL/SET para aplicar la configuración y que 
el reloj comience a funcionar.
Después de cerrar la pantalla de ajustes, puede 
cambiar los ajustes de fecha, hora y zona horaria 
en Clock Set (página 96) en el menú System.

Notas

• Si el ajuste del reloj se pierde debido a que la batería de 
reserva se descarga totalmente por el hecho de 
permanecer desconectado durante un período 
prolongado (sin batería ni fuente de alimentación DC 
IN), se mostrará la pantalla de ajustes iniciales la 
próxima vez que encienda el camcorder.

• Mientras se muestra la pantalla de ajustes iniciales, no 
podrá realizar ninguna otra operación, excepto apagar 
el dispositivo, hasta que se completen los ajustes en 
esta pantalla.

• El camcorder dispone de una batería recargable 
incorporada que almacena la fecha, la hora y otros 
ajustes incluso cuando está apagado. Si desea obtener 
más información acerca de la batería recargable 
incorporada, consulte página 103.

Ajuste del reloj
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Antes de filmar, configure el funcionamiento 
básico del camcorder que mejor se adapte a su 
uso.

Puede cambiar el modo de filmación entre el 
modo “Custom” para crear imágenes de manera 
flexible in situ y el modo “Cine EI” (donde el 
camcorder funciona de manera similar a una 
cámara de cine y el metraje se revela en 
postproducción).
Puede seleccionar el modo en Base Setting 
(página 91) >Shooting Mode en el menú System.

El espacio de color selecciona una gama de 
colores base para las señales grabadas y las 
señales de salida.
Si el modo de filmación está ajustado en modo 
Custom, el espacio de color se ajusta en “Matrix”.

Matrix: permite seleccionar la gama de colores 
mediante el parámetro Matrix, similar a las 
cámaras de vídeo convencionales.

Si el modo de filmación está ajustado en el modo 
Cine EI, el espacio de color permite seleccionar la 
gama de colores de la salida de vídeo con el ajuste 
MLUT establecido en Off.

S-Gamut3.Cine/SLog3: gama de colores fácil de 
ajustar para el cine digital (DCIP3).

S-Gamut3/SLog3: amplia gama de colores que 
ofrece compatibilidad con gamas estándar 
futuras, optimizada con la tecnología de 
corrección de distorsión de imagen de Sony.

Puede seleccionar la gama de colores en Base 
Setting (página 91) >Color Space en el menú 
System.

El camcorder graba audio y vídeo en tarjetas de 
memoria XQD (disponibles por separado) 
introducidas en las ranuras para tarjetas.

Utilice las siguientes tarjetas de memoria XQD de 
Sony en el camcorder.
Para obtener más información sobre las 
operaciones con soportes de otros fabricantes, 
consulte las instrucciones de mantenimiento de 
dichos soportes o la información del fabricante.

Tarjetas de memoria XQD serie S

Tarjetas de memoria XQD serie H

Tarjetas de memoria XQD serie N

Tarjetas de memoria XQD serie G

No se garantiza el uso de otras tarjetas de 
memoria XQD que no sean de Sony.

Para obtener más información acerca del uso de 
tarjetas de memoria XQD y las precauciones de uso, 
consulte las instrucciones de funcionamiento de las 
tarjetas de memoria XQD.

Configuración del 
funcionamiento básico 
del camcorder

Modo de filmación

Espacio de color

Utilización de tarjetas 
de memoria XQD

Acerca de las tarjetas de memoria 
XQD
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El soporte recomendado varía según el Rec Format y los ajustes de Recording.
Sí: soportes recomendados verificados para un funcionamiento normal
No: no se garantiza un funcionamiento normal

Soportes recomendados

Formato XQD G
XQD S
(EB Stream)

XQD N Descatalogados:
XQD H
XQD S
(sin EB Stream)

32/64/128 GB 32/64 GB 16/32/64 GB

XAVC Intra 
422

4096 × 2160P – 59.94P Sí No No

50P Sí No No

29.97P Sí No No

25P Sí No No

23.98P Sí No No

3840 × 2160 – 59.94P Sí No No

50P Sí No No

29.97P Sí No No

25P Sí No No

23.98P Sí No No

1920 × 1080 Modo normal o 
S&Q (excepto HFR)

59.94P Sí No No

59.94i Sí Sí No

50P Sí No No

50i Sí Sí No

29.97P Sí Sí No

25P Sí Sí No

23.98P Sí Sí No

S&Q (modo HFR) 59.94P Sí No No

50P Sí No No

29.97P Sí No No

25P Sí No No

23.98P Sí No No
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* HFR: velocidad de fotogramas alta

XAVC-L 3840 × 2160 – 59.94P Sí Sí No

50P Sí Sí No

29.97P Sí Sí No

25P Sí Sí No

23.98P Sí Sí No

1920 × 1080 Modo normal o 
S&Q (excepto HFR)

59.94P Sí Sí Sí

50P Sí Sí Sí

59.94i Sí Sí Sí

50i Sí Sí Sí

29.97P Sí Sí Sí

25P Sí Sí Sí

23.98P Sí Sí Sí

1920 × 1080 S&Q (modo HFR) 59.94P Sí Sí No

50P Sí Sí No

29.97P
Sí

50 Mbps: No
30 Mbps: Sí

No

25P
Sí

50 Mbps: No
30 Mbps: Sí

No

23.98P
Sí

50 Mbps: No
30 Mbps: Sí

No

MPEG2 HD 
422

1920 × 1080 – 59.94i Sí Sí Sí

50i Sí Sí Sí

29.97P Sí Sí Sí

25P Sí Sí Sí

23.98P Sí Sí Sí

1280 × 720 – 59.94P Sí Sí Sí

50P Sí Sí Sí

29.97P Sí Sí Sí

25P Sí Sí Sí

23.98P Sí Sí Sí

ProRes 422 
HQ

1920 × 1080 – 59.94i Sí No No

50i Sí No No

29.97P Sí No No

25P Sí No No

23.98P Sí No No

ProRes 422 1920 × 1080 – 59.94i Sí Sí No

50i Sí Sí No

29.97P Sí Sí No

25P Sí Sí No

23.98P Sí Sí No

Formato XQD G
XQD S
(EB Stream)

XQD N Descatalogados:
XQD H
XQD S
(sin EB Stream)

32/64/128 GB 32/64 GB 16/32/64 GB
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1 Pulse el botón de liberación de la tapa 
de soportes (página 10) para abrir la 
tapa de soportes de la sección de la 
ranura para tarjetas.

2 Introduzca una tarjeta de memoria 
XQD con al etiqueta XQD orientada 
hacia la izquierda.

El indicador de acceso (página 10) se 
iluminará en rojo y, a continuación, cambiará 
a verde si la tarjeta se puede utilizar.

3 Cierre la tapa de soportes.

Notas

• La tarjeta de memoria, la ranura de la tarjeta de 
memoria y los datos de imagen de la tarjeta de 
memoria pueden resultar dañados si la tarjeta se 
introduce a la fuerza en la ranura en la orientación 
incorrecta.

• Cuando grabe en los soportes utilizando ambas ranuras 
de tarjeta XQD, la A y la B, inserte los soportes en las 
dos ranuras que se recomiendan para su 
funcionamiento con el formato que desea grabar.

Pulse el botón de liberación de la tapa de soportes 
(página 10) para abrir la tapa de soportes de la 
sección de la ranura para tarjetas y presione 
ligeramente la tarjeta de memoria para extraerla.

Notas

• Si el camcorder está apagado o si se extrae la tarjeta de 
memoria mientras se está accediendo a esta, no se 
podrá garantizar la integridad de los datos de la tarjeta. 
Es posible que se pierdan todos los datos grabados en 
la tarjeta. Asegúrese de que el indicador de acceso esté 
siempre iluminado en color verde o apagado antes de 
apagar el camcorder o extraer la tarjeta de memoria.

• Cuando extraiga una tarjeta de memoria XQD 
inmediatamente después de finalizar una grabación, es 
posible que la tarjeta de memoria XQD esté caliente 
pero esto no indica un problema.

Cuando se han cargado tarjetas de memoria XQD 
tanto en la ranura A como en la B, puede cambiar 
la tarjeta utilizada para grabaciones con tan solo 
pulsar el botón SLOT SELECT (página 9).
Si una tarjeta se llena por completo durante la 
grabación, el camcorder cambia automáticamente 
a la otra tarjeta.

Nota

El botón SLOT SELECT está deshabilitado durante la 
reproducción. Las tarjetas de memoria no se 
intercambian incluso si pulsa el botón. El botón está 
habilitado mientras se muestra la pantalla de miniaturas 
(página 55).

Si se introduce una tarjeta de memoria XQD sin 
formatear o formateada con especificaciones 
diferentes, aparecerá en el visor el mensaje 
“Media Needs to be Formatted”.
Formatee la tarjeta mediante el siguiente 
procedimiento.

Seleccione Format Media (página 88) 
>Media(A) o Media(B) en el menú Media y, 
a continuación, seleccione Execute. Cuando 
aparezca un mensaje de confirmación, 
vuelva a seleccionar Execute.

Se mostrará un mensaje durante el formateo y el 
indicador de acceso se iluminará en rojo.
Cuando se haya completado el formateo, se 
mostrará un mensaje de finalización. Pulse el dial 
SEL/SET para ignorar el mensaje.

Si el formateo no se completa correctamente
Las tarjetas de memoria XQD protegidas y las 
tarjetas de memoria no compatibles con el 
camcorder no se podrán formatear.
Se mostrará un mensaje de advertencia. Siga las 
instrucciones para sustituir la tarjeta por una 
tarjeta de memoria XQD compatible.

Nota

Al formatear una tarjeta de memoria se borran todos los 
datos, incluidos los archivos de configuración y los datos 
de vídeos grabados.

Introducción de una tarjeta de 
memoria XQD

Extracción de tarjetas de memoria 
XQD

Intercambio de tarjetas de 
memoria XQD

Formateo (inicialización) de 
tarjetas de memoria XQD
29



Durante la filmación (grabación/en espera), 
puede comprobar la capacidad restante de la 
tarjeta de memoria XQD en cada ranura mediante 
los indicadores de capacidad de los soportes A/B 
en el visor (página 13).
El tiempo de grabación restante se calcula a partir 
de la capacidad restante de los soportes en cada 
ranura y del formato de vídeo actual (velocidad de 
bits de grabación), y se mostrará en minutos.

Nota

Si los soportes están protegidos se mostrará la marca .

Tiempo de cambio de tarjetas de 
memoria XQD
• Cuando el tiempo de grabación restante total en 

las dos tarjetas de memoria es inferior a 5 
minutos, aparece el mensaje “Media Near Full”, 
el indicador de grabación comienza a parpadear 
y se escucha un pitido (salida de auriculares) de 
advertencia. 
Introduzca algún soporte que disponga de 
espacio.

• Si continúa grabando hasta que el tiempo 
restante de grabación total llegue a cero, el 
mensaje cambiará a “Media Full” y la grabación 
se detendrá.

Nota

En una tarjeta de memoria XQD se pueden grabar hasta 
600 clips aproximadamente.
Si el número de clips grabados alcanza el límite, el 
indicador de tiempo de grabación restante cambiará a “0” 
y también aparecerá el mensaje “Media Full”.

Puede guardar datos de configuración de la 
cámara para el camcorder en una tarjeta SD 
(disponible por separado). Los archivos de datos 
guardados se pueden importar desde la tarjeta SD.

Tarjetas de memoria SDHC*
Tarjetas de memoria SD*
* En este manual se denominan de manera general como 

“tarjetas SD”.

1 Pulse el botón de liberación de la tapa 
de soportes (página 10) para abrir la 
tapa de soportes de la sección de la 
ranura para tarjetas.

2 Introduzca una tarjeta de memoria SD 
con al etiqueta SD orientada hacia la 
izquierda.

El indicador de acceso (página 10) se 
iluminará en rojo y, a continuación, se 
apagará si la tarjeta se puede utilizar.

3 Cierre la tapa de soportes.

Pulse el botón de liberación de la tapa de 
soportes (página 10) para abrir la tapa de 
soportes de la sección de la ranura para 
tarjetas y presione ligeramente la tarjeta SD 
para extraerla.

Notas

• Si el camcorder está apagado o si se extrae la tarjeta SD 
mientras se está accediendo a esta, no se podrá 
garantizar la integridad de los datos de la tarjeta. Es 
posible que se pierdan todos los datos grabados en la 
tarjeta. Asegúrese de que el indicador de acceso esté 
siempre apagado antes de apagar el camcorder o 
extraer la tarjeta SD.

• Tenga cuidado para evitar que la tarjeta SD se caiga al 
introducirla o extraerla.

Comprobación del tiempo de 
grabación restante Utilización de una 

tarjeta UTILITY SD

Tarjetas SD compatibles

Introducción de una tarjeta SD

Extracción de la tarjeta SD
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Es necesario formatear las tarjetas SD la primera 
vez que se van a utilizar en el camcorder.
Las tarjetas SD que se vayan a utilizar en el 
camcorder se deben formatear mediante la 
función de formateo del camcorder. Si aparece un 
mensaje cuando la tarjeta SD se introduce en el 
camcorder, formatee la tarjeta SD.

Seleccione Format Media (página 88) >SD 
Card en el menú Media y, a continuación, 
seleccione Execute. Cuando aparezca un 
mensaje de confirmación, vuelva a 
seleccionar Execute.

Se mostrará un mensaje y el estado de avance 
durante el formateo y el indicador de acceso se 
iluminará en rojo.
Cuando se haya completado el formateo, se 
mostrará un mensaje de finalización. Pulse el dial 
SEL/SET para ignorar el mensaje.

Nota

Al formatear una tarjeta SD se borran todos los datos de 
esta. La tarjeta no se podrá restaurar.

Puede comprobar la capacidad restante de una 
tarjeta SD en la pantalla Media Status 
(página 17).

Nota

Si la tarjeta SD está protegida se mostrará la marca .

Para utilizar una tarjeta SD formateada con el 
camcorder en la ranura de otro dispositivo
En primer lugar, realice una copia de seguridad de 
la tarjeta y, a continuación, vuelva a formatear la 
tarjeta en el dispositivo que se va a utilizar.

Puede añadir funciones al camcorder como, por 
ejemplo, una batería tipo V o una señal de 
sincronización externa; para ello, conecte una 
unidad de extensión XDCA-FS7 (opcional) al 
camcorder.

Notas

• La batería del camcorder no se puede utilizar cuando la 
unidad XDCA-FS7 también está conectada al 
camcorder. Deberá acoplar la batería a la XDCA-FS7 
o conectar el camcorder a una toma de alimentación 
externa.

• Acople o retire la unidad XDCA-FS7 mientras el 
camcorder esté apagado.

1 Extraiga la batería (página 18) 
acoplada al camcorder.

2 Retire la tapa de la sección del conector 
de la unidad de extensión.

Formateo (inicialización) de 
tarjetas SD

Comprobación de la capacidad 
restante

Uso de la XDCA-FS7

Acople de la XDCA-FS7
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3 Alinee los salientes de la XDCA-FS7 con 
las ranuras izquierda y derecha del 
camcorder y deslícelo por completo. 
Luego deslice la XDCA-FS7 hacia abajo 
en la sección del conector.

4 Apriete los dos tornillo situados en la 
parte superior de la XDCA-FS7 para 
asegurar la unidad.

La cubierta de la sección del conector de la 
unidad de extensión se puede insertar en la 
parte superior de la unidad de extensión.

Afloje los dos tornillos de la parte superior de la 
XDCA-FS7 y retire la unidad del camcorder.

Introduzca la batería en el acople de esta en la 
XDCA-FS7.
Las siguientes baterías originales de Sony son 
compatibles.

Baterías de iones de litio
BP-L80S
BP-FL75

Tire de la batería hacia afuera del acople de esta 
en la XDCA-FS7 mientras mantiene pulsado el 
botón BATT RELEASE.

Ranuras Salientes

Extracción de la XDCA-FS7

Colocación de la batería

Extracción de la batería
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Puede cambiar la entrada/salida de código de 
tiempo con el interruptor TC IN/OUT 
(página 12).

Para obtener más detalles, consulte página 101.

Puede grabar vídeo RAW (página 50) en una 
unidad AXS-R5 RAW Recorder (opcional) 
mediante una unidad de interfaz HXR-IFR5 
(opcional) y una XDCA-FS7 (opcional).
Para obtener más información acerca de la 
configuración de la HXR-IFR5 y AXS-R5, 
consulte el manual de funcionamiento de la HXR-
IFR5.

1 Acople la XDCA-FS7 al camcorder 
(página 31).

2 Conecte el conector RAW OUT de la 
XDCA-FS7 al conector SDI IN (RAW) 
de la HXR-IFR5 mediante un cable 
SDI.

Desconecte el cable SDI del conector RAW 
OUT de la XDCA-FS7.

Cambio de la entrada/salida de 
código de tiempo Uso de las unidades 

HXR-IFR5 y AXS-R5

Conexión de la HXR-IFR5 al 
camcorder

Extracción de la HXR-IFR5

conector SDI

HXR-IFR5

AXS-R5
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Primer uso
Tire de la película aislante del soporte de baterías 
cuando utilice por primera vez el control remoto 
de infrarrojos suministrado. 

En el soporte de baterías viene preinstalado de 
fábrica una batería de iones de litio CR2025.

Control del camcorder con el control 
remoto
Para utilizar el control remoto, primero encienda 
el camcorder y, a continuación, active el 
funcionamiento del control remoto.
Utilice el menú de configuración para activar o 
desactivar el funcionamiento del control remoto.

Para activarlo mediante el menú
Pulse el botón MENU para cambiar el camcorder 
al modo menú y, a continuación, ajuste IR 
Remote (página 97) en On en el menú System.

Notas

• Apunte el control remoto hacia el sensor del receptor 
de control remoto del camcorder.

• Configure el camcorder de manera que el sensor del 
receptor del control remoto no esté expuesto a la luz 
directa del sol ni a una luz fuerte de otras fuentes. Las 
luces potentes pueden dificultar el funcionamiento 
correcto del control remoto.

• Es posible que otras unidades de vídeo se pongan en 
funcionamiento por error al utilizar el control remoto 
suministrado para controlar el camcorder. En tal caso, 
cambie el interruptor de modo del control remoto en la 
unidad de vídeo a DVD2 o cubra el sensor del receptor 
del control remoto con papel negro.

Cambio de la batería del control remoto
El control remoto utiliza una batería estándar 
CR2025.
No utilice una batería distinta a la CR2025.

1 Empuje la pestaña hacia adentro y 
extraiga el soporte de la batería 
introduciendo una uña en la ranura.

2 Introduzca una batería nueva con el 
terminal + orientado hacia arriba.

3 Introduzca el soporte de la batería 
hasta que encaje en su lugar.

No guarde las baterías en lugares expuestos a la 
luz solar directa, cerca de fuegos ni a temperatura 
elevadas.

Nota

Sustituir una batería por otra no especificada puede 
provocar averías en el dispositivo. Utilice siempre las 
baterías especificadas.
Elimine las baterías usadas de acuerdo con las leyes 
locales y nacionales.

Uso del control remoto 
de infrarrojos

Película aislante

Precaución

Pestaña
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Puede utilizar el camcorder desde un navegador 
web; para ello, conecte un smartphone, una 
tableta u otro dispositivo que utilice un navegador 
web al camcorder mediante una conexión LAN 
inalámbrica. Esta función de denomina control 
remoto Wi-Fi.
Esta función resulta útil cuando se utiliza el 
camcorder desde una ubicación remota como, por 
ejemplo, cuando el camcorder está montado en 
una grúa.
Para obtener más información acerca del 
procedimiento de configuración del control 
remoto Wi-Fi, consulte página 54.

Pantalla remota Wi-Fi (smartphone)

Pantalla Main

Pantalla Playback

Pantalla Cursor

Pantalla Assign

Uso del control remoto 
Wi-Fi

• Ajustes
S&Q FPS, Shutter, 
White, Sensitivity/
Gain/Exposure Index, 
Gamma, MLUT, Color 
Bars, Auto Black, 
Auto White, Rec Start/
Stop, Lock, Iris, Focus, 
Zoom, Auto Iris, Auto 
Shutter, AGC, ATW

• Estado
• Botones de 

reproducción
Play/Pause, Stop, F 
Fwd, F Rev, Next, Prev

• Estado
• Botones del cursor

Up, Down, Left, Right, 
Set, Cancel/Back, 
Menu, Status, 
Thumbnail, User 
Menu

• Estado
• Botones asignables

Botones asignables de 
1 a 6
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Pantalla Wi-Fi Remote (tableta)

Pantalla Main

• Ajustes
S&Q FPS, Shutter, White, Sensitivity/Gain/Exposure 
Index, Gamma, MLUT, Color Bars, Auto Black, Auto 
White, Rec Start/Stop, Lock, Iris, Focus, Zoom, Auto 
Iris, Auto Shutter, AGC, ATW

Pantalla Playback

• Estado
• Botón de reproducción

Play/Pause, Stop, F Fwd, F Rev, Next, Prev

Pantalla Cursor

• Estado
• Botones del cursor

Up, Down, Left, Right, Set, Cancel/Back, Menu, 
Status, Thumbnail, User Menu

Pantalla Assign

• Estado
• Botones asignables

Botones asignables de 1 a 6
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La filmación básica se realiza mediante el 
siguiente procedimiento.

1 Acople los dispositivos necesarios y 
compruebe que se suministra la 
alimentación necesaria.

2 Introduzca las tarjetas de memoria.

3 Coloque el interruptor POWER en la 
posición ON.

La imagen de la cámara aparecerá en el visor.

4 Pulse el botón de grabación (página 7).

El indicador de grabación se encenderá y el 
camcorder comenzará a grabar.

5 Para detener la grabación, pulse el 
botón de grabación de nuevo.

La grabación se detendrá y el camcorder 
cambiará al modo STBY (en espera).

Nota

Si se pulsa el botón de grabación pocos segundos 
después de encender la videocámara, el indicador de 
grabación se iluminará para indicar que la unidad se 
encuentra en estado de grabación; pero es posible que la 
grabación en los soportes no se produzca durante los 
primeros segundos, según el formato de grabación 
seleccionado.

Filmación (Modo automático completo)
Pulse el botón FULL AUTO y gire el indicador 
del botón hasta que se encienda.
Las funciones de diafragma automático (solo 
objetivos compatibles), AGC, obturador 
automático y ATW (localización automática del 
balance de blancos) se habilitan para controlar el 
brillo y el balance de blancos automáticamente 
(modo automático completo).
Para controlar cada función manualmente, gire el 
interruptor del modo automático completo a la 
posición Off.

Grabación continua mientras se cambian 
las tarjetas de memoria (Relay Rec)
Cuando las tarjetas de memoria se introducen en 
las ranuras A y B, la grabación cambia 

automáticamente a la segunda tarjeta de memoria 
justo antes de que la capacidad restante de la 
primera tarjeta se reduzca a cero.

Notas

• No extraiga una tarjeta de memoria mientras se esté 
grabando en ella. Cambie solo las tarjetas de memoria 
en las ranuras cuyo indicador de acceso esté apagado.

• Cuando la capacidad restante de la tarjeta de memoria 
en la que se está grabando es inferior a un minuto y en 
la otra ranura se ha insertado otra tarjeta de memoria en 
la que se puede grabar, aparecerá el mensaje “Will 
Switch Slots Soon”. El mensaje desaparecerá después 
de cambiar las ranuras de tarjeta de memoria.

• Es posible que la grabación continua no funcione si la 
grabación comienza cuando la capacidad restante de la 
tarjeta de memoria es inferior a un minuto. Para una 
grabación continua correcta, compruebe que la 
capacidad restante de la tarjeta de memoria es superior 
a un minuto antes de comenzar a grabar.

• Los vídeos creados con la función de grabación 
continua del camcorder no se pueden reproducir sin 
interrupciones en el camcorder.

• Para combinar los vídeos creado con la función de 
grabación continua del camcorder, utilice el software 
Content Browser.

Grabación en la tarjetas de memoria A y 
B simultáneamente (Simul Rec)
Puede grabar simultáneamente en las dos tarjetas 
de memoria A y B.

Ajuste Simul Rec >Setting en el menú 
Recording en “On”.

Nota

La grabación simultánea no es compatible con el modo 
de Slow & Quick Motion (página 86) ni con el modo de 
grabación Picture Cache (página 86).
Además, la grabación simultánea no es compatible con 
los siguientes formatos de grabación (página 92).

Área NTSC
XAVC-I
4096 × 2160 59.94P, 4096 × 2160 29.97P, 
4096 × 2160 23.98P, 3840 × 2160 59.94P, 
3840 × 2160 29.97P, 3840 × 2160 23.98P, 
1920 × 1080 59.94P
XAVC-L
3840 × 2160 59.94P, 3840 × 2160 29.97P, 
3840 × 2160 23.98P

Filmación

Procedimiento básico de funcionamiento
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RAW (con las unidades XDCA-FS7, HXR-IFR5 
y AXS-R5 conectadas)
4096 × 2160 59.94P, 4096 × 2160 29.97P, 
4096 × 2160 23.98P, 2048 × 1080 59.94P, 
2048 × 1080 29.97P, 2048 × 1080 23.98P
RAW y XAVC-I (con las unidades XDCA-FS7, 
HXR-IFR5 y AXS-R5 conectadas)
4096 × 2160 59.94P, 2048 × 1080 59.94P
ProRes 422 HQ, ProRes 422 (con la unidad 
XDCA-FS7 conectada)
1920 × 1080 59.94i, 1920 × 1080 29.97P, 
1920 × 1080 23.98P

Área PAL
XAVC-I
4096 × 2160 50P, 4096 × 2160 25P, 
3840 × 2160 50P, 3840 × 2160 25P, 
1920 × 1080 50P
XAVC-L
3840 × 2160 50P, 3840 × 2160 25P
RAW (con las unidades XDCA-FS7, HXR-IFR5 
y AXS-R5 conectada)
4096 × 2160 50P, 4096 × 2160 25P, 
2048 × 1080 50P, 2048 × 1080 25P
RAW y XAVC-I (con las unidades XDCA-FS7, 
HXR-IFR5 y AXS-R5 conectadas)
4096 × 2160 50P, 2048 × 1080 50P
ProRes 422 HQ, ProRes 422 (con la unidad 
XDCA-FS7 conectada)
1920 × 1080 50i, 1920 × 1080 25P

Cambio de los ajustes de los botones de 
grabación START/STOP en el camcorder 
y en el asa
Cuando se habilita la grabación (Simul Rec), 
puede iniciar y detener la grabación en cada 
tarjeta de memoria de forma independiente con 
los botones START/STOP de grabación en el 
camcorder y en el asa.
Según el ajuste predeterminado de fábrica, ambos 
botones se han configurado para iniciar y detener 
la grabación simultánea en ambas tarjetas A y B.
• “Rec Button [SlotA SlotB] Handle Rec Button 

[SlotA SlotB]”
Cuando los botones se establecen para controlar 
la grabación de diferentes tarjetas de memoria, 
SDI/HDMI Rec Control y RAW Rec Control 
siguen el estado de grabación de la ranura A.

Para cambiar el ajuste

Seleccione Simul Rec >Rec Button Set en el 
menú Recording.

Se necesita un objetivo compatible con enfoque 
automático. Sitúe el interruptor FOCUS 
(página 9) del camcorder en la posición 
“AUTO”. Si el objetivo dispone de interruptor de 
selección de enfoque, sitúe el interruptor en la 
posición “AF/MF” o “AF”. Si se ajusta el 
interruptor en la posición “Full MF” o “MF”, el 
enfoque del objetivo no se puede realizar con el 
camcorder (página 24).

Detención temporal del enfoque 
automático (Focus Hold)
Pulse el botón PUSH AUTO FOCUS (página 9) 
cuando esté en modo de enfoque automático para 
anular el enfoque automático.
Esto resulta útil, por ejemplo, cuando frente al 
sujeto se cruza algo que no desea enfocar o 
cuando se pierde el enfoque automático.

Para ajustar el enfoque manualmente, ajuste el 
interruptor FOCUS (página 9) en “MAN”.
Esto le permitirá ajustar el enfoque manualmente 
según las condiciones de filmación.

Rec Button Set Botones y tarjetas de 
memoria

“Rec Button 
[SlotA SlotB] 
Handle Rec 
Button [SlotA 
SlotB]”

Inicia y detiene la grabación 
simultánea en las tarjetas de 
memoria A y B con cualquiera de 
los botones.

“Rec Button 
[SlotA] Handle 
Rec Button 
[SlotB]”

El botón START/STOP inicia y 
detiene la grabación en la tarjeta 
de memoria A, y el botón START/
STOP de grabación del asa inicia 
y detiene la grabación en la tarjeta 
de memoria B.

“Rec Button 
[SlotB] Handle 
Rec Button 
[SlotA]”

El botón START/STOP inicia y 
detiene la grabación en la tarjeta 
de memoria B, y el botón START/
STOP de grabación del asa inicia 
y detiene la grabación en la tarjeta 
de memoria A.

Ajuste automático del enfoque

Ajuste manual del enfoque
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El enfoque manual resulta útil para los siguientes 
tipos de sujetos.

- Sujetos en la parte más alejada de una 
ventana cubierta por gotas de agua

- Sujetos con poco contraste con el fondo
- Sujetos más alejados que otros más cercanos

Ajuste rápido del enfoque con el enfoque 
manual (Push Auto Focus)
Sitúe al sujeto con el que desee ajustar el enfoque 
en el centro de la imagen y, a continuación, pulse 
el botón PUSH AUTO FOCUS (página 9).
El enfoque volverá al ajuste anterior cuando 
suelte el botón.
Esto resulta útil cuando desea enfocar 
rápidamente a un sujeto antes de empezar a 
filmar.

Notas

• La función Push Auto Focus no se puede utilizar si el 
objetivo está ajustado en enfoque manual.

• Durante el uso de Push Auto Focus cuando se utiliza 
LA-EA2/4, el modo Full Auto está activado.

Indicador de enfoque
Indica el estado del enfoque.
• (Encendido): el sujeto está en el enfoque.
• (Parpadeando): el sujeto está fuera de enfoque. 

Debido a que el enfoque no es automático, 
cambie los ajustes de composición y enfoque 
para conseguir el enfoque.

Enfocar con una visualización 
aumentada (Focus Magnifier)
Según el ajuste predeterminado de fábrica, la 
función Focus Magnifier x4/x8 se asigna al botón 
ASSIGN4 en el control remoto de la empuñadura 
(página 45).

Pulse el botón ASSIGN4.

La pantalla de ampliación del enfoque aparecerá 
con el centro ampliado unas cuatro veces 
aproximadamente. Pulse el botón de nuevo para 
incrementar el aumento hasta aproximadamente 
ocho veces. Esta función resulta útil para 
comprobar el enfoque.
Pulse el botón de nuevo para volver a la pantalla 
normal.

Notas

• La imagen grabada o la imagen de salida SDI/HDMI 
no aumenta cuando se aumenta el enfoque.

• Durante el aumento del enfoque, el botón STATUS 
CHECK y los botones de menú no se pueden usar.

Ajuste del enfoque mediante el indicador 
de enfoque asistido

La posición de enfoque está indicada por el nivel 
máximo que alcance la barra. Ajuste el enfoque 
para maximizar la longitud de la barra.

Nota

Es posible que el indicador de enfoque muestre poca o 
ninguna variación cuando filme sujetos con pocas 
diferencias de superficie o en escenas oscuras.

Puede controlar el audio que se está grabando con 
los auriculares.
Al conectar unos auriculares al conector de 
auriculares (página 10) podrá controlar el audio 
que se está grabando. También puede controlar el 
audio de reproducción (página 56) con el altavoz 
integrado (página 10) o con los auriculares.
Puede seleccionar el canal de audio que desea 
controlar y ajustar el volumen mediante Audio 
Output (página 77) en el menú Audio.

Control del audio

Marco del rango de detección del enfoque 
(Marcador del área de enfoque)

Indicador de enfoque asistido

Enfocado: posición del nivel 
máximo que alcance la barra
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Si introduce dos tarjetas de memoria XQD, pulse 
el botón SLOT SELECT (página 9) para 
intercambiar las tarjetas.

Nota

No se pueden intercambiar las tarjetas de memoria 
durante el modo de reproducción. Además, la 
reproducción continua de un soporte de duración de un 
clip en la ranura A y B no es compatible.

Puede cambiar la configuración según la 
aplicación de vídeo o las condiciones de 
grabación.

Los formatos disponibles que se pueden 
seleccionar varían según los ajustes Country 
(región de uso) y Codec.
Seleccione un formato mediante Rec Format 
>Video Format en el menú System.

Puede ajustar el brillo mediante el ajuste de 
diafragma, ganancia y velocidad del obturador y 
también mediante el ajuste del nivel de luz con 
filtros ND.
Al ajustar el brillo sin usar filtros ND, gire el 
interruptor del modo Full Auto a la posición 
(página 37) Off.
Puede ajustar el nivel de brillo en el menú de 
configuración.

Ajuste del nivel de control deseado
Ajuste el nivel de exposición con Auto Exposure 
(página 64) >Level en el menú Camera.

Nota

El brillo no puede ajustarse automáticamente en el modo 
Cine EI.

Ajuste automático del diafragma
Esta función ajusta el brillo según el sujeto. Se 
necesita un objetivo compatible con diafragma 
automático.

1 Si se acopla un objetivo con interruptor 
Auto Iris, coloque el interruptor en 
AUTO.

2 Pulse el botón IRIS (página 45) para 
activar Auto Iris.

El ajuste alterna entre activado y desactivado 
cada vez que se pulsa el botón IRIS.

Intercambio de tarjetas de 
memoria XQD

Clips (datos grabados)
Al dejar de grabar, el vídeo, el audio, y los datos 
que los acompañan desde el principio hasta el 
final de la grabación, se guardan como un solo 
“clip” en una tarjeta de memoria XQD.

Nombres de clips
A cada clip grabado por el camcorder se le 
asigna automáticamente un nombre formado 
por la palabra “Clip” y un número de 4 dígitos. 
El número de 4 dígitos aumenta 
automáticamente en cada grabación.
Puede cambiar el prefijo del “clip” con la 
opción Clip del menú Media.

Duración máxima de clip
Hasta 6 horas por clip.
Se graban varios clips sucesivamente durante la 
grabación continua, pero la grabación se 
detendrá de manera automática transcurridas 
unas 13 horas.

Cambio de la 
configuración básica

Selección del formato de 
grabación

Ajuste del brillo
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Nota

El diafragma no se puede ajustar de manera 
automática en un objetivo de montura A.

Ajuste manual del diafragma

Pulse el botón IRIS para desactivar Auto 
Iris y luego ajuste usando el dial IRIS.

También puede asignar la función IRIS a un dial 
asignable (página 45).

Ajuste temporal del diafragma de forma 
automática
Mantenga pulsado el botón PUSH AUTO IRIS 
para activar el diafragma automático de forma 
temporal.
El diafragma volverá al ajuste anterior cuando 
suelte el botón.

Nota

Cuando el interruptor Auto Iris del objetivo se ajusta en 
“MANUAL”, las funciones Auto Iris y Push Auto Iris 
del camcorder no tendrán ningún efecto. Los ajustes 
manuales de diafragma en el camcorder tampoco tendrán 
ningún efecto.

Ajuste automático de la ganancia
Pulse el botón ISO/Gain (página 9) para activar 
AGC.
O seleccione Auto Exposure (página 64) >AGC 
en el menú Camera y ajústelo en “On”.

Ajuste manual de la ganancia
Puede controlar la ganancia cuando desee ajustar 
la exposición con un ajuste de diafragma fijo, o 
bien cuando desee evitar que la ganancia aumente 
debido al AGC.

1 Pulse el botón ISO/Gain (página 9) para 
desactivar AGC.

2 Ajuste el interruptor GAIN (página 9) 
en H, M o L.

Control de la ganancia (ajuste fino)
Gire el dial IRIS, o el dial asignable asignado a la 
función ISO/Gain/EI, para ajustar el valor de 
ganancia establecido con el interruptor GAIN.
Esto es útil cuando desea ajustar la exposición en 
un nivel sin cambiar la profundidad de campo.
El valor de ganancia ajustado e puede cancelar 
con el interruptor GAIN o activando AGC.

Filmación con obturador automático
Esta función ajusta la velocidad del obturador 
automáticamente como respuesta al brillo de la 
imagen.

Pulse el botón SHUTTER (página 9).

Si se visualiza la pantalla de ajustes, pulse de 
nuevo el botón.
O seleccione Auto Exposure (página 64) >Auto 
Shutter en el menú Camera y ajústelo en “On”.

Filmación con obturador fijo
Puede filmar con una velocidad de obturador 
definida.
Pulse el botón SHUTTER para mostrar una 
pantalla con los valores de obturador admitidos y, 
a continuación, seleccione y establezca un valor 
con el dial SEL/SET. Si vuelve a pulsar el botón 
SHUTTER en lugar del dial SEL/SET, se 
habilitará el obturador automático.

Configuración en el menú Camera
Seleccione Shutter (página 66) en el menú 
Camera y ajuste el modo de obturador y la 
velocidad.

Ajuste del nivel de luz (filtro ND)
En condiciones donde la luz es demasiado fuerte, 
puede ajustar el brillo adecuado si cambia el filtro 
ND.
Gire el Dial ND FILTER (página 9) para 
seleccionar Clear t 1/4 t 1/16 t 1/64 t 
Clear de forma consecutiva.
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Puede seleccionar el modo de ajuste que mejor se 
adapte a las condiciones de filmación.

ATW (localización automática del 
balance de blancos)
Esta función ajusta el balance de blancos 
automáticamente en el nivel adecuado.
El balance de blancos se ajusta automáticamente 
cuando la temperatura de color de la fuente de luz 
cambia.
Pulse el botón WHT BAL (página 9) para activar 
o desactivar ATW.
Puede seleccionar la velocidad de ajuste (cinco 
pasos) mediante White >ATW Speed (página 68) 
en el menú Paint.
Puede congelar el ajuste del balance de blancos 
actual si asigna la función ATW Hold a un botón 
asignable (página 45) y pulsa el botón asignable 
para pausar temporalmente el modo ATW.

Notas

• ATW no se puede utilizar en el modo Cine EI.
• Tal vez no sea posible ajustar los colores adecuados 

con ATW, según las condiciones de iluminación y del 
sujeto.
Ejemplos:
- Cuando un único color domina el sujeto, como por 

ejemplo el cielo, el mar, la tierra o las flores.
- Cuando la temperatura del color es 

extremadamente alta o extremadamente baja.
Si no se puede obtener el efecto adecuado porque 
la velocidad de corrección automática de ATW es 
demasiado lenta o por cualquier otro motivo, 
utilice el balance de blancos automático.

Ajuste manual del balance de blancos

1 Desactive el modo automático completo 
(página 37).

2 Si el balance de blancos está ajustado en 
el modo ATW, pulse el botón WHT 
BAL (página 9) para seleccionar el 
modo manual.

3 Seleccione B, A o PRESET con el 
interruptor WHT BAL (página 9).

B: modo memoria B *
A: modo memoria A
PRESET: modo predeterminado
* B puede asignarse a ATW ON.

Modo predeterminado
Este modo ajusta la temperatura del color a un 
valor predeterminado (el valor predeterminado de 
fábrica es 3200 K).

Modo memoria A/memoria B
Este modo ajusta el balance de blancos en la 
configuración guardada en la memoria A o B 
respectivamente.

Nota

Los ajustes del interruptor WHT BAL en el modo Cine 
EI están fijados del modo siguiente.

B: 5500 K
A: 4300 K
PRESET: 3200 K

Utilización del balance automático de 
blancos

1 Pulse el botón ISO/Gain (página 9) para 
activar AGC.

O seleccione Auto Exposure (página 64) 
>AGC en el menú Camera y ajústelo en 
“On”.

2 Para guardar un valor de ajuste en la 
memoria, seleccione el modo memoria 
A o el modo memoria B.

3 Coloque un papel blanco (u otro objeto) 
en un lugar con la misma fuente de 
iluminación y condiciones que el sujeto 
y, a continuación, utilice el zoom para 
acercarse al papel y así mostrar blanco 
en la pantalla.

4 Ajuste el brillo.

Ajuste el diafragma con el procedimiento 
descrito en “Ajuste manual del diafragma” 
(página 41)

5 Pulse el botón WB SET (página 7).

Si el balance automático de blancos se ajusta 
en el modo de memoria, el valor de ajuste se 
guarda en la memoria (A o B) seleccionada 
en el paso 2.
Si el balance de blancos se ajusta en el modo 
ATW, el ajuste del balance de blancos vuelve 
al balance de blancos del modo ATW cuando 
finaliza el ajuste.

Ajuste de colores naturales 
(balance de blancos)
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Notas

• El ajuste automático de blancos no funciona en el 
modo Cine EI.

• Si el ajuste no se realiza correctamente, aparecerá un 
mensaje de error en la pantalla durante unos tres 
segundos. Si el mensaje de error continúa después de 
varios intentos repetidos de ajuste del balance de 
blancos, póngase en contacto con su servicio de 
asistencia técnica de Sony.

Puede especificar el audio que se va a grabar con 
los conectores de entrada, interruptores y diales 
del camcorder.

Interruptores de selección y conectores de 
entrada de audio externa
Conector INPUT1 (página 10)
Conector INPUT2 (página 10)
Interruptor INPUT1 (LINE/MIC/MIC+48V) 
(página 7)
Interruptor INPUT2 (LINE/MIC/MIC+48V) 
(página 7)

Interruptores para ajustar el nivel de audio
Interruptor CH1 LEVEL CONTROL (página 9)
Interruptor CH2 LEVEL CONTROL (página 9)
Dial CH1 INPUT LEVEL (página 9)
Dial CH2 INPUT LEVEL (página 9)

Selección del dispositivo de entrada de 
audio

1 Seleccione el conector de entrada de 
audio.

Seleccione la entrada de audio con Audio 
Input >CH1 Input Select o CH2 Input Select 
en el menú Audio.
Establezca INPUT1 o INPUT2 para que 
coincidan con el conector del dispositivo 
conectado. Si utiliza un micrófono acoplable 
o un adaptador de XLR, especifique Shoe 1 o 
Shoe 2 del mismo modo. Para obtener más 
información acerca del adaptador de XLR, 
consulte “Adición de conectores de entrada 
de audio” (página 50).

Nota

El camcorder está equipado con un micrófono 
interno. Aunque no resulta adecuado para obtener el 
audio final, se puede utilizar para la sincronización 
con otro equipo. En tales casos, especifique Internal 
MIC.

2 Seleccione la fuente de entrada de 
audio.

Ajuste los interruptores INPUT1/INPUT2 
(LINE/MIC/MIC+48V) en los dispositivos 
conectados a los conectores INPUT1/
INPUT2 respectivamente.

• Si selecciona “MIC+48V” y conecta un 
micrófono que no sea compatible con 
fuentes de +48 V, es posible que dañe el 
dispositivo conectado. Compruebe el ajuste 
antes de conectar el dispositivo.

• Si le preocupa el ruido en conectores que 
no tengan un dispositivo conectado, ajuste 
los interruptores INPUT1/INPUT2 (LINE/
MIC/MIC+48V) correspondientes en 
“LINE”.

Ajuste automático del nivel de grabación 
de audio
Ajuste los interruptores CH1/CH2 LEVEL 
CONTROL para que los canales se ajusten 
automáticamente en “AUTO”.
Para CH3/CH4, ajuste Audio Input > CH3 Level 
Control y CH4 Level Control del menú Audio en 
“Auto” (página 75).

Ajuste manual del nivel de grabación de 
audio
Utilice el siguiente procedimiento para ajustar el 
nivel de grabación de audio de CH1/CH2.

1 Ajuste los interruptores CH1/CH2 
LEVEL CONTROL para que los 
canales se ajusten manualmente en 
“MAN”.

Especificación del audio que se va 
a grabar

Dispositivo conectado Posición del 
interruptor

Fuente externa de audio 
(por ejemplo, mezclador)

LINE

Micrófono dinámico, 
micrófono con batería

MIC

Micrófono con 
alimentación fantasma de 
+48 V

MIC+48V
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2 Durante la filmación o en espera, gire 
los diales INPUT LEVEL (CH1)/(CH2) 
hasta los canales correspondientes para 
ajustar el nivel de audio.

También puede ajustar el nivel de grabación 
con el dial asignable (página 45) si está 
asignado a la función Audio Input Level, o 
bien desde el menú de configuración.
Para CH3/CH4, ajuste Audio Input > CH3 
Level Control y CH4 Level Control del menú 
Audio en “Manual” y, a continuación, ajuste 
el nivel de grabación de audio en CH3 Input 
Level y CH4 Input Level (página 75).

Notas

• Cuando se configuren los siguientes ajustes de 
Audio Input en el menú Audio, se inhabilitará 
Audio Input Level, ya que no habrá ningún 
destino para el nivel de entrada de audio. 
Además, no será posible ajustar el nivel de 
grabación de audio mediante el dial asignable al 
cual se haya asignado Audio Input Level.
- Cuando tanto CH1 Level como CH2 Level 

estén ajustados en “Side”
- Cuando CH3 Input Select esté ajustado en 

“Off”, o CH3 Level esté ajustado en “CH3 
Input Level”

- Cuando CH4 Input Select esté ajustado en 
“Off”, o CH4 Level esté ajustado en “CH4 
Input Level”

• Si Audio Input >CH1 Level o CH2 Level en el 
menú Audio se ajusta en “Level + Side”, el 
valor de ajuste es el producto del ajuste Audio 
Input Level y el nivel definido por el dial 
INPUT LEVEL. Si cualquiera de los dos 
niveles se ha ajustado en el valor mínimo, el 
audio se silenciará. Si ambos niveles se ajustan 
en el valor máximo, se seleccionará el nivel 
máximo.
De manera similar para CH3/CH4, si CH3 
Level o CH4 Level están ajustados en 
“Level+CH3 Input Level” o “Level+CH4 Input 
Level”, el ajuste del nivel de grabación de audio 
se realizará como se ha indicado anteriormente.

• Si Audio Input > CH1 Input Select o CH2 Input 
Select del menú Audio está ajustado en 
“Internal MIC”, CH2 cambia a automático/
manual juntamente con el interruptor CH1 
LEVEL CONTROL. Asimismo, el nivel de 
grabación de audio de CH2 se establece 
juntamente con el dial CH1 INPUT LEVEL 
(página 75).

Ajuste del código de tiempo
Ajuste el código de tiempo que se va a grabar 
mediante Timecode (página 85) en el menú TC/
UB.

Visualización de los datos de tiempo
Pulse el botón DISPLAY para mostrar los datos 
de tiempo en la pantalla (página 14).
Ajuste el código de tiempo que se va a mostrar 
mediante TC Display (página 85) >Display 
Select en el menú TC/UB.
Si pulsa un botón asignable (página 45) al que se 
le haya asignado DURATION/TC/U-BIT, 
cambiará la visualización entre código de tiempo, 
bits de usuario y duración de forma consecutiva.

Especificación de los datos de 
tiempo
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Existen seis botones asignables (página 9, 
página 11) en el camcorder a los que puede 
asignar diversas funciones.
También puede asignar funciones al dial IRIS 
(página 9) en el camcorder y al dial asignable 
(página 11) en el control remoto de la 
empuñadura.

Cambio de función de los botones
Utilice Assignable Button (página 93) en el menú 
System.
Puede visualizar las funciones asignadas en la 
pantalla Assignable Button Status (página 16).

Las funciones se asignan a cada botón asignable 
de manera predeterminada de fábrica

Funciones asignables
• Off
• Marker
• Zebra
• Peaking
• Video Signal Monitor
• DURATION/TC/U-BIT
• Focus Magnifier x4/x8
• Focus Magnifier x4
• Focus Magnifier x8
• Push AF/Focus Hold
• VF Mode
• IRIS
• AGC
• SHUTTER
• Auto Exposure Level
• Push Auto Iris
• Push AGC
• Spotlight
• Backlight
• ATW
• ATW Hold

• SteadyShot
• Color Bars
• User Menu
• Rec Lamp
• S&Q Motion
• Picture Cache Rec
• Rec Review
• Thumbnail
• Shot Mark1
• Shot Mark2
• Clip Flag OK
• Clip Flag NG
• Clip Flag Keep
• High/Low Key

Cambio de función de los diales
Utilice Assignable Dial (página 95) en el menú 
System.
Puede visualizar las funciones asignadas en la 
pantalla Assignable Button Status (página 16).
IRIS se asigna de manera predeterminada de 
fábrica.

Funciones asignables
• Off
• IRIS
• ISO/GAIN/EI
• Focus
• Audio Input Level

Funciones útiles

Botones/diales asignables

Botón 1 S&Q Motion
Botón 2 IRIS
Botón 3 User Menu
Botón 4 Focus Magnifier x4/x8
Botón 5 User Menu
Botón 6 Off
45



Cuando el formato de vídeo (página 91) se ajusta 
en uno de los siguientes valores, puede 
especificar un valor diferente para la velocidad de 
fotogramas de grabación y la velocidad de 
fotogramas de reproducción.

Área NTSC
XAVC-I
4096 × 2160 59.94P, 4096 × 2160 29.97P, 
4096 × 2160 23.98P, 3840 × 2160 59.94P, 
3840 × 2160 29.97P, 3840 × 2160 23.98P, 
1920 × 1080 59.94P, 1920 × 1080 29.97P, 
1920 × 1080 23.98P
XAVC-L
3840 × 2160 59.94P, 3840 × 2160 29.97P, 
3840 × 2160 23.98P, 1920 × 1080 59.94P 50, 
1920 × 1080 59.94P 35, 1920 × 1080 29.97P 
50, 1920 × 1080 29.97P 35, 1920 × 1080 
23.98P 50, 1920 × 1080 23.98P 35

Área PAL
XAVC-I
4096 × 2160 50P, 4096 × 2160 25P, 
3840 × 2160 50P, 3840 × 2160 25P, 
1920 × 1080 50P, 1920 × 1080 25P
XAVC-L
3840 × 2160 50P, 3840 × 2160 25P, 
1920 × 1080 50P 50, 1920 × 1080 50P 35, 
1920 × 1080 25P 50, 1920 × 1080 25P 35

Notas

• La función Slow & Quick Motion no se puede ajustar 
durante la grabación, la reproducción ni durante la 
visualización de la pantalla de miniaturas.

• La grabación automática no es compatible con el modo 
Slow & Quick Motion.

• La función de enfoque automático se inhabilita en el 
modo Slow & Quick Motion.

• Las siguientes condiciones se aplican cuando se filma 
a velocidades de fotogramas mayores a 60 fps.
- El indicador de enfoque asistido, el indicador de 

profundidad de campo, el indicador de posición de 
enfoque, el indicador de posición del diafragma y 
el indicador de posición del zoom se desactivan.

Área NTSC

Área PAL

La función de grabación de memoria intermedia 
de imágenes le permite capturar vídeo de forma 
retroactiva cuando empieza a grabar y después lo 
graba en tarjetas de memoria XQD; esto se 
consigue manteniendo una memoria intermedia 
de imágenes de una duración específica durante la 
filmación. El tiempo de grabación de memoria 
intermedia se establece mediante Picture Cache Rec 

Movimiento a cámara lenta y 
rápida

Formato Resolución Velocidad 
de 
fotogramas

Velocidad de 
fotogramas 
alta

XAVC-I 2160 De 1 a 
60 fps

No admitido

(59.94P, 29.97P, 23.98P)

1080 De 1 a 
60 fps

72/75/80/90/96/
100/110/120/125/
135/144/150/160/
168/175/180 fps

(59.94P, 29.97P, 23.98P)

XAVC-L 2160 De 1 a 
60 fps

No admitido

(59.94P, 29.97P, 23.98P)

1080 De 1 a 
60 fps

72/75/80/90/96/
100/110/120 fps

(59.94P 50, 59.94P 35, 29.97P 
50, 29.97P 35, 23.98P 50, 
23.98P 35)

Formato Resolución Velocidad 
de 
fotogramas

Velocidad de 
fotogramas 
alta

XAVC-I 2160 De 1 a 
60 fps

No admitido

(59P, 25P)

1080 De 1 a 
60 fps

72/75/80/90/96/
100/110/120/125/
135/144/150 fps

(59P, 25P)

XAVC-L 2160 De 1 a 
60 fps

No admitido

(59P, 25P)

1080 De 1 a 
60 fps

72/75/80/90/96/
100/110/120 fps

(50P 50, 50P 35, 25P 50, 
25P 35)

Grabación de memoria intermedia 
de imágenes (Picture Cache Rec)
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>Cache Rec Time (página 86) en el menú 
Recording.

Formatos de grabación compatibles

*1: XAVC-I 59.94P y 50P no son compatibles.

Notas

• Picture Cache Rec no puede estar activado al mismo 
tiempo que Frame Rec, Interval Rec o Slow & Quick 
Motion. Cuando Picture Cache Rec está activado, estos 
otros modos de grabación se apagan de forma forzosa.

• El modo Picture Cache Rec no se puede seleccionar 
mientras se graba o cuando Rec Review está en 
proceso.

• Cuando Picture Cache Rec está activado, el código de 
tiempo se graba en el modo Free Run 
independientemente del ajuste del menú TC/UB 
(página 85).

• Zebra y Peaking no se pueden utilizar cuando el modo 
Picture Cache Rec está activado.

Configuración antes de la filmación
Configure Picture Cache Rec (página 86) en el 
menú Recording antes de filmar.
También puede asignar la función Picture Cache 
Rec a un botón asignable (página 45) y activar o 
desactivar Picture Cache Rec con el botón.
Cuando está configurado, el indicador z (verde) 
aparece en el visor (página 13).

Grabación de memoria intermedia de 
imágenes
Cuando pulsa el botón de grabación, la grabación 
comienza y el vídeo se graba en las tarjetas de 
memoria XQD a partir del vídeo almacenado en 
la memoria intermedia.

Para cancelar Picture Cache Rec
Desactive el ajuste Picture Cache Rec >Setting en 
el menú Recording o pulse un botón asignable 
que tenga asignada la función Picture Cache Rec.

Notas

• El cambio del formato de grabación borra el vídeo de 
la memoria intermedia almacenado hasta ese punto y 
comienza a almacenar vídeo nuevo. En consecuencia, 
la grabación de memoria intermedia de imágenes no es 

posible antes de cambiar el formato, aunque empiece a 
grabar inmediatamente después de cambiar el formato.

• Si Picture Cache Rec se activa/desactiva 
inmediatamente después de insertar una tarjeta de 
memoria XQD, los datos de la memoria intermedia 
pueden no grabarse en la tarjeta.

• El vídeo se almacena en la memoria intermedia cuando 
la función de grabación en memoria intermedia está 
activada. No se almacena en la memoria media el 
vídeo anterior a la activación de la función.

• El vídeo no se almacena en la memoria intermedia 
durante el acceso a una tarjeta de memoria XQD; lo 
mismo ocurre durante la reproducción, Rec Review o 
la visualización de miniaturas en la pantalla. Durante 
ese intervalo, la grabación de memoria intermedia de 
imágenes de vídeo no es posible.

• Puede cambiar el ajuste del tiempo de grabación de 
memoria intermedia con el menú durante la grabación, 
pero el valor nuevo no surte efecto hasta que finalice la 
grabación.

Puede comprobar el vídeo del clip que ha grabado 
por último en la pantalla.

Cuando detenga la grabación, pulse el 
botón asignable (página 45) al que se ha 
asignado la función Rec Review.

El clip se reproduce hasta el final, Rec Review 
finaliza y el camcorder vuelve al modo STBY (en 
espera).
Mantenga pulsado el botón para comenzar la 
reproducción en dirección contraria. Cuando 
suelte el botón, el clip se reproducirá hasta el 
final.

Para detener Rec Review
Pulse el botón asignable al que ha asignado Rec 
Review.

Nota

Rec Review no es compatible si el formato de vídeo se 
cambia después de grabar un clip.

Puede dar la vuelta a la imagen en el visor 
(página 11) verticalmente u horizontal/
verticalmente con el interruptor MIRROR.
Esto le permite girar el visor 180º hacia el 
objetivo.

Formato de 
grabación

Resolución
Tiempo de 
memoria [s]

RAW 4096×2160
2048×1080

No admitido

XAVC *1 3840×2160 0 a 2

1920×1080 0 a 2/2 a 4/4 a 6/6 a 8

MPEG-2 1920×1080 0 a 2/2 a 4/4 a 6/6 a 
8/8 a 10/13 a 15

ProRes422 1920×1080 No admitido

Revisión de una grabación (Rec 
Review)

Modo Self Portrait (autorretrato)
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OFF
La imagen no se invierte.

B/T
La imagen se da la vuelta de forma vertical.
La visualización de información se invierte de 
forma vertical y horizontal. 

ROT
La imagen se da la vuelta de forma vertical y 
horizontal.

La visualización de información también se 
invierte de forma vertical y horizontal.

Nota

Las vistas B/T y ROT solo se visualizan en el visor. El 
vídeo de salida y el vídeo grabado seguirán sin verse 
afectados.

Puede activar o desactivar la nitidez con el botón 
PEAKING en el visor (página 11).
Puede activar o desactivar la nitidez y ajustar el 
tipo y la frecuencia de nitidez con Peaking 
(página 81) en el menú VF.

Nota

No se puede utilizar cuando el modo Picture Cache Rec 
está activado.

Visualización de la nitidez
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Puede activar o desactivar la visualización del 
patrón de cebra con el botón ZEBRA en el visor 
(página 11).
Puede activar o desactivar la visualización del 
patrón de cebra y ajustar el tipo de patrón y el 
nivel de visualización de cebra con Zebra 
(página 81) en el menú VF.

Nota

No se puede utilizar cuando el modo Picture Cache Rec 
está activado.

Ajuste GPS en “On” en el menú System.

 se mostrará cuando el camcorder esté 
buscando satélites de GPS. Cuando se establece el 
posicionamiento, la información de ubicación se 
graba mientras se filma el vídeo.

Notas

• El ajuste de GPS no se puede establecer en “On” en el 
menú System cuando el asa no está acoplada, puesto 
que el receptor de GPS está integrado en el asa.

• El icono que se muestra varía según la recepción de 
señal de los satélites GPS.

• GPS se ajusta en “On” de manera predeterminada de 
fábrica. El camcorder grabará la información de 
ubicación y de tiempo del vídeo grabado cuando el 
posicionamiento esté activado.

• Si después de varios minutos no se muestra un icono de 
posicionamiento, es posible que exista un problema 
con la recepción de señal. Comience a filmar sin 
información de ubicación o desplácese a una zona con 
una vista clara del cielo. Si filma cuando no se muestra 
un icono de posicionamiento, la información de 
ubicación no se grabará.

• Es posible que no se reciba señal de GPS cuando esté 
en interiores o cerca de estructuras altas. Desplácese 
hasta una ubicación con una vista despejada del cielo.

• Es posible que se interrumpa la grabación de 
información de ubicación, según la fuerza de la señal 
recibida, incluso si se muestra el icono de 
posicionamiento.

Este modo imita la manera en que funciona una 
cámara de cine y presupone que el metraje se 
revela en postproducción.

Restricciones del modo Cine El
• Funciones que no se pueden ajustar de forma 

automática (corrección)
- White balance
- Gain
- Shutter
- Iris
- Auto Exposure

• Funciones que no se pueden configurar
- Gain
- Noise Suppression
- Ajustes del menú Paint
- Scene File
- Lens File

Visualización de cebra

Obtención de la información de 
ubicación (GPS)

Estado de 
posiciona-
miento

Pantalla Estado de recepción 
de GPS

Off Sin visuali-
zación

GPS se ha ajustado en 
“Off” o se ha producido 
un error.

Ubicación no 
disponible

No se ha podido obtener 
la información de 
ubicación porque no se 
ha podido recibir la señal 
de GPS. Desplácese 
hasta una ubicación con 
una vista despejada del 
cielo.

Buscando 
satélites

Buscando satélites de 
GPS. Puede que tarde 
varios minutos en 
encontrar satélites.

Posiciona-
miento

Se recibe una señal débil 
de GPS.

Se recibe una señal de 
GPS. Se puede conseguir 
la información de 
ubicación.

Se recibe una señal fuerte 
de GPS. Se puede 
conseguir la información 
de ubicación.

Filmación en modo Cine El

Estado de 
posiciona-
miento

Pantalla Estado de recepción 
de GPS
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Funciones disponibles solo en modo 
Cine El
• Exposure Index
• Monitor LUT
• Grabación de vídeos RAW

Puede grabar vídeos RAW en un grabador AXS-
R5 (opcional) si convierte la señal de salida de un 
conector RAW OUT de una XDCA-FS7 
(opcional) acoplada al camcorder con una HXR-
IFR5 (opcional) (página 33).

1 Configure la unidad de grabación RAW 
externa (página 33).

2 Ajuste Base Setting >Shooting Mode en 
el menú System en Cine EI.

3 Ajuste Codec >Select en RAW en el 
menú System. 

Si selecciona RAW & XAVC-I, se grabará 
simultáneamente vídeo RAW en el grabador 
RAW externo y vídeo HD en las tarjetas de 
memoria XQD del camcorder.

4 Ajusta Rec Format en RAW Output 
Format en el menú System.

5 Compruebe que el grabador externo 
esté encendido y, a continuación, pulse 
el botón de grabación en el camcorder.

A continuación se muestran los formatos de 
salida RAW compatibles.

Área NTSC

Área PAL

Indicador de estado de grabación
Si Display On/Off (página 83) >HXR-IFR5 Rec 
Control del menú VF está ajustado en “On”, el 
estado de grabación RAW se mostrará en el visor 
mediante un icono.

Grabación de movimiento a cámara lenta y rápida
Si S&Q Motion >Setting en el menú Recording 
está ajustado en “On”, el vídeo RAW se grabará 
en el modo de movimiento a cámara lenta y 
rápida.
RAW output Slow & Quick Motion es 
compatible solo con una resolución de 2K a 120/
240 fps (NTSC) y 100/200 fps (PAL).

Nota

El conector RAW OUT del camcorder solo controla la 
grabación mediante la transmisión de una señal Rec 
Control al grabador externo; por lo tanto, el camcorder 
puede indicar que la grabación de vídeo RAW está en 
proceso cuando el grabador externo no está grabando 
realmente. Compruebe el indicador del grabador externo 
para obtener el estado de funcionamiento correcto.

Puede conectar al camcorder hasta cuatro canales 
de los dispositivos de audio XLR al mismo 
tiempo si utiliza un adaptador de XLR XLR-K2M 
(no suministrado).
Acople el adaptador de XLR a la zapata MI y, a 
continuación, ajuste Audio Input >CH3 Input 
Select en “Shoe 1” y CH4 Input Select en “Shoe 
2” en el menú Audio.
Las funciones del camcorder que se solapen se 
inhabilitarán para los canales en los que el 
adaptador de XLR se haya seleccionado como la 
entrada. Utilice los interruptores y los diales del 
adaptador de XLR para realizar los ajustes.

Grabación de vídeos RAW

Ajuste de Codec 
>Select

Formatos de salida 
RAW

RAW / RAW & 
XAVC-I / RAW &
XAVC-L / RAW &
MPEG HD422

4096 × 2160 59.94P
4096 × 2160 29.97P
4096 × 2160 23.98P
2048 × 1080 59.94P
2048 × 1080 29.97P
2048 × 1080 23.98P

Ajuste de Codec 
>Select

Formatos de salida 
RAW

RAW / RAW & 
XAVC-I / RAW &
XAVC-L / RAW &
MPEG HD422

4096 × 2160 50P
4096 × 2160 25P
2048 × 1080 50P
2048 × 1080 25P

Adición de conectores de entrada 
de audio
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Notas

• Si Audio Input >CH3 Level y CH4 Level se han 
establecido en “Audio Input Level” en el menú Audio, 
el Audio Input Level del camcorder se ajustará para 
que coincida con el nivel que se haya ajustado en el 
adaptador de XLR. Audio Input Level también se 
habilita cuando el dial del adaptador de XLR está 
ajustado en AUTO. Cuando se especifique “Through”, 
el audio se grabará en el nivel que se haya ajustado con 
el adaptador de XLR.

• También es posible asignar a CH1 y CH2 acoplando un 
adaptador de XLR y estableciendo Audio Input >CH1 
Input Select y CH2 Input Select en el menú Audio en 
“Shoe 1” y “Shoe 2,” respectivamente. No obstante, si 
se asigna la entrada desde un adaptador de XLR a CH1 
y CH2, la entrada desde los conectores INPUT1/
INPUT2 del camcorder ya no se podrá asignar a los 
canales.

El camcorder se puede conectar a smartphones, 
tabletas y otros dispositivos que utilicen una 
conexión LAN inalámbrica, mediante el acople 
del módulo de LAN inalámbrica USB IFU-
WLM3 (suministrado) o una adaptador 
inalámbrico CBK-WA100 (opcional).

Nota

Los módulos inalámbricos USB distintos del IFU-
WLM3 no son compatibles.

Las siguientes funciones son compatibles con 
dispositivos conectados mediante LAN inalámbrico.
• Control remoto

Habilita el control remoto del camcorder.
• Control de vídeo (solo CBK-WA100)

Habilita el control del vídeo desde el 
camcorder.
Es necesario disponer del CBK-WA100 
(opcional) y de la aplicación Content 
Browser Mobile.

Para obtener más información acerca de la 
aplicación Content Browser Mobile, póngase en 
contacto con el servicio de asistencia técnica o de 
ventas de Sony.

Dispositivos compatibles
Puede utilizar un smartphone, tableta u ordenador 
para configurar y utilizar el camcorder. En la 
siguiente se indican los dispositivos, sistemas 
operativos y navegadores compatibles.

Conexión de 
dispositivos con LAN 
inalámbrica

Dispositivo SO Navegador
Smartphone Android 4.3 Chrome

iOS7 Safari

Tableta Android 4.3 Chrome

iOS7 Safari

Ordenador Microsoft Windows 7/
Microsoft Windows 8.1

Chrome

Mac OS 10.8/10.9 Safari
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Enchufe el IFU-WML3 en el conector USB del 
módulo de LAN inalámbrica (página 7).
Tras acoplar la unidad, ajuste Wi-Fi >Wi-Fi 
(página 96) en el menú System en “Enable” para 
habilitar la LAN inalámbrica.

Nota

Acople o retire el IFU-WLM3 mientras el camcorder 
esté apagado.

Nota

Acople o retire el CBK-WA100 mientras el camcorder 
esté apagado.

1 Conecte el CBK-WA100 al soporte de 
montaje y apriete los dos tornillos.

2 Conecte el soporte de montaje del CBK-
WA100 en el camcorder y apriete los 
tornillos.

3 Conecte el cable USB del CBK-WA100 
al conector del módulo LAN 
inalámbrico USB (1) y el cable SDI al 
conector SDI OUT (2).

4 Encienda el CBK-WA100 y luego 
encienda el camcorder.

5 Cuando se completa la conexión, el 
LAN inalámbrico debe habilitarse si se 
establece Wi-Fi >Wi-Fi (página 96) en 
Enable en el menú System.

Acople del IFU-WLM3

Acople del CBK-WA100
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Nota

El parámetro de salida SDI OUT se debe configurar para 
utilizar el CBK-WA100 con el camcorder. Sin embargo, 
la videocámara no puede emitir una señal compatible con 
el CBK-WA100 cuando se utiliza ProRes 23.98P 
(página 78).

Acerca del CBK-WA100
El CBK-WA100 cuenta con funciones de 
grabación de archivos proxy de baja resolución en 
una tarjeta SD, así como de transferencia de 
archivos a un servidor mediante LAN 
inalámbrico. Para obtener más información, 
consulte el manual de funcionamiento del CBK-
WA100.

Los dispositivos compatibles con NFC se pueden 
conectar (conexión con un toque) mediante NFC.

1 Acople un IFU-WLM3 al camcorder 
(página 52), y ajuste Wi-Fi >Wi-Fi 
(página 96) en el menú System en 
“Enable” para habilitar la LAN 
inalámbrica.

 aparecerá en pantalla.

2 Abra “Settings” en el dispositivo, 
seleccione “More” y marque la casilla 
de NFC.

Los diferentes ajustes variarán según el 
dispositivo. Para obtener más información, 
consulte el manual de instrucciones del 
dispositivo.

3 Toque el camcorder con el dispositivo.

El dispositivo se conectará al camcorder, 
abrirá un navegador web y mostrará el 
control remoto Wi-Fi. Se requiere 
autenticación la primera vez que se conecta 
el dispositivo.

Conexión con un toque de 
dispositivos con NFC (solo para el 
IFU-WLM3)
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Notas

• Algunos dispositivos con la marca  son 
compatibles con NFC.

• Desactive previamente el modo de suspensión y el 
bloqueo de pantalla.

• Toque sin soltar el dispositivo hasta que se inicie la 
aplicación “Content Browser Mobile” (1 o 
2 segundos).

La pantalla Wi-Fi Remote cambia de tamaño 
automáticamente para adaptarse al tamaño de la 
pantalla del dispositivo conectado.

1 Conecte el camcorder y el dispositivo 
mediante una conexión de LAN 
inalámbrica (página 53).

2 Abra un navegador en el dispositivo y 
escriba “http://<dirección IP del 
camcorder (Wi-Fi >dirección IP en el 
menú System)>/rm.html” en la barra de 
direcciones.

Por ejemplo, si la dirección IP es 
192.168.1.1, introduzca “http://192.168.1.1/
rm.html” en la barra de URL.

3 Introduzca el nombre de usuario y la 
contraseña (Basic Authentication >User 
Name y Password en el menú System).

Cuando la conexión se realiza correctamente, 
en el dispositivo aparecerá la pantalla Wi-Fi 
Remote.
Puede utilizar la pantalla Wi-Fi Remote para 
controlar el camcorder.
Puede desactivar el funcionamiento del 
botón de grabación si desliza el dial Lock 
hacia la derecha.

Notas

• Para mostrar la página de un smartphone, cambie 
“rm.html” por “rms.html” en la URL. Para mostrar la 
página de un tableta, cambie “rm.html” por “rmt.html” 
en la URL. Cuando se introduce “rm.html”, la página 
cambia automáticamente para mostrar la pantalla en el 
dispositivo correspondiente. Sin embargo, es posible 
que no se muestre la página adecuada en función del 
dispositivo.

• Es posible que la pantalla Wi-Fi Remote no coincida 
con los ajustes del camcorder en las siguientes 
circunstancias. Si esto ocurre, vuelva a cargar la 
ventana del navegador.
- Si el camcorder se reinicia mientras está conectado
- Si el camcorder se utiliza directamente mientras 

está conectado
- Si el dispositivo se ha reconectado
- Si se han utilizado los botones de Adelante/Atrás 

del navegador
• Es posible que el control remoto por Wi-Fi no funcione 

si la señal inalámbrica es débil.

Visualización del control 
remoto Wi-Fi
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La pantalla de imágenes en miniatura aparece si pulsa el botón THUMBNAIL (página 9). La pantalla de 
imágenes en miniatura muestra los clips almacenados en las tarjetas de memoria XQD como imágenes en 
miniatura (imágenes índice).
Puede seleccionar un clip en la pantalla de imágenes en miniatura e iniciar la reproducción de dicho clip. 
La imagen de reproducción se puede mostrar en el visor y en un monitor externo.
Si pulsa el botón THUMBNAIL de nuevo, se cierra la pantalla de imágenes en miniatura y vuelve a la 
imagen de la cámara.

Notas

• Solo los clips grabados con el formato de grabación seleccionado actualmente se mostrarán en la pantalla de imágenes 
en miniatura. Si un clip grabado esperado no se muestra, compruebe el formato de grabación. Tenga en cuenta esto 
antes de formatear (inicializar) soportes.

• Si Codec > Select del menú System se establece en uno de los siguientes parámetros, la grabación no se puede iniciar 
durante la reproducción o cuando se muestra la pantalla de miniaturas. 
RAW & XAVC-I, RAW & XAVC-L, RAW & MPEG HD422

La información para el clip sobre el que se encuentra el cursor se muestra en la parte inferior de la pantalla.

1. Miniaturas (imágenes índice)
Muestra la imagen índice de un clip. Cuando se 
graba un clip, su primer fotograma se ajusta 
automáticamente como imagen índice.
La información del clip/fotograma se muestra 
debajo de la imagen en miniatura. Puede 
cambiar la información mostrada en Customize 
View (página 87) >Thumbnail Caption en el 
menú Thumbnail.

2. Nombre del clip
Muestra el nombre del clip seleccionado.

3. Formato de grabación del vídeo
Muestra el formato de archivo del clip 
seleccionado.

Pantalla de imágenes en miniatura

Pantalla de imágenes en miniatura

Diseño de la pantalla

Número del clip/Número total de clips

Cursor 
(amarillo)

Indicador de la tarjeta de memoria XQD seleccionada 
actualmente
(Se muestra un icono de bloqueo si la tarjeta está 
protegida).
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4. Información del modo de grabación 
especial
Muestra el modo de grabación solo si el clip se 
grabó con un modo especial de grabación.
En clips con Slow & Quick Motion, la velocidad 
de fotogramas se muestra a la derecha.

5. Duración del clip

6. Fecha de creación
Puede reproducir clips grabados cuando el 
camcorder esté en modo de espera (Stby).

1 Introduzca una tarjeta de memoria 
XQD para la reproducción.

2 Pulse el botón THUMBNAIL.

3 Gire el dial SEL/SET (página 9) para 
mover el cursor hasta la imagen en 
miniatura del clip que desea 
reproducir.

4 Pulse el dial SEL/SET.
La reproducción comienza desde el principio 
del clip seleccionado.

Puede controlar la reproducción con los 
siguientes botones.
Dial SEL/SET:

Pausa la reproducción. 
Pulse de nuevo para volver a la reproducción 
normal.

Pulse los botones izquierda/derecha:
Pasa al inicio del clip/inicio del siguiente clip.

Mantenga pulsado los botones izquierda/
derecha:

Rebobinado/avance rápido. 
Vuelve a la reproducción normal cuando 
suelta el botón.

Botón CANCEL/BACK:
Detiene la reproducción y vuelve al modo de 
espera de grabación.

Notas

• Pueden existir roturas momentáneas de imagen o 
visualizarse imágenes fijas en el cambio de un clip a 
otro. Durante este periodo no podrá utilizar el 
camcorder.

• Cuando selecciona un clip en la pantalla de imágenes 
en miniatura y comienza la reproducción, pueden 
existir roturas momentáneas de imagen al principio del 
clip. Para visualizar el principio del clip sin roturas, 
ponga el camcorder en modo de reproducción, pause y, 
a continuación, utilice el botón izquierdo del dial SEL/
SET para volver al principio del clip y comience de 
nuevo la reproducción.

• También puede controlar la reproducción con el 
control remoto suministrado.

Reproducción de clips

Reproducción de clips grabados
56



En la pantalla de imágenes en miniatura, puede 
utilizar los clips o comprobar sus propiedades a 
través del menú Thumbnail.
El menú Thumbnail (página 87) aparece cuando 
pulsa el botón MENU y selecciona una imagen en 
miniatura.

Gire el dial SEL/SET (página 9) para seleccionar 
una función y, a continuación, pulse el dial SEL/
SET.
Pulse el botón de CANCEL/BACK (página 9) 
para volver a la pantalla anterior.

Nota

Algunos elementos no pueden seleccionarse, 
dependiendo del estado, cuando se visualiza el menú.

Display Clip Properties
Set Index Picture
Thumbnail View
Set Shot Mark
Set Clip Flag
Lock/Unlock Clip
Delete Clip
Filter Clips
Customize View
Para obtener más información sobre los menús de 
operaciones con clips, consulte la “Menú 
Thumbnail” (página 87).

Visualización de propiedades de clips
Seleccione Display Clip Properties (página 87) 
en el menú Thumbnail para mostrar la pantalla de 
propiedades de los clips.

Visualización de la pantalla de imágenes 
en miniatura de marcadores 
Seleccione Thumbnail View (página 87) 
>Essence Mark Thumbnail en el menú 
Thumbnail y seleccione el tipo de marcador para 
mostrar una visualización de imágenes en 

miniatura de los fotogramas que tienen los 
marcadores especificados.

Visualización de la pantalla de imágenes 
en miniatura de clips filtrados
Seleccione Filter Clips (página 87) en el menú 
Thumbnail y seleccione un tipo de marca para 
mostrar solo aquellos clips que tengan la marca 
especificada.
Para visualizar todos los clips, ajuste Thumbnail 
View > Essence Mark Thumbnail en el menú 
Thumbnail en All.

Eliminación de clips
Puede eliminar clips de tarjetas de memoria 
XQD.
Seleccione Delete Clip >Select Clip o All Clips 
en el menú Thumbnail.
Select Clip:

Elimina el clip seleccionado. Compatible con 
la selección de varios clips.

All Clips:
Elimina todos los clips mostrados.

Cambio de la información mostrada en la 
pantalla de imágenes en miniatura
Puede cambiar la información de fotogramas/
clips que se muestra debajo de la imagen en 
miniatura.
Seleccione Customize View >Thumbnail Caption 
en el menú Thumbnail y seleccione la 
información que desea mostrar.
Date Time:

Muestra la fecha y la hora de creación del clip 
y de su última modificación.

Time Code:
Muestra el código de tiempo.

Duration:
Muestra la duración del clip.

Sequential Number:
Muestra el número secuencial de cada 
imagen en miniatura.

Operaciones con clips

Operaciones con el menú de 
imágenes en miniatura

Elementos del menú Thumbnail
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Pulse el botón MENU para mostrar el menú de 
configuración en el visor con el fin de especificar 
los distintos elementos para filmar, grabar y 
reproducir (el menú también se puede visualizar 
en un monitor externo). El menú de configuración 
incluye los siguientes menús.
Menú User:

Contiene elementos del menú configurados 
por el usuario mediante Edit User Menu.

Menú Edit User:
Contiene elementos del menú para editar el 
menú User.

Menú Camera:
Contiene ajustes relacionados con la 
filmación.

Menú Paint:
Contiene ajustes relacionados con la calidad 
de la imagen.

Menú Audio:
Contiene ajustes relacionados con el audio.

Menú Video:
Contiene ajustes relacionados con la salida 
de vídeo.

Menú VF:
Contiene ajustes de la pantalla del visor.

Menú TC/UB:
Contiene ajustes relacionados con el código 
de tiempo y los bits de usuario.

Menú Recording:
Contiene ajustes relacionados con la 
grabación.

Menú Thumbnail:
Contiene ajustes relacionados con la pantalla 
de imágenes en miniatura.

Menú Media:
Contiene ajustes relacionados con los 
soportes.

Menú File:
Contiene ajustes relacionados con los 
archivos.

Menú System:
Contiene ajustes relacionados con el sistema.

Pantalla de menús y ajustes

Configuración del menú de ajustes y jerarquía

Organización del menú de 
configuración

User
(Ajustes de 
fábrica)

Country

Base Setting

Rec Format

Codec

S&Q Motion

Picture Cache Rec

Simul Rec

Output Format

Monitor LUT

Clip

VF Setting

Assignable Button

Assignable Dial

Format Media

Edit User Menu

Edit User Add Item

Customize Reset

Camera ISO/Gain/EI

Auto Exposure

Focus

Shutter

Color Bars

Noise Suppression

Flicker Reduce

SteadyShot

Handle Zoom

Auto Black Balance

AF Micro Adjustment

Video Light Set

Paint White

Offset White

Black

Gamma

Black Gamma

Knee

White Clip

Detail(HD Mode)

Skin Detail

Aperture

Matrix 

Multi Matrix 

Maintenance
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Audio Audio Input

Audio Output

Video Output On/Off

Output Format

Output Setting

Monitor LUT

Output Display

VF VF Setting

Peaking

Zebra

Marker

Display On/Off

TC/UB Timecode

TC Display

Users Bit

HDMI TC Out

Recording S&Q Motion

Picture Cache Rec

Simul Rec

SDI/HDMI Rec Control

Thumbnail Display Clip Properties

Set Index Picture

Thumbnail View

Set Shot Mark

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Filter Clips

Customize View

Media Update Media

Format Media

Clip

File All File

Scene File

User Menu Item

User Gamma

Monitor LUT

Monitor 3D LUT

Lens File

System Base Setting

Codec

Rec Format

Genlock 

Assignable Button

Assignable Dial

Rec Lamp

Fan Control 

HOLD Switch Setting

Lens

Language

Clock Set

Country

Hours Meter

Basic Authentication

Wi-Fi 

GPS

IR Remote

Camera Battery Alarm

Camera DC IN Alarm

Ext. Unit Battery Alarm

Ext. Unit DC IN Alarm

All Reset

APR

Camera Config

Version
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Pulse el botón MENU para mostrar el menú de 
configuración en el visor con el fin de especificar 
los distintos elementos para filmar, grabar y 
reproducir (el menú también se puede visualizar 
en un monitor externo).

Controles del menú

Botón MENU (página 9)
Activa y desactiva el modo de menú para las 
operaciones del menú de configuración.

Botón izquierdo/botón derecho (página 9) y dial 
SEL/SET (página 9)
Pulse el botón izquierdo/derecho para mover el 
cursor hacia la izquierda/derecha y seleccionar 
elementos o ajustes del menú.
Gire el dial SEL/SET para mover el cursor hacia 
arriba y hacia abajo para seleccionar elementos o 
ajustes del menú.
Pulse el dial SEL/SET para aplicar el elemento 
seleccionado.

Botón CANCEL/BACK (página 9)
Cancela un ajuste antes de que se aplique y sube 
un nivel en la jerarquía del menú.

Nota

El menú de configuración no se puede utilizar cuando el 
modo de ampliación de enfoque está activado 
(página 39).

Elementos del menú de configuración
Gire el dial SEL/SET para mover el cursor hasta 
el elemento del menú que se desea ajustar y, a 
continuación, pulse el dial SET/SEL para 
seleccionar el elemento.
• El área de selección de elementos del menú 

muestra hasta ocho líneas. Si las opciones 
disponibles para un elemento no se pueden 
mostrar al mismo tiempo, desplácese por la 
pantalla moviendo el cursor hacia arriba/abajo.

• Si un elemento tiene una gama muy amplia de 
opciones disponibles 
(Ejemplo: de –99 a +99), el área de selección no 
se muestra. El ajuste actual se resalta para 
indicar que el valor se puede cambiar.

• Si selecciona [Execute] para una función, la 
función correspondiente se ejecutará.

• Si selecciona un elemento que requiere 
confirmación antes de su ejecución, el menú se 
ocultará temporalmente y se mostrará un 
mensaje de confirmación. Compruebe el 
mensaje y a continuación selecciones si desea 
ejecutar o cancelar la función.

Introducción de una cadena de 
caracteres
Cuando selecciona un elemento, como por 
ejemplo un nombre de archivo, que requiere la 
introducción de caracteres, aparecerá la pantalla 
para introducir caracteres.

1 Gire el dial SEL/SET para seleccionar 
un tipo de carácter y, a continuación, 
pulse el dial. 

ABC: caracteres alfabéticos en mayúsculas
abc: caracteres alfabéticos en minúsculas
123: caracteres numéricos
!#$: caracteres especiales

2 Seleccione un carácter del tipo de 
carácter seleccionado y, a continuación, 
pulse el dial.

El cursor pasa al campo siguiente.
Space: introduce un carácter de espacio en la 
posición del cursor.
T/t : mueve la posición del cursor.
BS: elimina el carácter a la izquierda del 
cursos (retroceso).

3 Cuando acabe, seleccione [Done] y 
pulse el dial.

La cadena de caracteres se confirma y la 
pantalla de introducción de caracteres 
desaparece.

Operaciones del menú 
de configuración
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Esta sección describe la función y los ajustes de los elementos en cada menú.
Los ajustes predeterminados de fábrica se muestran en negrita (por ejemplo, 18dB ).

Lista del menú de configuración

Menú User

User

Elemento Ajuste de subelementos Descripción

Country
Ajustes de región

Consulte Country en el menú 
System.

Base Setting
Ajustes básicos

Consulte Base Setting en el menú 
System.

Rec Format
Ajustes del formato de grabación

Consulte Rec Format en el menú 
System.

Codec
Ajustes de códec

Consulte Codec en el menú 
System.

S&Q Motion
Ajustes del modo de movimiento 
lento y rápido

Consulte S&Q Motion en el menú 
Recording.

Picture Cache Rec
Ajustes del modo de grabación de 
memoria intermedia

Consulte Picture Cache Rec en el 
menú Recording.

Simul Rec
Ajustes de grabación simultánea

Consulte Simul Rec en el menú 
Recording.

Output Format
Ajustes del formato de salida

Consulte Output Format en el 
menú Video.

Monitor LUT
Ajustes LUT del monitor

Consulte Monitor LUT en el menú 
Video.

Clip
Ajustes relacionados con los 
nombres de los clips 

Consulte Clip en el menú Media.

VF Setting
Ajustes del visor

Consulte VF Setting en el menú 
VF.

Assignable Button
Ajustes para asignar funciones a 
los botones asignables

Consulte Assignable Button en el 
menú System.

Assignable Dial
Ajustes para asignar funciones a 
los diales asignables

Consulte Assignable Dial en el 
menú System.

Format Media
Formatear (inicializa) tarjeta de 
memoria

Consulte Format Media en el menú 
Media.

Edit User Menu
Edición de los elementos del 
menú User

Edita los elementos en el menú User.
Si selecciona el menú “Edit User Menu”, este 
se mueve al nivel superior y se muestran los 
elementos del menú.
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El menú Edit User se muestra en el nivel superior cuando se selecciona “Edit User Menu” en el menú 
User.

Menú Edit User

Edit User

Elemento Ajuste de subelementos Descripción

Add Item
Adición de un elemento al menú 
User

Agrega un elemento del menú al menú User.

Customize Reset
Restablecimiento de los 
elementos en el menú User

Restaura los elementos del menú registrados 
en el menú User de manera predeterminada de 
fábrica.

Elemento de menú seleccionado 
durante la edición

Delete Elimina el elemento de menú registrado del 
menú User.

Move Reordena los elementos de menú registrados 
dentro del menú User.

Edit Sub Item Elimina los subelementos de menú registrados 
en el menú User.

Menú Camera

Camera

Elemento Ajuste de subelementos Descripción

ISO/Gain/EI
Ajustes de 
ganancia

Mode
ISO/dB

Selecciona el modo de ajuste de ganancia.

ISO/Gain<H>
Cuando Mode se ajusta en ISO y el 
rango dinámico es 460%.

ISO 800 / ISO 1000 / 
ISO 1250 / ISO 1600 / 
ISO 2000 / ISO 2500 / 
ISO 3200 / ISO 4000 / 
ISO 5000 / ISO 6400 

Cuando Mode se ajusta en ISO y el 
rango dinámico es 800%.

ISO 1600 / ISO 2000 /
ISO 2500 / ISO 3200 /
ISO 4000 / ISO 5000 /
ISO 6400 / ISO 8000 /
ISO 10000 / ISO 12500

Ajusta el valor predeterminado de ganancia <H>.
Cuando Mode está ajustado en ISO y el rango dinámico es 
1300% (Gamma Category está ajustado en S-Log2 o S-Log3).

ISO 2000 / ISO 2500 / ISO 3200 /
ISO 4000 / ISO 5000 / ISO 6400 /
ISO 8000 / ISO 10000 / ISO 12500 /
ISO 16000

Cuando Mode está ajustado en dB.
–3dB / 0dB / 3dB / 6dB /
9dB / 12dB / 18dB

El rango dinámico se determina por el gamma.

Gamma Rango dinámico
STD / HG1 / HG2 / HG3 / HG4 460%

HG7 / HG8 / User 800%

S-Log2 / S-Log3 1300%
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ISO/Gain<M>
(El mismo ajuste que ISO/
Gain<H>)

Ajusta el valor predeterminado de ganancia <M>.
Los valores predeterminados se indican abajo.
Cuando Mode se ajusta en ISO y el rango dinámico es 460%.

ISO 1600
Cuando Mode se ajusta en ISO y el rango dinámico es 800%.

ISO 3200
Cuando Mode está ajustado en ISO y el rango dinámico es 
1300% (Gamma Category está ajustado en S-Log2 o S-Log3).

ISO 4000
Cuando Mode está ajustado en dB.

6dB

ISO/Gain<L>
(El mismo ajuste que ISO/
Gain<H>)

Ajusta el valor predeterminado de ganancia <L>.
Los valores predeterminados se indican abajo.
Cuando Mode se ajusta en ISO y el rango dinámico es 460%.

ISO 800
Cuando Mode se ajusta en ISO y el rango dinámico es 800%.

ISO 1600
Cuando Mode está ajustado en ISO y el rango dinámico es 
1300% (Gamma Category está ajustado en S-Log2 o S-Log3).

ISO 2000
Cuando Mode está ajustado en dB.

0dB

Exposure Index<H>
500EI / 4.0E
640EI / 4.3E
800EI / 4.7E
1000EI / 5.0E
1250EI / 5.3E
1600EI / 5.7E
2000EI / 6.0E
2500EI / 6.3E
3200EI / 6.7E
4000EI / 7.0E
5000EI / 7.3E
6400EI / 7.7E
8000EI / 8.0E

Ajusta el valor del índice de exposición <H>.
Disponible solo en modo Cine El.

Exposure Index<M>
(El mismo ajuste que Exposure 
Index<H>)

Ajusta el valor del índice de exposición <M>.
El valor predeterminado es 1600EI / 5.7E

Exposure Index<L>
(El mismo ajuste que Exposure 
Index<H>)

Ajusta el valor del índice de exposición <L>.
El valor predeterminado es 800EI / 4.7E

Shockless Gain
On / Off

Activa y desactiva la función de ganancia sin vibraciones.

Camera

Elemento Ajuste de subelementos Descripción
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Auto Exposure
Configuración de 
ajustes de 
exposición 
automática

Level
–2.0 / –1.75 / –1.5 / –1.25 / 
–1.0 / –0.75 / –0.5 / –0.25 / 0 / 
+0.25 / +0.5 / +0.75 / +1.0 / 
+1.25 / +1.5 / +1.75 / +2.0

Establece el nivel de brillo para la exposición detectada 
automáticamente.

Mode
Backlight / Standard / 
Spotlight

Ajusta el modo de control.
Backlight:

Modo de retroiluminación (modo para reducir el 
oscurecimiento de un sujeto cuando dicho sujeto está 
retroiluminado)

Standard:
Modo estándar

Spotlight:
Modo de luz direccional (modo para reducir la 
sobreexposición de blancos cuando el sujeto recibe un 
iluminación direccional)

Speed
De –99 a +99 (±0)

Establece la velocidad de ajuste.

AGC
On / Off

Activa y desactiva la función AGC (Control automático de 
ganancia).

Camera

Elemento Ajuste de subelementos Descripción
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AGC Limit
Cuando ISO/Gain/EI >Mode está 
establecido en dB.

3dB / 6dB / 9dB / 12dB / 
15dB / 18dB

Cuando ISO/Gain/EI >Mode se 
ajusta en ISO y el rango dinámico 
es 460%.

ISO1000 / ISO1600 / ISO2000 / 
ISO3200 / ISO4000 / ISO6400

Cuando ISO/Gain/EI >Mode se 
ajusta en ISO y el rango dinámico 
es 800%.

ISO2000 / ISO3200 / ISO4000 / 
ISO6400 / ISO8000 / 
ISO12500

Cuando ISO/Gain/EI >Mode se 
ajusta en ISO y el rango dinámico 
es 1300%.

ISO2500 / ISO4000 / ISO5000 / 
ISO8000 / ISO10000 / 
ISO16000

Ajusta la ganancia máxima de la función AGC.

Auto Shutter
On / Off

Activa y desactiva la función de control del obturador 
automático.

A.SHT Limit
1/100 / 1/150 / 1/200 / 
1/250 / 1/2000

Ajusta la velocidad más rápida del obturador en la función de 
obturador automático.

Clip High light
On / Off

Activa y desactiva la función que ignora las zonas más 
iluminadas para proporcionar una reacción menor a la 
luminosidad alta.

Detect Window
1 / 2 / 3 / 4 / 5 / 6

Ajusta el rango del medidor de luz para ajustar 
automáticamente la exposición de acuerdo con la luminosidad 
del sujeto. (No disponible cuando se ajusta la exposición 
manualmente)

Detect Window Indication
On / Off

Activa y desactiva la función Detect Window.

Focus
Ajustes de enfoque

AF Assist
On / Off

Cuando está ajustado en On, le permite anular temporalmente 
el enfoque automático para ajustar el enfoque manualmente.

Camera

Elemento Ajuste de subelementos Descripción
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Shutter
Ajustes de las 
condiciones 
operativas del 
obturador 
electrónico

Mode
Speed / Angle / ECS / Off

Selecciona el modo de operación del obturador electrónico.
Speed/Angle (modo estándar):

Se utiliza para filmar con claridad sujetos que se mueven 
rápidamente. Selecciona el modo para ajustar la velocidad 
del obturador en segundos (Speed) o como el ángulo del 
obturador (Angle).

ECS (Extended Clear Scan):
Se utiliza para filmar sin que aparezcan barras horizontales 
de desplazamiento a lo largo del visor.

Shutter Speed
1/3 a 1/9000

Ajusta la velocidad del obturador cuando Mode está ajustado 
en Speed. Los ajustes disponibles dependen de la frecuencia 
de fotogramas del formato de vídeo seleccionado.
59.94P/59.94i:

1/4, 1/8, 1/15, 1/30, 1/60, 1/90, 1/100, 1/125, 1/180, 1/250, 
1/350, 1/500, 1/725, 1/1000, 1/1500, 1/2000, 1/3000, 
1/4000, 1/6000, 1/9000

50P/50i:
1/3, 1/6, 1/12, 1/25, 1/50, 1/60, 1/100, 1/120, 1/150, 1/215, 
1/300, 1/425, 1/600, 1/1000, 1/1250, 1/1750, 1/2500, 
1/3500, 1/6000, 1/9000

29.97P:
1/4, 1/8, 1/15, 1/30, 1/60, 1/90, 1/100, 1/125, 1/180, 1/250, 
1/350, 1/500, 1/725, 1/1000, 1/1500, 1/2000, 1/3000, 
1/4000, 1/6000, 1/9000

25P:
1/3, 1/6, 1/12, 1/25, 1/50, 1/60, 1/100, 1/120, 1/150, 1/215, 
1/300, 1/425, 1/600, 1/1000, 1/1250, 1/1750, 1/2500, 
1/3500, 1/6000, 1/9000

23.98P:
1/3, 1/6, 1/12, 1/24, 1/40, 1/48, 1/50, 1/60, 1/96, 1/100, 
1/120, 1/144, 1/192, 1/200, 1/288, 1/400, 1/576, 1/1200, 
1/2400, 1/4800, 1/9000

Shutter Angle
5.625° / 11.25° / 22.5° / 45° / 
90° / 120° / 144° / 150° / 
172.8° / 180° / 216° / 300°

Ajusta el ángulo del obturador cuando Mode está ajustado en 
Angle.

ECS Frequency
De 23.99 a 8000 (60)

Ajusta la frecuencia ECS cuando Mode está ajustado en ECS. 
Los ajustes disponibles dependen de la frecuencia de 
fotogramas del formato de vídeo seleccionado.

Color Bars
Ajustes de las 
barras de colores

Setting
On / Off

Activa y desactiva las barras de colores.

Nota

No se puede ajustar en On cuando se ha configurado para 
grabar vídeo RAW.

Type
ARIB / SMPTE / 75% / 100%

Selecciona el tipo de barra de color.

Noise 
Suppression
Ajustes de 
supresión de ruido

Setting
On / Off

Activa y desactiva la función de supresión de ruido.
(Habilitado cuando Base Setting >Shooting Mode en el menú 
System está ajustado en Custom)

Level
Low / Mid / High

Ajusta el nivel de supresión de ruido.

Camera

Elemento Ajuste de subelementos Descripción
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Flicker Reduce
Ajustes de 
corrección de 
parpadeo

Mode
Auto / On / Off

Ajusta el modo de corrección de parpadeo.

Frequency
50Hz / 60Hz

Ajusta la frecuencia de la fuente de alimentación que 
proporciona la iluminación causante del parpadeo.

SteadyShot
Ajustes de 
estabilización de la 
imagen

Setting
Active SteadyShot / 
SteadyShot / Off

Activa y desactiva la función de estabilización de la imagen.

Nota

Habilitado cuando se acopla un objetivo compatible.

Handle Zoom
Ajustes del zoom 
del asa

Zoom Speed Type
Fix / Variable / Off

Ajusta el modo de la palanca del zoom en el asa.

Nota

Desactivado cuando el asa no está acoplada.

Velocidad de zoom
De 1 a 8 (3)

Ajusta la velocidad del zoom del asa.
(Habilitado cuando Zoom Speed Type está ajustado en Fix)

Nota

Desactivado cuando el asa no está acoplada.

Auto Black 
Balance
Ajustes del 
balance 
automático de 
negros

Auto Black Balance
Execute / Cancel

Ejecuta la función de balance automático de negros.

Notas

• Ejecute la función de balance automático de negros con la 
tapa del objetivo acoplada.

• No se puede ejecutar durante la grabación ni cuando se 
muestran las barras de colores.

• No se puede ejecutar cuando se utilizan el modo Interval 
Rec, el modo Frame Rec, el modo Slow & Quick Motion ni 
el modo Slow Shutter.

AF Micro 
Adjustment
Microajuste de la 
posición de 
enfoque
(Habilitado 
cuando se utiliza 
LA-EA2/4 
(opcional))

Setting
On / Off

Activa/desactiva la función de microajuste del enfoque 
automático.

Amount
De –20 a 0 a +20

Ajusta el nivel de microajuste del enfoque automático.
Utilice el siguiente procedimiento para ajustar los objetivos de 
montura A.
1 Acople el objetivo que desea ajustar con LA-EA2/4 

(opcional).
2 Configure Setting en On y ajuste el valor Amount. 

Los valores positivos mueven el enfoque detrás del sujeto, 
mientras que los valores negativos mueven el enfoque 
delante del sujeto.
Se recomienda comprobar el resultado utilizando el AF de 
un toque, por ejemplo, mientras se ajusta el enfoque.

Clear All
Execute / Cancel

Inicializa los valores de ajuste guardados.

Video Light 
Set
Ajustes de luz de 
vídeo (cuando se 
usa HVL-LBPC 
(opcional))

Video Light Set
Power Link / Rec Link / Rec 
Link + Stby

Ajusta el método de control de iluminación para la luz de 
vídeo acoplada a la zapata de interfaces múltiples.
Power Link:

Activa y desactiva la luz de vídeo cuando el camcorder se 
enciende/apaga.

Rec Link:
Activa y desactiva la luz de vídeo cuando el camcorder 
inicia/detiene la grabación.

Rec Link + Stby:
Activa y desactiva la luz de vídeo cuando el camcorder está 
grabando o en modo de espera.

Camera

Elemento Ajuste de subelementos Descripción
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Menú Paint

Paint

Elemento Ajuste de subelementos Descripción

White
Ajustes del 
balance de blancos

Preset White
De 2100K a 10000K (3200K)

Ajusta el valor predeterminado del balance de blancos.

Color Temp<A>
De 1500K a 50000K (3200K)

Visualiza la temperatura de color del balance de blancos que 
está guardada en la memoria A.

Color Temp. Balance<A>
De –99 a +99 (±0)

Ajusta los valores de ganancia del balance de blancos que 
están guardados en la memoria A (relacionado con ganancia R 
y ganancia B).

R Gain<A>
De –99 a +99 (±0)

Ajusta la ganancia R del balance de blancos que está guardada 
en la memoria A.

B Gain<A>
De –99 a +99 (±0)

Ajusta la ganancia B del balance de blancos que está guardada 
en la memoria A.

Color Temp<B>
De 1500K a 50000K (3200K)

Visualiza la temperatura de color del balance de blancos que 
está guardada en la memoria B.

Color Temp. Balance<B>
De –99 a +99 (±0)

Ajusta los valores de ganancia del balance de blancos que 
están guardados en la memoria B (ganancia R y ganancia B 
unidas).

R Gain<B>
De –99 a +99 (±0)

Ajusta la ganancia R del balance de blancos que está guardada 
en la memoria B.

B Gain<B>
De –99 a +99 (±0)

Ajusta la ganancia B del balance de blancos que está guardada 
en la memoria B.

Filter White Memory
On / Off

Activa y desactiva la función que ajusta el área de memoria 
del balance de blancos para cada filtro ND.
On: ajusta la memoria de alance de blancos para cada filtro 
ND.
Off: ajusta la memoria de alance de blancos común a todos los 
filtros ND.

Shockless White
Off / 1 / 2 / 3

Ajusta la velocidad de respuesta del balance de blancos 
cuando se cambia el modo de balance de blancos.
Off: cambia instantáneamente.
De 1 a 3: cambia más lentamente cuanto mayor es el número.

White Switch <B>
Memory / ATW

Selecciona el modo de ajuste de balance de blancos 
seleccionado cuando el interruptor WHT BAL está ajustado 
en B.

ATW Speed
1 / 2 / 3 / 4 / 5

Ajusta la velocidad de respuesta en el modo ATW.
1: Velocidad de respuesta más rápida
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Offset White
Ajustes de 
desviación del 
balance de blancos

Offset White<A>
On / Off

Selecciona si se debe (On) o no se debe (Off) añadir un valor 
de desviación al balance de blancos especificado en la 
memoria A.

Warm Cool <A>
De –99 a +99 (±0)

Ajusta la desviación añadida al balance de blancos en la 
memoria A como una temperatura de color cuando Offset 
White<A> está ajustado en “On”.

Warm Cool Balance<A>
De –99 a +99 (±0)

Ajusta una temperatura de color más precisa que se puede 
utilizar cuando no se obtiene una imagen satisfactoria con 
Warm Cool <A>.

Offset White<B>
On / Off

Selecciona si se debe (On) o no se debe (Off) añadir un valor 
de desviación al balance de blancos especificado en la 
memoria B.

Warm Cool <B>
De –99 a +99 (±0)

Ajusta la desviación añadida al balance de blancos en la 
memoria B como una temperatura de color cuando Offset 
White<B> está ajustado en “On”.

Warm Cool Balance<B>
De –99 a +99 (±0)

Ajusta una temperatura de color más precisa que se puede 
utilizar cuando no se obtiene una imagen satisfactoria con 
Warm Cool <B>.

Offset White<ATW>
On / Off

Selecciona si se debe (On) o no se debe (Off) añadir un valor 
de desviación al balance de blancos ATW.

Warm Cool <ATW>
De –99 a +99 (±0)

Ajusta la desviación añadida al balance de blancos ATW como 
una temperatura de color cuando Offset White<ATW> está 
ajustado en “On”.

Warm Cool Balance<ATW>
De –99 a +99 (±0)

Ajusta una temperatura de color más precisa que se puede 
utilizar cuando no se obtiene una imagen satisfactoria con 
Warm Cool <ATW>.

Black
Ajustes de negro

Setting
On / Off

Activa y desactiva la corrección de negro.

Master Black
De –99 a +99 (±0)

Ajusta el nivel de negro maestro.

Nota

El ajuste fino es compatible girando el dial SEL/SET 
lentamente. En este caso, es posible que el valor que se 
muestra no cambie.

R Black
De –99 a +99 (±0)

Ajusta el nivel de negro R.

B Black
De –99 a +99 (±0)

Ajusta el nivel de negro B.

Paint
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Gamma
Ajustes de 
corrección de 
gamma

Setting
On / Off

Activa y desactiva la función de corrección gamma.

Step Gamma
De 0.35 a 0.45 a 0.90

Ajusta un valor de corrección gamma en incrementos de 0,05.

Master Gamma
De –99 a +99 (±0)

Ajusta el nivel de gamma maestro.

R Gamma
De –99 a +99 (±0)

Ajusta el nivel de gamma R.

G Gamma
De –99 a +99 (±0)

Ajusta el nivel de gamma G.

Gamma Category
STD / HG / User / S-Log2 / 
S-Log3

Selecciona el uso de gamma estándar (STD), HyperGamma 
(HG), gamma de usuario (User), S-Log2 o S-Log3.

Gamma Select
Cuando Gamma Category está 
ajustado en STD.

STD1 DVW / STD2 x 4.5 / 
STD3 x 3.5 / STD4 240M / 
STD5 R709 / STD6 x 5.0

Cuando Gamma Category está 
ajustado en HG.

HG1 3250G36 / HG2 4600G30 
/ HG3 3259G40 / HG4 
4609G33 / HG7 8009G40 / 
HG8 8009G33

Cuando Gamma Category está 
ajustado en User.

User 1 / User 2 / User 3 / User 4 
/ User 5

Cuando Gamma Category está 
ajustado en S-Log2.

S-Log2
Cuando Gamma Category está 
ajustado en S-Log3.

S-Log3

Selecciona la tabla de gamma utilizada para la corrección 
gamma.

Black Gamma Setting
On / Off

Activa y desactiva la función de corrección gamma de negro.
(Habilitado cuando Gamma >Gamma Category está ajustado 
en STD)

Nota

Las funciones Black Gamma y Knee >Knee Saturation no se 
pueden utilizar simultáneamente.

Range
Low / Mid / High

Selecciona el rango efectivo de corrección gamma del negro.

Master Black Gamma
De –99 a +99 (±0)

Ajusta el nivel de gama del negro maestro.

Paint
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Knee Setting
On / Off

Activa y desactiva la función de corrección de inflexión.
(Habilitado cuando Gamma >Gamma Category está ajustado 
en STD)

Auto Knee
On / Off

Activa y desactiva la función de corrección de inflexión 
automática.

Point
De 75% a 109% (90%)

Ajusta el punto de inflexión.

Slope
De –99 a +99 (±0)

ajusta la pendiente de inflexión.

Knee Saturation
On / Off

Habilita/inhabilita el ajuste de la saturación de inflexión 
(ajusta los colores por encima del punto de inflexión).

Nota

Las funciones Black Gamma y Knee >Knee Saturation no se 
pueden utilizar simultáneamente.

Knee Saturation Level
De –99 a +99 (±0)

Ajusta el nivel de ajuste de colores por encima del punto de 
inflexión (saturación de inflexión).

White Clip
Ajustes de ajuste 
de picos del blanco

Setting
On / Off

Activa y desactiva la función de ajuste de picos del blanco.

Nota

No se puede establecer cuando Gamma > Gamma Category se 
ha ajustado en S-Log2 o S-Log3.

Level
Cuando Country no está ajustado 
en PAL Area.

De 90.0% a 109.0% (108.0%)
Cuando Country está ajustado en 
PAL Area.

De 90,0% a 109,0% (105,0%)

Ajusta el nivel de limitación de picos del blanco.

Paint
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Detail
Ajustes de ajuste 
de detalles

Setting
On / Off

Activa y desactiva la función de ajuste de detalles.

Level
De –99 a +99 (±0)

Ajusta el nivel de detalle.

H/V Ratio
De –99 a +99 (±0)

Ajusta la relación de mezcla entre el nivel de detalle H y el 
nivel de detalle V.

Crispening
De –99 a +99 (±0)

Establece el nivel de nitidez.

Level Depend
On / Off

Activa y desactiva la función de ajuste de la dependencia de 
nivel.

Level Depend Level
De –99 a +99 (±0)

Ajusta el nivel de dependencia de nivel.

Frequency
De –99 a +99 (±0)

Ajusta la frecuencia central del detalle (grosor del detalle).
El detalle será más fino cuanto mayor sea la frecuencia central 
y será más grueso cuanto menor sea la frecuencia central.

Knee Aperture
On / Off

Activa y desactiva la función de apertura de inflexión.

Knee Aperture Level
De –99 a +99 (±0)

Establece el nivel de apertura de inflexión.

Limit
De –99 a +99 (±0)

Ajusta el limitador del detalle tanto para la dirección de los 
blancos como para la de los negros.

White Limit
De –99 a +99 (±0)

Ajusta el limitador del detalle de los blancos.

Black Limit
De –99 a +99 (±0)

Ajusta el limitador del detalle de los negros.

V Black Limit
De –99 a +99 (±0)

Ajusta el limitador del detalle V de los negros.

V Detail Creation
NAM / Y / G / G+R

Ajusta la fuente de señal para crear el detalle V en NAM (G o 
R, el que sea mayor), Y, G o G+R.

Skin Detail
Ajustes de 
corrección de las 
imperfecciones de 
la piel

Setting
On / Off

Activa y desactiva la función de corrección de las 
imperfecciones de la piel.

Area Detection
Execute / Cancel

Detecta el color utilizado para la corrección de las 
imperfecciones de la piel.
Execute: Ejecutar la detección

Area Indication
On / Off

Activa y desactiva la función que muestra patrones cebra en 
áreas de color utilizadas para la corrección de imperfecciones 
de la piel.

Level
De –99 a +99 (±0)

Ajusta el nivel de detalle de la piel.

Saturation
De –99 a +99 (±0)

Ajusta la saturación del color que es objeto de la corrección de 
las imperfecciones de la piel.

Hue
De 0 a 359

Ajusta el matiz del color que es objeto de la corrección de las 
imperfecciones de la piel.

Width
De 0 a 90 (40)

Ajusta el rango del matiz del color que es objeto de la 
corrección de las imperfecciones de la piel.

Paint
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Aperture
Ajustes de 
corrección de 
apertura

Setting
On / Off

Habilita/inhabilita la corrección de la apertura (procesamiento 
que mejora la resolución al añadir una señal de apertura de alta 
frecuencia a la señal de vídeo para corregir el deterioro 
producido por las características de alta frecuencia).

Level
De –99 a +99 (±0)

Establece el nivel de corrección de apertura.

Matrix
Ajustes de 
corrección 
matricial

Setting
On / Off

Activa y desactiva la función de corrección matricial.

Adaptive Matrix
On / Off

Activa y desactiva la función de matriz adaptable.

Preset Matrix
On / Off

Activa y desactiva la función de matriz predeterminada.

Preset Select
Standard
High Saturation
FL Light
Cinema
F55 709 Like

Selecciona una matriz predeterminada.

User Matrix
On / Off

Activa y desactiva la función de corrección matricial del 
usuario.

Level
De –99 a +99 (±0)

Ajusta la saturación de color de toda la imagen. 

Phase
De –99 a +99 (±0)

Ajusta el tono de color (fase) de toda la imagen.

User Matrix R-G
De –99 a +99 (±0)

Ajusta una matriz del usuario R-G definida por el usuario.

User Matrix R-B
De –99 a +99 (±0)

Ajusta una matriz del usuario R-B definida por el usuario.

User Matrix G-R
De –99 a +99 (±0)

Ajusta una matriz del usuario G-R definida por el usuario.

User Matrix G-B
De –99 a +99 (±0)

Ajusta una matriz del usuario G-B definida por el usuario.

User Matrix B-R
De –99 a +99 (±0)

Ajusta una matriz del usuario B-R definida por el usuario.

User Matrix B-G
De –99 a +99 (±0)

Ajusta una matriz del usuario B-G definida por el usuario.

Paint
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Multi Matrix
Ajustes de 
corrección de 
matrices múltiples

Setting
On / Off

Activa y desactiva la función de corrección de matrices 
múltiples.

Area Indication
On / Off

Activa y desactiva la función de indicación de área.

Color Detection
Execute / Cancel

Detecta el color utilizado para la corrección de matrices 
múltiples.

Axis
B / B+ / MG– / MG / MG+ / 
R / R+ / YL– / YL / YL+ / G– / 
G / G+ / CY / CY+ / B–

Selecciona el eje.

Hue
De –99 a +99 (±0)

Ajusta el matiz del color utilizado para la corrección de 
matrices múltiples.

Saturation
De –99 a +99 (±0)

Ajusta la saturación del color utilizado para la corrección de 
matrices múltiples.

Maintenance
Ajustes de 
mantenimiento

Test Saw
On / Off

Activa y desactiva la señal de prueba.

Paint
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Menú Audio

Audio

Elemento Ajuste de subelementos Descripción

Audio Input
Ajustes de entrada 
de audio

CH1 Input Select
INPUT1 / Internal MIC / 
Shoe 1

Cambia la fuente de entrada para la grabación en el canal 1.

CH2 Input Select
INPUT1 / INPUT2 / 
Internal MIC / Shoe 2

Cambia la fuente de entrada para la grabación en el canal 2.

CH3 Input Select
Off / Internal MIC / Shoe 1

Cambia la fuente de entrada para la grabación en el canal 3.

CH4 Input Select
Off / Internal MIC / Shoe 2

Cambia la fuente de entrada para la grabación en el canal 4.

INPUT1 MIC Reference
–60dB / –50dB / –40dB

Ajusta el nivel de la grabación de referencia para la entrada 
del micrófono XLR desde INPUT1.

INPUT2 MIC Reference
–60dB / –50dB / –40dB

Ajusta el nivel de la grabación de referencia para la entrada 
del micrófono XLR desde INPUT2.

CH1 Wind Filter
On / Off

Habilita/inhabilita el filtro de reducción de ruido del viento 
para la grabación del canal 1.

CH2 Wind Filter
On / Off

Habilita/inhabilita el filtro de reducción de ruido del viento 
para la grabación del canal 2.

CH3 Wind Filter
On / Off

Habilita/inhabilita el filtro de reducción de ruido del viento 
para la grabación del canal 3.

CH4 Wind Filter
On / Off

Habilita/inhabilita el filtro de reducción de ruido del viento 
para la grabación del canal 4.

CH3 Level Control
Auto / Manual

Selecciona el ajuste de nivel de entrada de audio automático o 
el ajuste manual para el canal de grabación 3.

Nota

Si CH3 Input Select o CH4 Input Select está ajustado en 
“Internal MIC”, CH4 cambia a automático/manual juntamente 
con este ajuste.

CH4 Level Control
Auto / Manual

Selecciona el ajuste de nivel de entrada de audio automático o 
el ajuste manual para el canal de grabación 4.

Nota

Si CH3 Input Select o CH4 Input Select está ajustado en 
“Internal MIC”, CH4 cambia a automático/manual juntamente 
con el ajuste CH3 Level Control.

CH3 Input Level
De 0 a 99 (49)

Establece el nivel de entrada de audio para el canal de 
grabación 3.

Nota

Si CH3 Input Select o CH4 Input Select está ajustado en 
“Internal MIC”, el CH4 Input Level cambia juntamente con 
este ajuste.
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CH4 Input Level
De 0 a 99 (49)

Establece el nivel de entrada de audio para el canal de 
grabación 4.

Nota

Si CH3 Input Select o CH4 Input Select está ajustado en 
“Internal MIC”, el CH4 Input Level cambia juntamente con el 
ajuste CH3 Input Level.

Audio Input Level
De 0 a 99

Ajusta el nivel de entrada de audio.

Limiter Mode
Off / –6dB / –9dB / –12dB / 
–15dB / –17dB

Selecciona la característica del limitador para señales de 
entrada grandes cuando está ajustado el nivel de entrada de 
audio manualmente.

CH1&2 AGC Mode
Mono / Stereo

Establece el modo de ajuste de nivel automático para la 
grabación en el canal 1 y en el canal 2.

CH3&4 AGC Mode
Mono / Stereo

Establece el modo de ajuste de nivel automático para la 
grabación en el canal 3 y en el canal 4.

AGC Spec
–6dB / –9dB / –12dB / 
–15dB / –17dB

Selecciona la característica AGC.

1kHz Tone on Color Bars
On / Off

Activa y desactiva la señal de tono de referencia de 1 kHz 
cuando se muestran las barras de colores.

Nota

Cuando se ajusta en On, la señal de tono de referencia de 
1 kHz se establece para grabar en el canal 3 y en el canal 4, 
aunque CH3 Input Select y CH4 Input Select estén ajustados 
en Off.

CH1 Level
Entrada sin el adaptador de XLR

Audio Input Level / Side / 
Level+Side

Entrada con el adaptador de XLR 
(página 50)

Audio Input Level / Through

Ajusta la combinación de ajustes de nivel de entrada de audio 
habilitada para el canal de grabación 1.

CH2 Level
Entrada sin el adaptador de XLR

Audio Input Level / Side / 
Level+Side

Entrada con el adaptador de XLR 
(página 50)

Audio Input Level / Through

Ajusta la combinación de ajustes de nivel de entrada de audio 
habilitada para el canal de grabación 2.

Audio
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CH3 Level
Entrada sin el adaptador de XLR

Audio Input Level / CH3 Input 
Level / Level+CH3 Input 
Level

Entrada con el adaptador de XLR 
(página 50)

Audio Input Level / Through

Ajusta la combinación de ajustes de nivel de entrada de audio 
habilitada para el canal de grabación 3.

CH4 Level
Entrada sin el adaptador de XLR

Audio Input Level / CH4 Input 
Level / Level+CH4 Input 
Level

Entrada con el adaptador de XLR 
(página 50)

Audio Input Level / Through

Ajusta la combinación de ajustes de nivel de entrada de audio 
habilitada para el canal de grabación 4.

Audio Output
Ajustes de salida 
de audio

Monitor CH
CH1/CH2 / CH3/CH4 / MIX 
ALL / CH1 / CH2 / CH3 / CH4

Selecciona la salida del canal de audio en el conector de 
auriculares y en el altavoz incorporado.

Nota

Si el audio de varios canales se establece para la salida 
simultánea, el nivel de salida de cada canal se reduce para la 
emisión con el fin de evitar la sobreexposición.

Monitor Volume
De 0 a 15 (7)

Ajusta la salida del nivel de audio del monitor al conector de 
auriculares y al altavoz incorporado.

Headphone Out
Mono / Stereo

Selecciona si la salida del conector de los auriculares es 
monoaural (Mono) o estéreo (Stereo).

Alarm Volume
De 0 a 7 (4)

Ajusta el volumen de la alarma.

Output Limiter
On / Off

Activa y desactiva el limitador de salida de audio.

HDMI Output CH
CH1/CH2 / CH3/CH4

Ajusta la combinación de canales de audio en la salida HDMI.

Audio
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Menú Video

Video

Elemento Ajuste de subelementos Descripción

Output On/Off
Ajustes de salida 
de vídeo

SDI
On / Off

Activa y desactiva la salida SDI.

HDMI
On / Off

Activa y desactiva la salida HDMI.

Output Format
Ajustes del 
formato de salida

SDI Ajusta la resolución de salida de SDI y HDMI.
Para obtener más detalles acerca de los ajustes, consulte 
“Formatos de vídeo y señales de salida” (página 104).

HDMI

Output Setting
Ajustes del modo 
de conversión de la 
salida

HDMI Target Device
Recorder / Monitor

Ajusta el tipo de dispositivo de entrada HDMI conectado a la 
salida HDMI.
Recorder:

Emite el mismo vídeo que SDI1 en HDMI cuando se 
encuentra en el modo Cine EI.

Monitor:
Emite el mismo vídeo que SDI2 en HDMI cuando se 
encuentra en el modo Cine EI.

4K/2K a HD Conv.
Edge Crop / Letter Box

Ajusta el modo de conversión de salida de vídeo de 17:9 a 
16:9.
78



Monitor LUT
Ajustes LUT del 
monitor
Disponible solo en 
modo Cine El.

Category
LUT / Look Profile / User 3D 
LUT

Ajusta el tipo de Look aplicado como LUT del monitor.
LUT:

Salidas de vídeo a las que se aplica un LUT 
predeterminado o del usuario.

Look Profile:
Salidas de vídeo similares a vídeos o películas impresas 
que son adecuadas como punto de inicio de la graduación 
de color, si se selecciona un numero de Look.

User 3D LUT:
Salidas de vídeo a las que se aplica un LUT 3D de usuario.

Nota

Es posible que Monitor LUT no se pueda establecer de manera 
independiente para cada sistema (página 117).

LUT Select
P1: 709(800%)
P2: HG8009G40
P3: HG8009G33
P4: S-Log2
P5: S-Log3
U1
U2
U3
U4
U5
U6

Selecciona el tipo de LUT, cuando Monitor LUT >Category 
está ajustado en LUT.
709(800%):

Señal con curva base ITU-R709 con rango dinámico 
ampliado hasta 800%.

HG8009G40:
Señal que utiliza HyperGamma con rango dinámico 800%, 
límite blanco 109% y salida de vídeo de tarjeta gris18% de 
40%.

HG8009G33:
Señal que utiliza HyperGamma con rango dinámico 800%, 
límite blanco 109% y salida de vídeo de tarjeta gris18% de 
33%.

S-Log2:
Señal de registro con rango dinámico 1300% que tiene en 
cuenta la visibilidad en un monitor de vídeo y cuyo metraje 
se revela en posproducción.
(Habilitada cuando Base Setting >Color Space en el menú 
System está ajustado en S-Gamut/SLog2)

S-Log3:
Señal de registro con rango dinámico 1300% que imita las 
características de la película, similar a la curva Cineon Log.
(Habilitada cuando Base Setting >Color Space en el menú 
System está ajustado en S-Gamut3.Cine/SLog3 o S-
Gamut3/SLog3)

U1 to U6:
Señales LUT de usuario importadas desde una tarjeta SD.

Nota

Seleccione F55/F5 como formato de salida al crear un LUT 
mediante el Visor RAW.
Cree e implemente archivos LUT en la siguiente carpeta de 
una tarjeta SD.
\PRIVATE\SONY\PRO\CAMERA\PMWF55_F5

Look Profile Select
1: LC-709
2: LC-709typeA
3: SLog2-709
4: Cine+709

Selecciona el tipo de perfil Look, cuando Monitor LUT 
>Category está ajustado en Look Profile.

Video
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User 3D LUT Select
User 3D-1
User 3D-2
User 3D-3
User 3D-4

Selecciona el tipo de LUT 3D de usuario.

SDI1 & Internal Rec
MLUT On / MLUT Off

Selecciona si se va a aplicar el LUT de monitor al vídeo de 
salida SDI OUT1 y al vídeo grabado en tarjetas de memoria 
XQD.

SDI2
MLUT On / MLUT Off

Selecciona si se aplica el LUT de monitor al vídeo de salida de 
SDI OUT2.

HDMI
MLUT On / MLUT Off

Muestra si se aplica el LUT de monitor al vídeo de salida de 
HDMI (página 117).

Viewfinder
MLUT On / MLUT Off

Selecciona si se aplica el LUT de monitor al vídeo de salida 
del visor.

Output Display
Ajustes de la señal 
de salida

SDI2
On / Off

Selecciona si se superponen los menús y los estados en la 
señal de salida de SDI y en la señal de salida de HDMI.

HDMI
On / Off

Video

Elemento Ajuste de subelementos Descripción
80



Menú VF

VF

Elemento Ajuste de subelementos Descripción

VF Setting
Ajustes del visor

Brightness
De –99 a +99 (±0)

Ajusta el brillo de la imagen del visor.

Color Mode
Color / B&W

Selecciona el modo de visualización del visor en modo E-E/
grabación.

Peaking
Ajustes de nitidez

Setting
On / Off

Activa y desactiva la función de nitidez.

Nota

No se puede ajustar en On cuando Picture Cache Rec está 
ajustado en On.

Peaking Type
Normal / Color

Selecciona el tipo de nitidez.
Normal: Nitidez normal
Color: Nitidez del color

Frequency
Normal / High

Selecciona la frecuencia de nitidez.

Normal Peaking Level
De 0 a 99 (50)

Ajusta el nivel de nitidez normal.

Color
B&W / Red / Yellow / Blue

Selecciona el color de la señal de nitidez de color.

Color Peaking Level
De 0 a 99 (50)

Ajusta el nivel de nitidez de color.

Zebra
Ajustes de los 
patrones de cebra

Setting
On / Off

Activa y desactiva la función cebra.

Nota

No se puede ajustar en On cuando Picture Cache Rec está 
ajustado en On.

Zebra Select
1 / 2 / Both

Selecciona el tipo de patrón de cebra (Zebra 1, Zebra 2, Both).

Zebra1 Level
De 50% a 107% (70%)

Ajusta el nivel de visualización de Zebra 1.

Zebra1 Aperture Level
De 1% a 20% (10%)

Ajusta el nivel de apertura de Zebra 1.

Zebra2 Level
De 52% a 109% (100%)

Ajusta el nivel de visualización de Zebra 2.
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Marker
Ajustes de 
visualización de 
marcadores

Setting
On / Off

Activa y desactiva la visualización de todos los marcadores.

Color
White / Yellow / Cyan / Green / 
Magenta / Red / Blue

Selecciona el color de la señal de los marcadores.

Center Marker
1 / 2 / 3 / 4 / Off

Activa y desactiva el marcador central.

Safety Zone
On / Off

Activa y desactiva el marcador de la zona de seguridad.

Safety Area
80% / 90% / 92.5% / 95%

Selecciona el tamaño del marcador de la zona de seguridad 
(como un porcentaje del tamaño total de la pantalla).

Aspect Marker
Line / Mask / Off

Selecciona el tipo de marcador de aspecto.

Aspect Mask
De 0 a 15 (12)

Ajusta el nivel de señal de vídeo fuera del marcador en 
relación con la señal dentro del marcador en forma de 
porcentaje.

Aspect Safety Zone
On / Off

Activa y desactiva el marcador de la zona de seguridad de 
aspecto.

Aspect Safety Area
80% / 90% / 92.5% / 95%

Selecciona el tamaño del marcador de la zona de seguridad de 
aspecto (como un porcentaje del tamaño total de la pantalla).

Aspect Select
4:3 / 1.66:1 / 
1.85:1 / 2.35:1 / 2.4:1

Ajusta el modo cuando se muestra el marcador de aspecto.

User Box
On / Off

Activa y desactiva la visualización del cursor de cuadro.

User Box Width
De 3 a 479 (240)

Ajusta la amplitud del cursor de cuadro (distancia del centro a 
los bordes derecho e izquierdo).

User Box Height
De 3 a 269 (135)

Ajusta la altura del cursor de cuadro (distancia del centro a los 
bordes superior e inferior).

User Box H Position
De -476 a +476 (0)

Ajusta la posición horizontal del centro del cursor de cuadro.

User Box V Position
De -266 a +266 (0)

Ajusta la posición vertical del centro del cursor de cuadro.

100% Marker
On / Off

Activa y desactiva el marcador de 100 %.

Guide Frame
On / Off

Activa y desactiva la visualización del fotograma de la 
imagen.

VF

Elemento Ajuste de subelementos Descripción
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Display On/Off
Ajustes de los 
elementos de la 
pantalla

Setting
On / Off

Selecciona los elementos que se visualizan en el visor.

Shutter Setting
On / Off

ND Filter Position
On / Off

Gain Setting
On / Off

Rec/Play Status
On / Off

HXR-IFR5 Rec Control
On / Off

Color Temp.
On / Off

Frame Rate
On / Off

Battery Remain
On / Off

Timecode
On / Off

Audio Manual
On / Off

Audio Level Meter
On / Off

Media Status
On / Off

Focus Position
Meter / Feet / Off

Iris Position
On / Off

Zoom Position
Number / Bar / Off

SteadyShot
On / Off

Focus Mode
On / Off

Focus Area Indicator
On / Off

Focus Indicator
On / Off

Auto Shutter
On / Off

AGC
On / Off

Auto Iris
On / Off

AE Mode
On / Off

VF

Elemento Ajuste de subelementos Descripción
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Auto Exposure Level
On / Off

White Balance Mode
On / Off

SDI/HDMI Rec Control
On / Off

Rec Format
On / Off

Gamma
On / Off

Timecode Lock
On / Off

Wi-Fi Condition
On / Off

Video Signal Monitor
Off / Waveform / Vector / 
Histogram

Nota

No se puede establecer cuando la salida SDI no está 
configurada en el menú Video. Se muestra para la salida SDI2 
solamente en los siguientes casos.

– Cuando la salida SDI sea Edge Crop
– Cuando los ajustes On/Off de Monitor LUT sean 

distintos para cada sistema.
Para obtener más detalles, consulte (página 117).

Clip Name
On / Off

Focus Assist Indicator
On / Off

Focus Area Marker
On / Off

Video Level Warning
On / Off

Clip Number
On / Off

GPS
On / Off

Level Gauge
On / Off

Lens Info
Meter / Feet / Off

Notice Message
On / Off

VF

Elemento Ajuste de subelementos Descripción
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Menú TC/UB

TC/UB

Elemento Ajuste de subelementos Descripción

Timecode
Ajustes de código 
de tiempo

Mode
Preset / Regen / Clock

Ajusta el modo de ejecución del código de tiempo.
Preset:

Empieza a funcionar a partir de un valor preestablecido.
Regen:

Empieza a funcionar a partir del código de tiempo del final 
del clip anterior.

Clock:
Utiliza el reloj interno como código de tiempo.

Run
Rec Run / Free Run

Rec Run: Funciona solo durante la grabación.
Free Run: Funciona siempre, independientemente del 
funcionamiento del camcorder.

Setting Ajusta el código de tiempo en un valor arbitrario.
SET: Ajustar el valor.

Reset
Execute / Cancel

Restablece el valor del código de tiempo a 00:00:00:00
Execute: Restablece el código de tiempo

TC Format
DF / NDF

Ajusta el formato del código de tiempo.
DF: Omisión de fotograma
NDF: No omisión de fotograma

TC Display
Ajustes de 
visualización de 
datos de tiempo

Display Select
Timecode / Users Bit / 
Duration

Cambia la visualización de datos de tiempo.

Users Bit
Ajustes 
relacionados con 
los bits de usuario.

Mode
Fix / Time

Ajusta el modo de bit de usuario.
Fix: Utiliza un valor fijo arbitrario en bits de usuario.
Time: Utiliza la hora actual en bits de usuario.

Setting Ajusta los bits de usuario en un valor arbitrario.

HDMI TC Out Setting
On / Off

Ajusta si enviar la salida del código de tiempo a dispositivos 
con otros objetivos, mediante HDMI. 
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Menú Recording

Recording

Elemento Ajuste de subelementos Descripción

S&Q Motion
Ajustes del modo 
de movimiento 
lento y rápido 
(página 46)

Setting
On / Off

Activa y desactiva el movimiento lento y rápido.
Cuando se ajusta en On, se inhabilitan las siguientes 
funciones.
• Auto iris
• Auto focus

High Frame Rate Mode
Off / Full Scan

Permite una velocidad de imágenes superior a 60P.
Off:

Se inhabilita la velocidad de imágenes superior a 60P.
Full Scan:

Facilita las imágenes a alta velocidad con un tamaño de 
fotograma Súper de 35.

Frame Rate
Up to 240fps

Ajusta la velocidad de fotogramas para la filmación con 
movimiento lento y rápido.

Nota

El valor inicial varía según los ajustes de Codec, Country, 
Video Format y RAW Output Format.

Picture Cache 
Rec
Ajustes del modo 
de grabación de 
memoria 
intermedia 
(página 46)

Setting
On / Off

Activa y desactiva la función de grabación de memoria 
intermedia.

Cache Rec Time
0-2sec / 2-4sec / 4-6sec / 
6-8sec / 8-10sec / 
10-12sec / 12-14sec / 
13-15sec

Ajusta el tiempo de grabación de memoria intermedia, cuando 
Picture Cache Rec está ajustado en On.

Simul Rec
Ajustes de 
grabación 
simultánea 
(página 37)

Setting
On / Off

Activa y desactiva la función de grabación simultánea y ajusta 
el soporte de destino de grabación.

Rec Button Set
“Rec Button [SlotA SlotB] 
Handle Rec Button [SlotA 
SlotB]” / “Rec Button [SlotA] 
Handle Rec Button [SlotB]” / 
“Rec Button [SlotB] Handle 
Rec Button [SlotA]”

Asigna los botones de grabación utilizados para controlar cada 
soporte de grabación.

SDI/HDMI Rec 
Control
Ajustes de control 
de grabación SDI/
HDMI

Setting
On / Off

Activa y desactiva el control de inicio/parada de grabación 
para un dispositivo externo conectado, mediante señales SDI/
HDMI.
Cuando se asignan botones distintos mediante Rec Button Set, 
la señal de control de grabación sigue el estado de grabación 
de la ranura A.
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Menú Thumbnail

Thumbnail

Elemento Ajuste de subelementos Descripción

Display Clip 
Properties
Display clip 
properties screen

Muestra la pantalla de propiedades de visualización de clips.

Set Index 
Picture
Ajustes de imagen 
índice de clip

Ajusta la imagen índice de un clip.

Thumbnail 
View
Ajustes de la 
pantalla de 
imágenes en 
miniatura

Essence Mark Thumbnail
All / Rec Start / Shot Mark1 / 
Shot Mark2 / Shot Mark3 / 
Shot Mark4 / Shot Mark5 / 
Shot Mark6 / Shot Mark7 / 
Shot Mark8 / Shot Mark9 / 
Shot Mark0

Muestra las imágenes en miniatura de fotogramas con 
marcadores.

Clip Thumbnail Muestra las imágenes en miniatura de clips grabados.

Set Shot Mark
Ajustes de marcas 
de filmación

Add Shot Mark1 Agrega la marca de filmación 1.

Delete Shot Mark1 Elimina la marca de filmación 1.

Add Shot Mark2 Agrega la marca de filmación 2.

Delete Shot Mark2 Elimina la marca de filmación 2.

Set Clip Flag
Ajustes de marca 
de clip

Add OK Agrega una marca OK.

Add NG Agrega una marca NG.

Add KEEP Agrega una marca Keep.

Delete Clip Flag Elimina todas las marcas.

Lock/Unlock
Clip
Protección de clips

Select Clip Selecciona y bloque/desbloquea un clip.

Lock All Clips Bloquea todos los clips.

Unlock All Clips Desbloquea todos los clips.

Delete Clip
Elimina un clip

Select Clip Elimina el clip seleccionado.

All Clips Elimina todos los clips mostrados.

Filter Clips
Ajustes de 
visualización de 
los clips filtrados

OK Muestra todos los clips con la marca OK.

NG Muestra todos los clips con la marca NG.

KEEP Muestra todos los clips con la marca Keep.

None Muestra solo los clips que no tienen marca.

Customize 
View
Ajustes de la 
pantalla de 
imágenes en 
miniatura

Thumbnail Caption
Date Time / Time Code / 
Duration / Sequential Number

Cambia la información mostrada debajo de las imágenes en 
miniatura.
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Menú Media

Media

Elemento Ajuste de subelementos Descripción

Update Media
Actualizar tarjetas 
de memoria

Media (A)
Execute / Cancel

Actualiza el archivo de gestión en la tarjeta de memoria XQD 
en la ranura A.
Execute: Actualizar la tarjeta

Media (B)
Execute / Cancel

Actualiza el archivo de gestión en la tarjeta de memoria XQD 
en la ranura B.
Execute: Actualizar la tarjeta

Format Media
Formatear 
(inicializa) tarjeta 
de memoria

Media (A)
Execute / Cancel

Inicializa la tarjeta de memoria XQD en la ranura A.
Execute: Inicializar la tarjeta

Media (B)
Execute / Cancel

Inicializa la tarjeta de memoria XQD en la ranura B.
Execute: Inicializar la tarjeta

SD Card
Execute / Cancel

Inicializa la tarjeta UTILITY SD.
Execute: Inicializar la tarjeta

Clip
Ajustes del 
nombre del clip

Auto Naming
Cam ID + Reel# / Title

Ajusta el método para nombrar clips.
Cam ID + Reel#:

ID de la cámara + Número de rollo + Número de filmación 
+ Fecha + cadena aleatoria

Title:
Cadena ajustada con Prefijo de título + Número de clip

Nota

Cuando Simul Rec está ajustado en On, no se puede 
configurar Cam ID + Reel#.

Camera ID
De A a Z

Ajusta el identificador de la cámara cuando Auto Naming está 
ajustado en Cam ID + Reel#.

Reel Number
De 001 a 999

Ajusta la parte numérica del número de rollo cuando Auto 
Naming está ajustado en Cam ID + Reel#.

Camera Position
C / L / R

Ajusta el prefijo del número de filmación cuando Auto 
Naming está ajustado en Cam ID + Reel#.

Title Prefix Ajusta la parte del título del nombre del clip cuando Auto 
Naming está ajustado en Title.
(El valor inicial es un identificador específico del modelo y 
comprende al menos tres dígitos de un número de serie).
(El valor se introduce mediante una pantalla de introducción 
de caracteres (página 60)).

Number Set
De 0001 a 9999

Ajusta la parte numérica del nombre del clip cuando Auto 
Naming está ajustado en Title.
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Menú File

File

Elemento Ajuste de subelementos Descripción

All File
Ajuste relacionado 
con los archivos 
ALL.

Load SD Card
Execute / Cancel

Carga un archivo ALL.
Execute: Cargar archivo

Save SD Card
Execute / Cancel

Guarda un archivo ALL.
Execute: Guardar archivo

File ID Asigna un nombre al archivo.

Scene File
Ajustes de 
archivos de escena

Recall Internal Memory
Execute / Cancel

Carga un archivo de escena desde la memoria interna.
Execute: Cargar archivo

Store Internal Memory
Execute / Cancel

Guarda un archivo de escena en la memoria interna.
Execute: Guardar archivo

Load SD Card
Execute / Cancel

Carga un archivo de escena desde una tarjeta SD.
Execute: Cargar archivo

Save SD Card
Execute / Cancel

Guarda un archivo de escena en una tarjeta SD.
Execute: Guardar archivo

File ID Asigna un nombre al archivo.

Scene White Data
On / Off

Ajusta si se deben aplicar los datos de balance de blancos 
cuando se cargan archivos de escena.

User Menu 
Item
Ajustes de los 
elementos del 
menú de usuario

Load SD Card
Execute / Cancel

Carga los ajustes del menú User en una tarjeta SD de la 
memoria interna.
Execute: Cargar ajustes

Save SD Card
Execute / Cancel

Guarda los ajustes del menú User en una tarjeta SD.
Execute: Guardar ajustes

File ID Muestra el identificador de archivo especificado para el 
archivo cargado mediante Load SD Card. También ajusta 
(edita) el identificador de archivo cuando guarda un archivo 
con este menú.

User Gamma
Ajustes de 
archivos gamma 
de usuario

Current Settings Muestra una lista de los ajustes actuales de archivos gamma de 
usuario (nombres de archivos).

Load SD Card
Execute / Cancel

Carga los ajustes de gamma de usuario en una tarjeta SD de la 
memoria interna.
Execute: Cargar gamma

Reset
1 / 2 / 3 / 4 / 5 / All
Valor inicial: 709(800%)

Restablece los archivos de gamma de usuario en la memoria 
interna a los valores predeterminados.
De 1 a 5: Restablece gamma de usuario individual
All: Restablece todos los gammas de usuario

Monitor LUT
Ajustes de 
archivos LUT del 
monitor

Current Settings Muestra una lista de los ajustes actuales de archivos LUT del 
monitor (nombres de archivos).

Load SD Card
Execute / Cancel

Carga los ajustes de LUT del monitor en una tarjeta SD de la 
memoria interna.
Execute: Cargar ajustes LUT

Reset
1 / 2 / 3 / 4 / 5 / 6 / All

Restablece los datos LUT del monitor en la memoria interna a 
los valores predeterminados.
De 1 a 6: Restablece el LUT de monitor individual
All: Restablece todos los LUT de monitor
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Monitor 3D 
LUT
Ajustes de 
archivos LUT 3D 
del monitor

Current Settings Muestra una lista de los ajustes actuales de archivos LUT 3D 
del monitor (nombres de archivos).

Load SD Card
Execute / Cancel

Carga los ajustes de LUT 3D del monitor en una tarjeta SD de 
la memoria interna.
Execute: carga ajustes LUT 3D

Reset
1 / 2 / 3 / 4 / All

Restablece los datos LUT 3D del monitor en la memoria 
interna a los valores predeterminados.
De 1 a 4: restablece el LUT 3D de monitor individual
All: restablece todos los LUT 3D de monitor

Lens File
Ajustes de 
archivos del 
objetivo

White Offset R
De –99 a +99 (±0)

Ajusta el valor de corrección del canal R de desviación del 
balance de blancos para el objetivo en el archivo del objetivo.

White Offset B
De –99 a +99 (±0)

Ajusta el valor de corrección del canal B de desviación del 
balance de blancos para el objetivo en el archivo del objetivo.

File

Elemento Ajuste de subelementos Descripción
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Menú System

System

Elemento Ajuste de subelementos Descripción

Base Setting
Ajustes básicos

Shooting Mode
Custom / Cine EI

Ajusta el modo de filmación.

Color Space
S-Gamut/SLog2 / 
S-Gamut3.Cine/SLog3 / 
S-Gamut3/SLog3 / Matrix

Ajusta el espacio de color.

Codec
Ajustes de códec

Select
RAW / RAW & XAVC-I / RAW 
& XAVC-L / RAW & MPEG 
HD 422 / XAVC-I / XAVC-L / 
MPEG HD 422 / ProRes 422 
HQ / ProRes 422

Ajusta el modo de grabación/reproducción.

Notas

• RAW / RAW & XAVC-I / RAW & XAVC-L / RAW & 
MPEG HD 422 están disponibles cuando se conecta un 
XDCA-FS7 y Base Setting >Shooting Mode se ajusta en 
Cine EI.

• ProRes 422 HQ / ProRes 422 están disponibles solamente 
cuando se conecta un XDCA-FS7.
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Rec Format
Ajustes de formato 
de grabación

Video Format

• En sistemas NTSC:
Si Codec >Select está ajustado en 
XAVC-I.

4096×2160 59.94P
4096×2160 29.97P
4096×2160 23.98P
3840×2160 59.94P
3840×2160 29.97P
3840×2160 23.98P
1920×1080 59.94P
1920×1080 59.94i
1920×1080 29.97P
1920×1080 23.98P

Si Codec >Select está ajustado en 
XAVC-L.

3840×2160 59.94P
3840×2160 29.97P
3840×2160 23.98P
1920×1080 59.94P 50
1920×1080 59.94P 35
1920×1080 59.94i 50
1920×1080 59.94i 35
1920×1080 59.94i 25
1920×1080 29.97P 50
1920×1080 29.97P 35
1920×1080 23.98P 50
1920×1080 23.98P 35

Si Codec >Select está ajustado en 
MPEG HD422.

1920×1080 59.94i 50
1920×1080 29.97P 50
1920×1080 23.98P 50
1280×720 59.94P 50
1280×720 29.97P 50
1280×720 23.98P 50

Cuando Codec >Select está 
ajustado en ProRes 422 HQ o 
ProRes 422.

1920×1080 59.94i
1920×1080 29.97P
1920×1080 23.98P

Ajusta el formato de grabación.

• En sistemas PAL:
Si Codec >Select está ajustado en XAVC-I.

4096×2160 50P
4096×2160 25P
3840×2160 50P
3840×2160 25P
1920×1080 50P
1920×1080 50i
1920×1080 25P

Si Codec >Select está ajustado en XAVC-L.
3840×2160 50P
3840×2160 25P
1920×1080 50P 50
1920×1080 50P 35
1920×1080 50i 50
1920×1080 50i 35
1920×1080 50i 25
1920×1080 25P 50
1920×1080 25P 35

Si Codec >Select está ajustado en MPEG HD422.
1920×1080 50i 50
1920×1080 25P 50
1280×720 50P 50
1280×720 25P 50

Cuando Codec >Select está ajustado en ProRes 422 HQ o 
ProRes 422.

1920×1080 50i
1920×1080 25P

Notas

• “---”aparece en gris cuando Codec >Select está ajustado en 
RAW.

• Los valores fijos aparecen en gris cuando Codec >Select está 
establecido en RAW & XAVC-I, RAW & XAVC-L o RAW 
& MPEG HD 422.

System

Elemento Ajuste de subelementos Descripción
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RAW Output Format

• En sistemas NTSC:
Si Codec >Select está ajustado en 
un elemento que incluye RAW.

4096×2160 59.94P
4096×2160 29.97P
4096×2160 23.98P
2048×1080 59.94P
2048×1080 29.97P
2048×1080 23.98P

• En sistemas PAL:
Si Codec >Select está ajustado en 
un elemento que incluye RAW.

4096×2160 50P
4096×2160 25P
2048×1080 50P
2048×1080 25P

Ajusta el formato de grabación para una grabadora externa 
RAW.

Genlock
Ajustes del 
generador de 
sincronismo

Reference
Internal / External(HD) / 
External(SD)

Muestra el estado del generador de sincronismo. Muestra el 
tipo de señal si se aplica el generador de sincronismo.
Internal: no se aplica un generador de sincronismo externo.
External(HD): generador de sincronismo a la señal HD.
External(SD): generador de sincronismo a la señal SD.

Assignable 
Button
Ajustes de los 
botones asignables

De <1> a <6>
Off / Marker / Zebra / Peaking / 
Video Signal Monitor / Focus 
Magnifier x4/x8 / Focus Magnifier 
x4 / Focus Magnifier x8 / VF 
Mode / IRIS / Push Auto Iris / 
AGC / Push AGC / SHUTTER / 
Auto Exposure Level / Spotlight / 
Backlight / ATW / ATW Hold / 
Push AF/Focus Hold / SteadyShot 
/ Color Bars / User Menu / Rec 
Lamp / S&Q Motion / Picture 
Cache Rec / Rec Review / 
Thumbnail / Shot Mark1 / Shot 
Mark2 / Clip Flag OK / Clip Flag 
NG / Clip Flag Keep / 
DURATION/TC/U-BIT / High/
Low Key

Asigna funciones a los botones asignables.
Marker:

Activa y desactiva la función de marcador.
Zebra:

Activa y desactiva la función cebra.
Peaking:

Activa y desactiva la función de nitidez.
Video Signal Monitor:

Cambia la visualización de la señal de vídeo (histograma, 
etc.).

Focus Magnifier x4/x8:
Focus Magnifier x4:
Focus Magnifier x8:

Activa y desactiva la función de ampliación de enfoque.
VF Mode:

Cambia la visualización del visor entre color y blanco y 
negro.

IRIS:
Cambia la función del diafragma entre automática y 
manual.

Push Auto Iris:
Habilita la función de diafragma automático mientras se 
mantenga pulsado el botón.

AGC:
Activa y desactiva la función AGC.

System

Elemento Ajuste de subelementos Descripción
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Push AGC:
Habilita la función AGC mientras se mantenga pulsado el 
botón.

SHUTTER:
Cambia la función del obturador entre automática y 
manual.

Auto Exposure Level:
Abre la pantalla de nivel de exposición automático.

Spotlight:
Cambia entre luz direccional y estándar.

Backlight:
Cambia entre retroiluminación y estándar.

ATW:
Activa y desactiva la función ATW.

ATW Hold:
Pausa la operación de la función ATW.

Push AF/Focus Hold:
Ejecuta la función de enfoque automático con un toque o la 
función de detención temporal de enfoque.

SteadyShot:
Cambia entre Active SteadyShot, SteadyShot y Off.

Color Bars:
Activa y desactiva las barras de colores.

User Menu:
Abre/cierra el menú User.

Rec Lamp:
Activa y desactiva el indicador de grabación.

S&Q Motion:
Activa y desactiva el movimiento lento y rápido.

Picture Cache Rec:
Activa y desactiva el modo de grabación de memoria 
intermedia.

Rec Review:
Activa y desactiva la función Rec Review.

Thumbnail:
Abre/cierra la pantalla de imágenes en miniatura.

Shot Mark1:
Ejecuta la función Add Shot Mark1.

Shot Mark2:
Ejecuta la función Add Shot Mark2.

Clip Flag OK:
Ejecuta la función Add OK.
Pulse dos veces para ejecutar Delete Clip Flag.

Clip Flag NG:
Ejecuta la función Add NG.
Pulse dos veces para ejecutar Delete Clip Flag.

Clip Flag Keep:
Ejecuta la función Add Keep.
Pulse dos veces para ejecutar Delete Clip Flag.

DURATION/TC/U-BIT:
Alterna entre Time Code, Users Bit y Duration.

High/Low Key:
Alterna entre High Key, Low Key y Off.

System

Elemento Ajuste de subelementos Descripción
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Assignable 
Dial
Ajustes de diales 
asignables

Assignable Dial
Off / ISO/Gain/EI / IRIS / 
Focus / Audio Input Level

Asigna funciones a los diales asignables en el control remoto 
de empuñadura.
ISO/Gain/EI: Ajusta la ganancia o EI.
IRIS: Ajusta el diafragma.
Focus: Ajusta el enfoque.
Audio Input Level: Ajusta el nivel de audio.

IRIS Dial
(Los mismos ajustes que 
Assignable Dial)

Asigna funciones al dial IRIS.

Assignable Dial Direction
Normal / Opposite

Ajusta el sentido de rotación del dial asignable en el control 
remoto de empuñadura.
Normal: Girar en sentido de avance.
Opposite: Girar en sentido contrario.

IRIS Dial Direction
Normal / Opposite

Ajusta el sentido de rotación del dial IRIS.
Normal: Girar en sentido de avance.
Opposite: Girar en sentido contrario.

Rec Lamp
Ajustes del 
indicador de 
grabación 

Rec Lamp
On / Off

Activa y desactiva el indicador de grabación.

Fan Control
Ajustes del modo 
de control del 
ventilador

Fan Control Mode
Auto / Minimum / Off in Rec

Ajusta el modo de control del ventilador del camcorder.

Nota

Si la temperatura interna del camcorder asciende por encima 
de un valor determinado, el ventilador comenzará a funcionar, 
aunque esté seleccionada la opción “Off in Rec”.

HOLD Switch 
Setting
Ajustes del 
interruptor Hold

with Rec Button
On / Off

Ajusta si se bloquea o no el botón de grabación.

with Hand Grip Remote
On / Off

Ajusta si se bloquea el funcionamiento del control remoto de 
la empuñadura.

Lens
Ajustes del 
objetivo

Zoom Ring Direction
Left(W)/Right(T) / Right(W)/
Left(T)

Ajusta el sentido de funcionamiento del anillo del zoom.

Nota

Solo está habilitado cuando se utiliza un objetivo de montura 
E compatible con el cambio de dirección del anillo de zoom.

Distortion Comp.
Auto / Off

Activa y desactiva la compensación automática de la 
distorsión.

Notas

• No está disponible en el modo de grabación en memoria 
intermedia ni durante la grabación.

• La compensación de la distorsión no se aplica durante la 
grabación 4K o QFHD.

• Cuando “Auto” esté seleccionado, habrá algunas 
restricciones para Monitor LUT (página 117).

Language
Ajustes de idioma

Select Ajusta el idioma de visualización.
SET: Ajustar el lenguaje.

System
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Clock Set
Ajustes del reloj 
interno

Time Zone
UTC 12:00 Kwajalein a UTC 
+14:00

Ajusta la diferencia horaria desde UTC en intervalos de 30 
minutos.

Date Mode
YYMMDD / MMDDYY / 
DDMMYY

Selecciona el formato de visualización de la fecha.
YYMMDD: Año, mes, día
MMDDYY: Mes, año, día
DDMMYY: Día, mes, año

12H/24H
12H / 24H

Ajusta el formato de visualización del reloj.
12H: modo de 12 horas
24H: modo de 24 horas

Date Ajusta la fecha actual.
SET: Ajustar el valor.

Time Ajusta la hora actual.
SET: Ajustar el valor.

Country
Ajustes de región

NTSC/PAL Area
NTSC Area / PAL Area

Ajusta la región de uso.

Hours Meter
Ajustes del 
medidor de horas

Hours (System) Muestra el número de horas acumuladas de uso (no se puede 
restablecer).

Hours (Reset) Muestra el número de horas acumuladas de uso (se puede 
restablecer).

Reset
Execute / Cancel

Restablece la visualización de Hours (Reset) a 0.
Execute: Restablecer

Basic 
Authentication
Ajustes de 
autenticación 
básica de red

User Name  
(admin)

Ajusta un nombre de usuario deseado (entre 1 y 16 caracteres 
alfanuméricos).
SET: Ajustar el valor.

Password
(pxw-fs7)

Ajusta una contraseña (entre 1 y 16 caracteres alfanuméricos).
SET: Ajustar el valor.

Wi-Fi
Ajustes de 
conexión LAN 
inalámbrica

Wi-Fi
Enable / Disable

Selecciona si se activa o desactiva la conexión Wi-Fi.

SSID & Password Muestra el SSID y la contraseña.

Wi-Fi Direct Connection
Execute / Cancel

Inicia una conexión de red “Wi-Fi Direct”.
Execute: Conectar

Client Muestra información acerca del dispositivo cliente conectado 
(nombre de modelo y dirección MAC).

IP Address
192.168.1.1

Muestra la dirección IP del camcorder.

Nota

No se muestra cuando se utiliza el CBK-WA100.

Subnet Mask
255.255.0.0

Muestra la máscara de subred.

Nota

No se muestra cuando se utiliza el CBK-WA100.

MAC Address Muestra la dirección MAC del módulo Wi-Fi acoplado al 
camcorder.

Regenerate Password
Execute / Cancel

Crea una nueva contraseña.
Execute: Ejecutar

GPS
Ajustes de GPS

GPS
On / Off

Activa y desactiva la función GPS.

Nota

El módulo de GPS está integrado en el asa.

System
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IR Remote
Ajustes del control 
remoto

Setting
On / Off

Habilita/deshabilita el control desde el control remoto 
suministrado.

Camera 
Battery Alarm
Ajustes de la 
alarma de tensión 
baja en la batería

Low BATT
5% / 10% / 15% / ··· / 45% / 
50%

Ajusta el nivel de batería restante a partir del cual se mostrará 
una alarma de tensión baja en la batería (saltos de 5%).

BATT Empty
De 3% a 7%

Ajusta el nivel de batería restante a partir del cual se mostrará 
una alarma de batería agotada.

Camera DC IN 
Alarm
Ajustes de alarma 
de tensión de 
entrada

DC Low Voltage1
De 11,5 V a 17,0 V

Ajusta la tensión a partir de la cual se mostrará una alarma de 
tensión de entrada DC IN baja.

DC Low Voltage2
De 11,0 V a 14,0 V

Ajusta la tensión a partir de la cual se mostrará una alarma de 
tensión de entrada DC IN insuficiente.

Ext. Unit 
Battery Alarm
Ajustes de la 
batería XDCA-
FS7

Near End:Info Battery
De 5% a 100%

Ajusta el nivel de batería restante a partir del cual se mostrará 
una alarma de tensión baja en la batería de Info-Lithium 
(intervalos de 5%).

End:Info Battery
De 0% a 5%

Ajusta el nivel de batería restante a partir del cual se mostrará 
una alarma de batería Info-Lithium agotada y se detendrá el 
acceso a los soportes.

Near End:Sony Battery
De 11.5V a 17.0V

Ajusta el nivel de batería restante a partir del cual se mostrará 
una alarma de tensión baja en una batería que no sea Info-
Lithium.

End:Sony Battery
De 11.0V a 11.5V

Ajusta el nivel de batería restante a partir del cual se mostrará 
una alarma de batería que no sea Info-Lithium agotada y se 
detendrá el acceso a los soportes.

Near End:Other Battery
De 11.5V a 17.0V (11.8V)

Ajusta el nivel de batería restante a partir del cual se mostrará 
una alarma de tensión baja en una batería Anton/Bauer.

End:Other Battery
De 11.0V a 14.0V

Ajusta el nivel de batería restante a partir del cual se mostrará 
una alarma de batería Anton/Bauer agotada y se detendrá el 
acceso a los soportes.

Detected Battery Muestra el tipo de batería conectada a la XDCA-FS7.
Si hay una batería conectada a la XDCA-FS7, se mostrará 
“Info Battery”, “Sony Battery” o “Other Battery”. Si se ha 
conectado una fuente de alimentación de CC, se mostrará “DC 
IN”.
Si la alimentación se proporciona mediante una batería o una 
fuente de CC conectada al camcorder, se mostrará “ --- ”.

Ext. Unit DC IN 
Alarm
Ajustes de alarma 
de tensión de 
entrada en XDCA-
FS7

DC Low Voltage1
De 11.5V a 17.0V

Ajusta la tensión a partir de la cual se mostrará una alarma de 
tensión de entrada DC IN baja.

DC Low Voltage2
De 11.0V a 14.0V

Ajusta la tensión a partir de la cual se mostrará una alarma de 
tensión de entrada DC IN insuficiente.

All Reset
Restablece los 
valores 
predeterminados 
de fábrica

Reset
Execute / Cancel

Restablece todos los ajustes a los valores predeterminados de 
fábrica.
Execute: Restablecer
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APR
Ejecutar APR

APR
Execute / Cancel

Ejecuta APR (restauración automática de píxeles) para ajustar 
automáticamente el sensor de imagen.
Execute: Ejecutar

Nota

Coloque siempre la tapa del objetivo antes de ejecutar APR.

Camera Config
Ajustes de salida 
del Down 
Converter

HD/2K Modulation
High / Low

Ajusta el ancho de banda de salida del down-converter para la 
conversión a HD y 2K.

Version
Mostrar la versión

Number
x.xx

Muestra la versión del software del camcorder.

Version Up
Execute / Cancel

Actualiza el camcorder.*
Execute: Ejecutar
* Actualiza el software del camcorder.

Ext. Unit Version Number
x.xx

Muestra la versión del software de XDCA-FS7.

Ext. Unit Version Up
Execute / Cancel

Actualiza XDCA-FS7.*
Execute: Ejecutar
* Actualiza el software de XDCA-FS7.

System
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Para mostrar imágenes de grabación o 
reproducción en un monitor externo, seleccione la 
señal de salida del camcorder y utilice un cable 
adecuado para conectar el monitor.
También puede conectar dispositivos de 
grabación, como una videograbadora y grabar la 
señal de salida desde el camcorder.
Puede mostrar la misma información que aparece 
en el visor, como por ejemplo, la información de 
estado y los menús, en un monitor externo. Ajuste 
Output Display (página 80) en el menú Video en 
“On” para el tipo de señal correspondiente que se 
enviará al monitor.

Conector SDI OUT (tipo BNC)
Active o desactive la salida y ajuste el formato de 
salida a través del menú Video (página 78).
Utilice un cable coaxial de 75 Ω disponible en el 
mercado para realizar la conexión.

Nota

Compruebe que la conexión entre el camcorder y el 
dispositivo externo está conectada a tierra antes de 
encender los dispositivos.
(Se recomienda que el camcorder y el dispositivo externo 
se enciendan después de conectar el cable coaxial de 
75 Ω).
Si el dispositivo externo se debe conectar al camcorder 
mientras este está encendido, conecte primero el cable 
coaxial de 75 Ω al dispositivo externo y, a continuación, 
conéctelo al camcorder.

Para iniciar una grabación en el camcorder y en 
el dispositivo externo simultáneamente
Con la salida de señal SDI habilitada, ajuste SDI/
HDMI Rec Control (página 86) >Setting en el 
menú Recording en “On” para habilitar la salida 
de una señal de activación REC hacia el 
dispositivo externo conectado en el conector SDI 
OUT. Esto sincronizará la grabación en el 
dispositivo externo con el camcorder.

Nota

Si el dispositivo externo conectado no es compatible con 
la señal de activación REC, el dispositivo no se podrá 
utilizar.

Conector HDMI OUT (conector tipo A)
Active o desactive la salida y ajuste el formato de 
salida a través del menú Video (página 78).
Utilice un cable HDMI de alta velocidad 
disponible en el mercado para realizar la 
conexión.
Seleccione el tipo de dispositivo conectado que 
utiliza HDMI Target Device (página 117) en el 
menú Video.

Conector RAW OUT (tipo BNC)
Acople una unidad de extensión XDCA-FS7 al 
camcorder para obtener ayuda para que se pueda 
conectar un grabador RAW externo, como AXS-
R5, al conector RAW OUT de la XDCA-FS7 
(página 33).

Conexión de dispositivos externos

Conexión de dispositivos de grabación y monitores 
externos
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Cuando se filma con varios camcorders, estos se 
pueden sincronizar con una señal de referencia o 
un código de tiempo específico sincronizado a 
través del conector Genlock de las unidades 
XDCA-FS7 (página 12) acopladas a los 
camcorders.

Nota

La batería del camcorder no se puede utilizar cuando la 
unidad XDCA-FS7 también está conectada al 
camcorder. Deberá acoplar la batería a la XDCA-FS7 o 
conectar el camcorder a una toma de alimentación 
externa.

Sincronización de la fase de las señales 
de vídeo (generador de sincronismo)
Habilite el generador de sincronismo mediante el 
suministro de una señal de referencia al conector 
Genlock (página 12) de las unidades XDCA-FS7 
conectadas a los camcorders.
Las señales de referencia que se pueden utilizar 
varían según la velocidad de fotogramas del 
formato de grabación seleccionado.

Para el área NTSC

Para el área PAL

Notas

• Si el formato de grabación seleccionado es 1280×720 
60P, deberá proporcionar una señal de vídeo y una 
señal de tiempo.

• Si la señal de referencia es inestable, no se podrá 
obtener el generador de sincronismo.

• La subportadora no se sincronizará.

Bloqueo del código de tiempo en otros 
dispositivos
Ajuste la unidad que proporciona el código de 
tiempo en un modo en el que la salida del código 
de tiempo siga funcionando (por ejemplo, Free 
Run o Clock).

1 Ajuste Timecode en el menú TC/UB de 
la siguiente manera.

Mode: Preset
Run: Free Run

2 Pulse el botón asignable (página 45) 
correspondiente a la función 
DURATION/TC/U-BIT para mostrar 
los códigos de tiempo en la pantalla.

3 Compruebe que el interruptor TC IN/
OUT (página 12) de la XDCA-FS7 está 
ajustado en la posición IN, y 
proporcione una señal de vídeo de 
referencia HD o SD y un código de 
tiempo sincronizado con la señal de 
vídeo a los conectores del generador de 
sincronismo y TC IN/OUT 
respectivamente.

El generador de códigos de tiempo del camcorder 
se bloqueará con el código de tiempo de 
referencia y “EXT-LK” aparecerá en la pantalla.
Después de que hayan transcurrido diez segundos 
desde el bloqueo del código de tiempo, el estado 
de bloqueo externo se mantendrá incluso si se 
desconecta la fuente externa de códigos de 
tiempo.

Notas

• Compruebe que el código de tiempo de referencia y la 
señal de vídeo de referencia suministrados tienen una 
relación de fase que cumple con el estándar SMPTE de 
códigos de tiempo.

• Cuando se utiliza el bloqueo externo, el código de 
tiempo obtendrá el bloqueo con el código de tiempo 
externo de forma instantánea y el valor de este código 
de tiempo externo aparecerá en el área de visualización 
de datos. Sin embargo, no comience a grabar 

Sincronización externa

Velocidad de 
fotogramas del 
formato de grabación

Señales de referencia 
válidas

59.94P 1920 × 1080 59.94i
720 × 486 59.94i
1280 × 720 59.94P

29.97P 1920 × 1080 59.94i
720 × 486 59.94i

23.98P 1920 × 1080 47.95i 
(23.98PsF)

59.94i 1920 × 1080 59.94i
720 × 486 59.94i

Velocidad de 
fotogramas del 
formato de grabación

Señales de referencia 
válidas

50P 1920 × 1080 50i
720 × 576 50i
1280 × 720 50P

25P 1920 × 1080 50i
720 × 576 50i

50i 1920 × 1080 50i
720 × 576 50i
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inmediatamente. Espere unos segundos antes de 
comenzar a grabar hasta que el generador de 
sincronización se estabilice.

• Si la frecuencia de la señal del vídeo de referencia y la 
frecuencia de fotogramas en el camcorder no son 
iguales, no se podrá conseguir un bloqueo y el 
camcorder no funcionará correctamente. Si esto 
ocurre, el código de tiempo no conseguirá un bloqueo 
correcto con el código de tiempo externo.

• Si la fuente del código de tiempo externo se 
desconecta, es posible que el código de tiempo cambie 
un fotograma por hora con respecto al código de 
tiempo de referencia.

Para liberar el bloqueo externo
Cambie el ajuste Timecode en el menú TC/UB o 
apague el camcorder.
El bloqueo externo también se liberará si 
comienza a grabar en modo Slow & Quick 
Motion.

Sincronización del código de tiempo de 
otro dispositivo con el código de tiempo 
del camcorder
Ajuste la unidad que proporciona el código de 
tiempo en un modo en el que la salida del código 
de tiempo siga funcionando (por ejemplo, Free 
Run o Clock).

1 Ajuste el código de tiempo del 
camcorder mediante Timecode 
(página 85) en el menú TC/UB.

2 Compruebe que el interruptor TC IN/
OUT (página 12) esté ajustado en la 
posición OUT y conecte el conector TC 
IN/OUT y el conector del generador de 
sincronismo (página 12) a la entrada de 
código de tiempo y a la entrada de señal 
de referencia respectivamente, en el 
dispositivo que desea sincronizar.

Uso de un lector de tarjetas XQD 
(opcional)
Conecte un lector de tarjetas XQD MRW-E80 
(opcional) mediante un cable USB e introduzca 
una tarjeta de memoria en la ranura. La tarjeta de 
memoria se reconocerá como una unidad de 
extensión del ordenador.

Uso del modo de almacenamiento 
masivo
Conecte el camcorder mediante un cable USB e 
introduzca una tarjeta de memoria en la ranura. 
La tarjeta de memoria se reconocerá como una 
unidad de extensión del ordenador.

1 Sitúe el interruptor POWER del 
camcorder en la posición ON.

En la pantalla o en el visor aparecerá un 
mensaje que le preguntará si desea habilitar 
la conexión USB.

El mensaje de confirmación de la conexión USB no 
se muestra si en esos momentos aparece otro 
mensaje de confirmación o de proceso en curso, por 
ejemplo, cuando se formatea o se restaura un tarjeta 
de memoria XQD. 
El mensaje de confirmación se mostrará cuando 
finalice el formateo o la restauración. El mensaje de 
confirmación de USB tampoco se muestra mientras 
aparece la pantalla de propiedades del clip. El 
mensaje se mostrará cuando el procesamiento 
finalice o cuando vuelva a la pantalla de imágenes 
en miniatura.

2 Gire el dial SEL/SET y seleccione 
Execute.

Gestión/Edición de clips 
con un ordenador

Conexión con un cable USB

Nota
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3 En Windows, compruebe que la tarjeta 
se ha añadido como un disco extraíble 
en la ventana “Mi Equipo”. 
En Macintosh, compruebe que se crea 
una carpeta “NO NAME” o “Untitled” 
(editable) en el escritorio.

Notas

• No realice las siguientes operaciones si la luz de acceso 
se ilumina en rojo.
- Apagar el dispositivo
- Desconectar el cable de alimentación
- Extraer la tarjeta de memoria XQD
- Desconectar el cable USB

• No se garantiza el funcionamiento en todos los 
ordenadores.

Uso de sistemas de edición no lineales
En un sistema de edición no lineal, es necesario 
disponer de software de edición (opcional) que 
sea compatible con los formatos grabados por el 
camcorder.
Utilice el software específico de aplicaciones para 
guardar previamente los clips que desee editar en 
el disco duro del ordenador.
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El ventilador es un consumible y, como tal, debe 
sustituirse periódicamente.
Si utiliza la unidad a temperatura ambiente, el 
ciclo de sustitución normal será de 5 años 
aproximadamente.
Sin embargo, esto representa solo una directriz 
general y no constituye ninguna garantía de su 
vida útil. Para obtener más información acerca de 
la sustitución de componentes, póngase en 
contacto con el distribuidor.

Si la unidad se lleva de repente de un lugar frío a 
uno cálido o si la temperatura ambiente sufre un 
aumento repentino, es posible que se acumule 
humedad en la superficie exterior o interior de la 
unidad. Este fenómeno se conoce como 
condensación. Si se produce condensación, 
apague la unidad y espere a que se evapore antes 
de ponerla en marcha. No la utilice en ese estado, 
ya que podría dañarla.

El panel LCD de esta unidad ha sido fabricado 
con tecnología de alta precisión y ofrece un índice 
de píxeles funcionales de al menos el 99,99%. Por 
ello, es posible que quede una pequeña 
proporción de píxeles “atascados”, o bien siempre 
apagados (negro), siempre encendidos (rojo, 
verde o azul), o parpadeando. Además, a lo largo 
de un amplio periodo de tiempo, esos píxeles 
“atascados” pueden ir apareciendo 
espontáneamente debido a las características de la 
pantalla de cristal líquido. Esto no significa que la 
unidad funcione mal. Tenga en cuenta que dichos 
problemas no producen efectos en los datos 
grabados.

La terminal de la batería de esta unidad (el 
conector para paquetes de pilas y adaptadores de 
CA) es una parte consumible.
Puede que la unidad no funcione correctamente si 
los contactos de las pilas están doblados o 
deformados debido a algún golpe o a vibraciones 
o si se han corroído debido a un uso prolongado 
en el exterior.
Se recomienda realizar inspecciones periódicas 
para que la unidad continúe funcionando 
correctamente y para prolongar su vida útil.

Acerca de la batería recargable incorporada
Contacte con el servicio de asistencia técnica de 
Sony o con el responsable de ventas para obtener 
más información sobre las inspecciones.
El camcorder dispone de una batería recargable 
incorporada que almacena la fecha, la hora y otros 
ajustes incluso cuando está apagado. La batería 
recargable tardará aproximadamente 3 meses en 
descargarse por completo si no se conecta el 
adaptador de CA o si se utiliza el camcorder sin la 
batería. Cargue la batería antes de utilizar el 
camcorder.
No obstante, aunque la batería recargable 
incorporada no esté cargada, el funcionamiento 
del camcorder no se verá afectado, a menos que 
esté grabando la fecha y la hora.

Apéndice

Precauciones de uso
103



Los ajustes predeterminados de fábrica se muestran en negrita (por ejemplo, 2048×1080P (Level A)).

Nota

Si la resolución de la salida de vídeo es mayor que la resolución de la imagen, no se emite ninguna imagen reproducida.

Formatos de salida del conector SDI OUT

Cuando Country >NTSC/PAL Area en el menú System está ajustado en NTSC Area

Cuando se utilice una configuración básica (XAVC-I / XAVC-L / MPEG HD)

Limitaciones y formatos de salida

 Formatos de vídeo y señales de salida

Ajustes de formato de grabación
(Rec Format >Video Format en el 
menú System)

Ajustes de salida SDI/HDMI
(Output Format >SDI y 
HDMI en el menú Video)

Señal de salida SDI

SDI HDMI
4096 × 2160 59.94P – 4096 × 2160P Sin salida

– 3840 × 2160P Sin salida

1920 × 1080P 
(Level A)

1920 × 1080P 1920 × 1080 59.94P Level-A

1920 × 1080P 
(Level B)

– 1920 × 1080 59.94P Level-B

1920 × 1080i 1920 × 1080i 1920 × 1080 59.94i

4096 × 2160 29.97P – 4096 × 2160P Sin salida

– 3840 × 2160P Sin salida

1920 × 
1080PsF

1920 × 1080i 1920 × 1080 29.97PsF

4096 × 2160 23.98P – 4096 × 2160P Sin salida

– 3840 × 2160P Sin salida

1920 × 
1080PsF

– 1920 × 1080 23.98PsF

– 1920 × 1080P Sin salida

3840 × 2160 59.94P – 4096 × 2160P Sin salida

– 3840 × 2160P Sin salida

1920 × 1080P 
(Level A)

1920 × 1080P 1920 × 1080 59.94P Level-A

1920 × 1080P 
(Level B)

– 1920 × 1080 59.94P Level-B

1920 × 1080i 1920 × 1080i 1920 × 1080 59.94i

3840 × 2160 29.97P – 4096 × 2160P Sin salida

– 3840 × 2160P Sin salida

1920 × 
1080PsF

1920 × 1080i 1920 × 1080 29.97PsF
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3840 × 2160 23.98P – 4096 × 2160P Sin salida

– 3840 × 2160P Sin salida

1920 × 
1080PsF

– 1920 × 1080 23.98PsF

– 1920 × 1080P Sin salida

1920 × 1080 59.94P 2048 × 1080P 
(Level A)

– 2048 × 1080 59.94P Level-A

2048 × 1080P 
(Level B)

– 2048 × 1080 59.94P Level-B

1920 × 1080P 
(Level A)

1920 × 1080P 1920 × 1080 59.94P Level-A

1920 × 1080P 
(Level B)

– 1920 × 1080 59.94P Level-B

1920 × 1080i 1920 × 1080i 1920 × 1080 59.94i

– 720 × 480i Sin salida

– 720 × 480P Sin salida

1920 × 1080 59.94i 1920 × 1080i 1920 × 1080i 1920 × 1080 59.94i 

– 720 × 480i Sin salida

– 720 × 480P Sin salida

1920 × 1080 29.97P 2048 × 1080PsF – 2048 × 1080 29.97PsF

1920 × 
1080PsF

1920 × 1080i 1920 × 1080 29.97PsF

– 720 × 480i Sin salida

1920 × 1080 23.98P 2048 × 1080PsF – 2048 × 1080 23.98PsF

1920 × 
1080PsF

– 1920 × 1080 23.98PsF

– 1920 × 1080P Sin salida

1920 × 1080i (2-
3PD)

1920 × 1080i (2-
3PD)

1920 × 1080 59.94i (2-3PD)

– 720 × 480i (2-
3PD)

Sin salida

1280 × 720 59.94P 1280 × 720P 1280 × 720P 1280 × 720 59.94P

– 720 × 480i Sin salida

– 720 × 480P Sin salida

1280 × 720 29.97P 1280 × 720P 1280 × 720P 1280 × 720 59.94P (2-2RP)

– 720 × 480i Sin salida

1280 × 720 23.98P 1280 × 720P (2-
3PD)

1280 × 720P (2-
3PD)

1280 × 720 59.94P (2-3PD)

– 720 × 480i (2-
3PD)

Sin salida

Ajustes de formato de grabación
(Rec Format >Video Format en el 
menú System)

Ajustes de salida SDI/HDMI
(Output Format >SDI y 
HDMI en el menú Video)

Señal de salida SDI

SDI HDMI
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Cuando se utiliza una unidad de extensión (RAW)

Ajustes de formato de grabación
(Rec Format >RAW Output Format y 
Video Format en el menú System)

Ajustes de salida SDI/HDMI
(Output Format >SDI y 
HDMI en el menú Video)

Señal de salida SDI

SDI HDMI

RAW Output Format
4096 × 2160 59.94P

Video Format (valor fijo)
1920 × 1080 59.94P

2048 × 1080P 
(Level A)

– 2048 × 1080 59.94P Level-A

2048 × 1080P 
(Level B)

– 2048 × 1080 59.94P Level-B

1920 × 1080P 
(Level A)

1920 × 1080P 1920 × 1080 59.94P Level-A

1920 × 1080P 
(Level B)

– 1920 × 1080 59.94P Level-B

1920 × 1080i 1920 × 1080i 1920 × 1080 59.94i

RAW Output Format
4096 × 2160 59.94P

Video Format (valor fijo)
1280 × 720 59.94P

2048 × 1080P 
(Level A)

– 2048 × 1080 59.94P Level-A

2048 × 1080P 
(Level B)

– 2048 × 1080 59.94P Level-B

1920 × 1080P 
(Level A)

1920 × 1080P 1920 × 1080 59.94P Level-A

1920 × 1080P 
(Level B)

– 1920 × 1080 59.94P Level-B

1280 × 720P 1280 × 720P 1280 × 720 59.94P

RAW Output Format
2048 × 1080 59.94P

Video Format (valor fijo)
1920 × 1080 59.94P 

2048 × 1080P 
(Level A)

– 2048 × 1080 59.94P Level-A

2048 × 1080P 
(Level B)

– 2048 × 1080 59.94P Level-B

1920 × 1080P 
(Level A)

1920 × 1080P 1920 × 1080 59.94P Level-A

1920 × 1080P 
(Level B)

– 1920 × 1080 59.94P Level-B

1920 × 1080i 1920 × 1080i 1920 × 1080 59.94i

RAW Output Format
2048 × 1080 59.94P

Video Format (valor fijo)
1280 × 720 59.94P 

2048 × 1080P 
(Level A)

– 2048 × 1080 59.94P Level-A

2048 × 1080P 
(Level B)

– 2048 × 1080 59.94P Level-B

1920 × 1080P 
(Level A)

1920 × 1080P 1920 × 1080 59.94P Level-A

1920 × 1080P 
(Level B)

– 1920 × 1080 59.94P Level-B

1280 × 720P 1280 × 720P 1280 × 720 59.94P

RAW Output Format
4096 × 2160 29.97P

Video Format (valor fijo)
1920 × 1080 29.97P

2048 × 
1080PsF

– 2048 × 1080 29.97PsF

1920 × 1080PsF 1920 × 1080i 1920 × 1080 29.97PsF

RAW Output Format
2048 × 1080 29.97P

Video Format (valor fijo)
1920 × 1080 29.97P 

2048 × 
1080PsF

– 2048 × 1080 29.97PsF

1920 × 1080PsF 1920 × 1080i 1920 × 1080 29.97PsF
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Cuando se utiliza una unidad de extensión (ProRes 422)

*1 No puede emitir una señal compatible con el CBK-WA100.

Cuando Country >NTSC/PAL Area en el menú System está ajustado en PAL Area

Cuando se utilice una configuración básica (XAVC-I / XAVC-L / MPEG HD)

RAW Output Format
4096 × 2160 23.98P

Video Format (valor fijo)
1920 × 1080 23.98P

2048 × 
1080PsF

– 2048 × 1080 23.98PsF

1920 × 1080PsF – 1920 × 1080 23.98PsF

– 1920 × 1080P Sin salida

RAW Output Format
2048 × 1080 23.98P

Video Format (valor fijo)
1920 × 1080 23.98P

2048 × 
1080PsF

– 2048 × 1080 23.98PsF

1920 × 1080PsF – 1920 × 1080 23.98PsF

– 1920 × 1080P Sin salida

Ajustes de formato de grabación
(Rec Format >Video Format en el 
menú System)

Ajustes de salida SDI/HDMI
(Output Format >SDI y 
HDMI en el menú Video)

Señal de salida SDI

SDI HDMI
1920 × 1080 59.94i 1920 × 1080i 1920 × 1080i 1920 × 1080 59.94i

1920 × 1080 29.97P 1920 × 
1080PsF

1920 × 1080i SDI OUT 1
1920 × 1080 29.97P

SDI OUT 2
1920 × 1080 29.97PsF

1920 × 1080 23.98P 1920 × 1080P 1920 × 1080P 1920 × 1080 23.98P *1

Ajustes de formato de grabación
(Rec Format >Video Format en el 
menú System)

Ajustes de salida SDI/HDMI
(Output Format >SDI y 
HDMI en el menú Video)

Señal de salida SDI

SDI HDMI
4096 × 2160 50P – 4096 × 2160P Sin salida

– 3840 × 2160P Sin salida

1920 × 1080P 
(Level A)

1920 × 1080P 1920 × 1080 50P Level-A

1920 × 1080P 
(Level B)

– 1920 × 1080 50P Level-B

1920 × 1080i 1920 × 1080i 1920 × 1080 50i

4096 × 2160 25P – 4096 × 2160P Sin salida

– 3840 × 2160P Sin salida

1920 × 
1080PsF

1920 × 1080i 1920 × 1080 25PsF

Ajustes de formato de grabación
(Rec Format >RAW Output Format y 
Video Format en el menú System)

Ajustes de salida SDI/HDMI
(Output Format >SDI y 
HDMI en el menú Video)

Señal de salida SDI

SDI HDMI
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3840 × 2160 50P – 4096 × 2160P Sin salida

– 3840 × 2160P Sin salida

1920 × 1080P 
(Level A)

1920 × 1080P 1920 × 1080 50P Level-A

1920 × 1080P 
(Level B)

– 1920 × 1080 50P Level-B

1920 × 1080i 1920 × 1080i 1920 × 1080 50i

3840 × 2160 25P – 4096 × 2160P Sin salida

– 3840 × 2160P Sin salida

1920 × 
1080PsF

1920 × 1080i 1920 × 1080 25PsF

1920 × 1080 50P 2048 × 1080P 
(Level A)

– 2048 × 1080 50P Level-A

2048 × 1080P 
(Level B)

– 2048 × 1080 50P Level-B

1920 × 1080P 
(Level A)

1920 × 1080P 1920 × 1080 50P Level-A

1920 × 1080P 
(Level B)

– 1920 × 1080 50P Level-B

1920 × 1080i 1920 × 1080i 1920 × 1080 50i

– 720 × 576i Sin salida

– 720 × 576P Sin salida

1920 × 1080 50i 1920 × 1080i 1920 × 1080i 1920 × 1080 50i

– 720 × 576i Sin salida

– 720 × 576P Sin salida

1920 × 1080 25P 2048 × 1080PsF – 2048 × 1080 25PsF

1920 × 
1080PsF

1920 × 1080i 1920 × 1080 25PsF

– 720 × 576i Sin salida

1280 × 720 50P 1280 × 720P 1280 × 720P 1280 × 720 50P

– 720 × 576i Sin salida

– 720 × 576P Sin salida

1280 × 720 25P 1280 × 720P 1280 × 720P 1280 × 720 50P (2-2RP)

– 720 × 576i Sin salida

Ajustes de formato de grabación
(Rec Format >Video Format en el 
menú System)

Ajustes de salida SDI/HDMI
(Output Format >SDI y 
HDMI en el menú Video)

Señal de salida SDI

SDI HDMI
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Cuando se utiliza una unidad de extensión (RAW)

Ajustes de formato de grabación
(Rec Format >RAW Output Format y 
Video Format en el menú System)

Ajustes de salida SDI/HDMI
(Output Format >SDI y 
HDMI en el menú Video)

Señal de salida SDI

SDI HDMI

RAW Output Format
4096 × 2160 50P

Video Format (valor fijo)
1920 × 1080 50P

2048 × 1080P 
(Level A)

– 2048 × 1080 50P Level-A

2048 × 1080P 
(Level B)

– 2048 × 1080 50P Level-B

1920 × 1080P 
(Level A)

1920 × 1080P 1920 × 1080 50P Level-A

1920 × 1080P 
(Level B)

– 1920 × 1080 50P Level-B

1920 × 1080i 1920 × 1080i 1920 × 1080 50i

RAW Output Format
4096 × 2160 50P

Video Format (valor fijo)
1280 × 720 50P 

2048 × 1080P 
(Level A)

– 2048 × 1080 50P Level-A

2048 × 1080P 
(Level B)

– 2048 × 1080 50P Level-B

1920 × 1080P 
(Level A)

1920 × 1080P 1920 × 1080 50P Level-A

1920 × 1080P 
(Level B)

– 1920 × 1080 50P Level-B

1280 × 720P 1280 × 720P 1280 × 720 50P

RAW Output Format
2048 × 1080 50P

Video Format (valor fijo)
1920 × 1080 50P

2048 × 1080P 
(Level A)

– 2048 × 1080 50P Level-A

2048 × 1080P 
(Level B)

– 2048 × 1080 50P Level-B

1920 × 1080P 
(Level A)

1920 × 1080P 1920 × 1080 50P Level-A

1920 × 1080P 
(Level B)

– 1920 × 1080 50P Level-B

1920 × 1080i 1920 × 1080i 1920 × 1080 50i

RAW Output Format
2048 × 1080 50P

Video Format (valor fijo)
1280 × 720 50P 

2048 × 1080P 
(Level A)

– 2048 × 1080 50P Level-A

2048 × 1080P 
(Level B)

– 2048 × 1080 50P Level-B

1920 × 1080P 
(Level A)

1920 × 1080P 1920 × 1080 50P Level-A

1920 × 1080P 
(Level B)

– 1920 × 1080 50P Level-B

1280 × 720P 1280 × 720P 1280 × 720 50P

RAW Output Format
4096 × 2160 25P

Video Format (valor fijo)
1920 × 1080 25P 

2048 × 
1080PsF

– 2048 × 1080 25PsF

1920 × 1080PsF 1920 × 1080i 1920 × 1080 25PsF

RAW Output Format
2048 × 1080 25P

Video Format (valor fijo)
1920 × 1080 25P 

2048 × 
1080PsF

– 2048 × 1080 25PsF

1920 × 1080PsF 1920 × 1080i 1920 × 1080 25PsF
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Cuando se utiliza una unidad de extensión (ProRes 422)

Ajustes de formato de grabación
(Rec Format >Video Format en el 
menú System)

Ajustes de salida SDI/HDMI
(Output Format >SDI y 
HDMI en el menú Video)

Señal de salida SDI

SDI HDMI
1920 × 1080 50i 1920 × 1080i 1920 × 1080i 1920 × 1080 50i

1920 × 1080 25P 1920 × 
1080PsF

1920 × 
1080PsF

SDI OUT 1
1920 × 1080 25P

SDI OUT 2
1920 × 1080 25PsF
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Formatos de salida del conector HDMI OUT

Cuando Country >NTSC/PAL Area en el menú System está ajustado en NTSC Area

Cuando se utilice una configuración básica (XAVC-I / XAVC-L / MPEG HD)

Ajustes de formato de grabación
(Rec Format >Video Format en el 
menú System)

Ajustes de salida SDI/HDMI
(Output Format >SDI y 
HDMI en el menú Video)

Señal de salida de HDMI

SDI HDMI
4096 × 2160 59.94P – 4096 × 2160P 4096 × 2160 59.94P

– 3840 × 2160P 3840 × 2160 59.94P

1920 × 1080P 
(Level A)

1920 × 1080P 1920 × 1080 59.94P

1920 × 1080P 
(Level B)

– Sin salida

1920 × 1080i 1920 × 1080i 1920 × 1080 59.94i

4096 × 2160 29.97P – 4096 × 2160P 4096 × 2160 29.97P

– 3840 × 2160P 3840 × 2160 29.97P

1920 × 
1080PsF

1920 × 1080i 1920 × 1080 29.97PsF

4096 × 2160 23.98P – 4096 × 2160P 4096 × 2160 23.98P

– 3840 × 2160P 3840 × 2160 23.98P

1920 × 
1080PsF

– Sin salida

– 1920 × 1080P 1920×1080 23.98P (Puro)

3840 × 2160 59.94P – 4096 × 2160P 4096 × 2160 59.94P

– 3840 × 2160P 3840 × 2160 59.94P

1920 × 1080P 
(Level A)

1920 × 1080P 1920 × 1080 59.94P

1920 × 1080P 
(Level B)

– Sin salida

1920 × 1080i 1920 × 1080i 1920 × 1080 59.94i

3840 × 2160 29.97P – 4096 × 2160P 4096 × 2160 29.97P

– 3840 × 2160P 3840 × 2160 29.97P

1920 × 
1080PsF

1920 × 1080i 1920 × 1080 29.97PsF

3840 × 2160 23.98P – 4096 × 2160P 4096 × 2160 23.98P

– 3840 × 2160P 3840 × 2160 23.98P

1920 × 
1080PsF

– Sin salida

– 1920 × 1080P 1920×1080 23.98P (Puro)
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1920 × 1080 59.94P 2048 × 1080P 
(Level A)

– Sin salida

2048 × 1080P 
(Level B)

– Sin salida

1920 × 1080P 
(Level A)

1920 × 1080P 1920 × 1080 59.94P

1920 × 1080P 
(Level B)

– Sin salida

1920 × 1080i 1920 × 1080i 1920 × 1080 59.94i

– 720 × 480i 720 × 480 59.94i

– 720 × 480P 720 × 480 59.94P

1920 × 1080 59.94i 1920 × 1080i 1920 × 1080i 1920 × 1080 59.94i

– 720 × 480i 720 × 480 59.94i

– 720 × 480P 720 × 480 59.94P

1920 × 1080 29.97P 2048 × 1080PsF – Sin salida

1920 × 
1080PsF

1920 × 1080i 1920 × 1080 29.97PsF

– 720 × 480i 720 × 480 59.94i (PsF)

1920 × 1080 23.98P 2048 × 1080PsF – Sin salida

1920 × 
1080PsF

– Sin salida

– 1920 × 1080P 1920×1080 23.98P (Puro)

1920 × 1080i (2-
3PD)

1920 × 1080i (2-
3PD)

1920 × 1080 59.94i (2-3PD)

– 720 × 480i (2-
3PD)

720 × 480 59.94i (2-3PD)

1280 × 720 59.94P 1280 × 720P 1280 × 720P 1280 × 720 59.94P

– 720 × 480i 720 × 480 59.94i

– 720 × 480P 720 × 480 59.94P

1280 × 720 29.97P 1280 × 720P 1280 × 720P 1280 × 720 59.94P (2-2RP)

– 720 × 480i 720 × 480 59.94i (PsF)

1280 × 720 23.98P 1280×720P (2-
3PD)

1280×720P (2-
3PD)

1280 × 720 59.94P (2-3PD)

– 720 × 480i (2-
3PD)

720 × 480 59.94i

Ajustes de formato de grabación
(Rec Format >Video Format en el 
menú System)

Ajustes de salida SDI/HDMI
(Output Format >SDI y 
HDMI en el menú Video)

Señal de salida de HDMI

SDI HDMI
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Cuando se utiliza una unidad de extensión (RAW)

Ajustes de formato de grabación
(Rec Format >RAW Output Format y 
Video Format en el menú System)

Ajustes de salida SDI/HDMI
(Output Format >SDI y 
HDMI en el menú Video)

Señal de salida de HDMI

SDI HDMI

RAW Output Format
4096 × 2160 59.94P

Video Format (valor fijo)
1920 × 1080 59.94P

2048 × 1080P 
(Level A)

– Sin salida

2048 × 1080P 
(Level B)

– Sin salida

1920 × 1080P 
(Level A)

1920 × 1080P 1920 × 1080 59.94P

1920 × 1080P 
(Level B)

– Sin salida

1920 × 1080i 1920 × 1080i 1920 × 1080 59.94i

RAW Output Format
4096 × 2160 59.94P

Video Format (valor fijo)
1280 × 720 59.94P

2048 × 1080P 
(Level A)

– Sin salida

2048 × 1080P 
(Level B)

– Sin salida

1920 × 1080P 
(Level A)

1920 × 1080P 1920 × 1080 59.94P

1920 × 1080P 
(Level B)

– Sin salida

1280 × 720P 1280 × 720P 1280 × 720 59.94P

RAW Output Format
2048 × 1080 59.94P

Video Format (valor fijo)
1920 × 1080 59.94P 

2048 × 1080P 
(Level A)

– Sin salida

2048 × 1080P 
(Level B)

– Sin salida

1920 × 1080P 
(Level A)

1920 × 1080P 1920 × 1080 59.94P

1920 × 1080P 
(Level B)

– Sin salida

1920 × 1080i 1920 × 1080i 1920 × 1080 59.94i

RAW Output Format
2048 × 1080 59.94P

Video Format (valor fijo)
1280 × 720 59.94P 

2048 × 1080P 
(Level A)

– Sin salida

2048 × 1080P 
(Level B)

– Sin salida

1920 × 1080P 
(Level A)

1920 × 1080P 1920 × 1080 59.94P

1920 × 1080P 
(Level B)

– Sin salida

1280 × 720P 1280 × 720P 1280 × 720 59.94P

RAW Output Format
4096 × 2160 29.97P

Video Format (valor fijo)
1920 × 1080 29.97P 

2048 × 
1080PsF

– Sin salida

1920 × 1080PsF 1920 × 1080i 1920 × 1080 29.97PsF

RAW Output Format
2048 × 1080 29.97P

Video Format (valor fijo)
1920 × 1080 29.97P

2048 × 
1080PsF

– Sin salida

1920 × 1080PsF 1920 × 1080i 1920 × 1080 29.97PsF
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Cuando se utiliza una unidad de extensión (ProRes 422)

Cuando Country >NTSC/PAL Area en el menú System está ajustado en PAL Area

Cuando se utilice una configuración básica (XAVC-I / XAVC-L / MPEG HD)

RAW Output Format
4096 × 2160 23.98P

Video Format (valor fijo)
1920 × 1080 23.98P

2048 × 
1080PsF

– Sin salida

1920 × 1080PsF – Sin salida

– 1920 × 1080P 1920×1080 23.98P (Puro)

RAW Output Format
2048 × 1080 23.98P

Video Format (valor fijo)
1920 × 1080 23.98P

2048 × 
1080PsF

– Sin salida

1920 × 1080PsF – Sin salida

– 1920 × 1080P 1920×1080 23.98P (Puro)

Ajustes de formato de grabación
(Rec Format >Video Format en el 
menú System)

Ajustes de salida SDI/HDMI
(Output Format >SDI y 
HDMI en el menú Video)

Señal de salida de HDMI

SDI HDMI
1920 × 1080 59.94i 1920 × 1080i 1920 × 1080i 1920 × 1080 59.94i

1920 × 1080 29.97P 1920 × 
1080PsF

1920 × 1080i 1920 × 1080 29.97PsF

1920 × 1080 23.98P 1920 × 1080P 1920 × 1080P 1920×1080 23.98P (Puro)

Ajustes de formato de grabación
(Rec Format >Video Format en el 
menú System)

Ajustes de salida SDI/HDMI
(Output Format >SDI y 
HDMI en el menú Video)

Señal de salida de HDMI

SDI HDMI
4096 × 2160 50P – 4096 × 2160P 4096 × 2160 50P

– 3840 × 2160P 3840 × 2160 50P

1920 × 1080P 
(Level A)

1920 × 1080P 1920 × 1080 50P

1920 × 1080P 
(Level B)

– Sin salida

1920 × 1080i 1920 × 1080i 1920 × 1080 50i

4096 × 2160 25P – 4096 × 2160P 4096 × 2160 25P

– 3840 × 2160P 3840 × 2160 25P

1920 × 
1080PsF

1920 × 1080i 1920 × 1080 25PsF

3840 × 2160 50P – 4096 × 2160P 4096 × 2160 50P

– 3840 × 2160P 3840 × 2160 50P

1920 × 1080P 
(Level A)

1920 × 1080P 1920 × 1080 50P

1920 × 1080P 
(Level B)

– Sin salida

1920 × 1080i 1920 × 1080i 1920 × 1080 50i

Ajustes de formato de grabación
(Rec Format >RAW Output Format y 
Video Format en el menú System)

Ajustes de salida SDI/HDMI
(Output Format >SDI y 
HDMI en el menú Video)

Señal de salida de HDMI

SDI HDMI
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Cuando se utiliza una unidad de extensión (RAW)

3840 × 2160 25P – 4096 × 2160P 4096 × 2160 25P

– 3840 × 2160P 3840 × 2160 25P

1920 × 
1080PsF

1920 × 1080i 1920 × 1080 25PsF

1920 × 1080 50P 2048 × 1080P 
(Level A)

– Sin salida

2048 × 1080P 
(Level B)

– Sin salida

1920 × 1080P 
(Level A)

1920 × 1080P 1920 × 1080 50P

1920 × 1080P 
(Level B)

– Sin salida

1920 × 1080i 1920 × 1080i 1920 × 1080 50i

– 720 × 576i 720 × 576 50i

– 720 × 576P 720 × 576 50P

1920 × 1080 50i 1920 × 1080i 1920 × 1080i 1920 × 1080 50i

– 720 × 576i 720 × 576 50i

– 720 × 576P 720 × 576 50P

1920 × 1080 25P 2048 × 1080PsF – Sin salida

1920 × 
1080PsF

1920 × 1080i 1920 × 1080 50i (PsF)

– 720 × 576i 720 × 576 50i (PsF)

1280 × 720 50P 1280 × 720P 1280 × 720P 1280 × 720 50P

– 720 × 576i 720 × 576 50i

– 720 × 576P 720 × 576 50P

1280 × 720 25P 1280 × 720P 1280 × 720P 1280 × 720 50P (2-2RP)

– 720 × 576i 720 × 576 50i (PsF)

Ajustes de formato de grabación
(Rec Format >RAW Output Format y 
Video Format en el menú System)

Ajustes de salida SDI/HDMI
(Output Format >SDI y 
HDMI en el menú Video)

Señal de salida de HDMI

SDI HDMI

RAW Output Format
4096 × 2160 50P

Video Format (valor fijo)
1920 × 1080 50P

2048 × 1080P 
(Level A)

– Sin salida

2048 × 1080P 
(Level B)

– Sin salida

1920 × 1080P 
(Level A)

1920 × 1080P 1920 × 1080 50P

1920 × 1080P 
(Level B)

– Sin salida

1920 × 1080i 1920 × 1080i 1920 × 1080 50i

Ajustes de formato de grabación
(Rec Format >Video Format en el 
menú System)

Ajustes de salida SDI/HDMI
(Output Format >SDI y 
HDMI en el menú Video)

Señal de salida de HDMI

SDI HDMI
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Cuando se utiliza una unidad de extensión (ProRes 422)

RAW Output Format
4096 × 2160 50P

Video Format (valor fijo)
1280 × 720 50P 

2048 × 1080P 
(Level A)

– Sin salida

2048 × 1080P 
(Level B)

– Sin salida

1920 × 1080P 
(Level A)

1920 × 1080P 1920 × 1080 50P

1920 × 1080P 
(Level B)

– Sin salida

1280 × 720P 1280 × 720P 1280 × 720 50P

RAW Output Format
2048 × 1080 50P

Video Format (valor fijo)
1920 × 1080 50P

2048 × 1080P 
(Level A)

– Sin salida

2048 × 1080P 
(Level B)

– Sin salida

1920 × 1080P 
(Level A)

1920 × 1080P 1920 × 1080 50P

1920 × 1080P 
(Level B)

– Sin salida

1920 × 1080i 1920 × 1080i 1920 × 1080 50i

RAW Output Format
2048 × 1080 50P

Video Format (valor fijo)
1280 × 720 50P 

2048 × 1080P 
(Level A)

– Sin salida

2048 × 1080P 
(Level B)

– Sin salida

1920 × 1080P 
(Level A)

1920 × 1080P 1920 × 1080 50P

1920 × 1080P 
(Level B)

– Sin salida

1280 × 720P 1280 × 720P 1280 × 720 50P

RAW Output Format
4096 × 2160 25P

Video Format (valor fijo)
1920 × 1080 25P 

2048 × 
1080PsF

– Sin salida

1920 × 1080PsF 1920 × 1080i 1920 × 1080 25PsF

RAW Output Format
2048 × 1080 25P

Video Format (valor fijo)
1920 × 1080 25P 

2048 × 
1080PsF

– Sin salida

1920 × 1080PsF 1920 × 1080i 1920 × 1080 25PsF

Ajustes de formato de grabación
(Rec Format >Video Format en el 
menú System)

Ajustes de salida SDI/HDMI
(Output Format >SDI y 
HDMI en el menú Video)

Señal de salida de HDMI

SDI HDMI
1920 × 1080 50i 1920 × 1080i 1920 × 1080i 1920 × 1080 50i

1920 × 1080 25P 1920 × 
1080PsF

1920 × 1080i 1920 × 1080 50i (PsF)

Ajustes de formato de grabación
(Rec Format >RAW Output Format y 
Video Format en el menú System)

Ajustes de salida SDI/HDMI
(Output Format >SDI y 
HDMI en el menú Video)

Señal de salida de HDMI

SDI HDMI
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Ajustes de salida HDMI para dispositivos HDMI

Notas

• Si el ajuste Output Display no se puede seleccionar después de cambiar HDMI Target Device, dicho ajuste cambiará 
de la siguiente forma.
- Cambiará de manera forzosa al valor predeterminado.
- Si la selección del valor predeterminado no está disponible, cambiará de manera forzosa a “SDI=On, HDMI=On”.

• HDMI Target Device no se puede establecer en Recorder si Codec está establecido en ProRes.

Define cuándo no se puede configurar Monitor LUT de manera independiente
En los siguientes casos, Monitor LUT >SDI2, HDMI y Viewfinder en el menú Video no se pueden ajustar 
de forma individual. Están sincronizados con el ajuste SDI1 & Internal Rec.

- Cuando Output Format >HDMI en el menú Video está ajustado en 4096×2160 o 3840×2160
- Cuando S&Q Motion >Setting en el menú Recording está On
- Si Lens >Distortion Comp. en el menú System está ajustado en Auto

Indica cuando Video Signal Monitor no se puede mostrar
• Para utilizar el Video Signal Monitor, debe activar la salida SDI. Además, la resolución de salida debe 

ser de 2K o inferior. Compruebe los siguientes ajustes.
- Output On/Off >SDI en el menú Video
- Output Format >SDI en el menú Video

• En los siguientes casos, el Video Signal Monitor no se puede visualizar en el visor.
- Si la salida SDI aparece con los bordes recortados cuando utiliza Output Setting >4K/2K to HD 

Conv. en el menú Video
- Si existe una mezcla de funciones MLUT On y MLUT Off para Monitor LUT >SDI1 & Internal Rec, 

SDI2, HDMI y Viewfinder en el menú Video

Output Setting >HDMI Target 
Device en el menú Video

Output Display >SDI/HDMI en 
el menú Video

Salida de HDMI

OSD On/Off MLUT On/Off

Recorder (predeterminado) SDI=On, HDMI=On (predeterminado)
* En gris, no se puede seleccionar.

– Sigue SDI1

SDI=On, HDMI=Off Off

SDI=Off, HDMI=Off Off

Monitor SDI=On, HDMI=On (predeterminado) On Sigue SDI2

SDI=On, HDMI=Off
* En gris, no se puede seleccionar.

–

SDI=Off, HDMI=Off Off
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Si en el camcorder se produce una condición de funcionamiento, precaución o advertencia que requiera 
confirmación, en el visor aparecerá un mensaje, los indicadores de grabación comenzarán a parpadear y 
sonará un pitido de advertencia.
El pitido de advertencia se emite desde el altavoz incorporado y los auriculares conectados a la toma de 
auriculares.

El camcorder dejará de funcionar cuando se visualicen los siguientes mensajes.

Siga las instrucciones proporcionadas si se muestran los siguientes mensajes.

Advertencias de funcionamiento

Mensajes de error

Mensaje del visor Sonido de 
advertencia

Indicador de 
grabación 

Causa y solución

E + error code Continuo Parpadeo 
rápido

Indica una anomalía en el camcorder. La grabación se detiene, 
incluso si zREC se muestra en el visor.
Apague el camcorder y compruebe si existe algún problema 
con los dispositivos, cables o soportes conectados. Si el error 
continúa cuando el camcorder se vuelve a encender, póngase 
en contacto con el servicio de asistencia técnica de Sony.
(Si el camcorder no se apaga cuando el interruptor POWER se 
ajusta en OFF, extraiga la batería o desconecte la alimentación 
DC IN).

Mensajes de advertencia

Mensaje del visor Sonido de 
advertencia

Indicador de 
grabación 

Causa y solución

Media Near Full Intermitente Parpadeo La capacidad restante de la tarjeta de memoria XQD se está 
agotando.
Sustitúyala en cuanto pueda.

Media Full Continuo Parpadeo 
rápido

Los clips no se pueden grabar, copiar ni dividir porque no 
queda capacidad en la tarjeta de memoria XQD.
Sustitúyala inmediatamente.

Battery Near End Intermitente Parpadeo La capacidad restante de la batería se está agotando.
Recárguela en cuanto pueda.

Battery End Continuo Parpadeo 
rápido

La batería está agotada. La grabación se detiene.
Detenga el funcionamiento y sustituya la batería.

Temperature High Intermitente Parpadeo La temperatura interna es elevada.
Apague el camcorder y deje que se enfríe antes de volverlo a 
utilizar.

Voltage Low Intermitente Parpadeo La tensión de DC IN es baja (nivel 1). Compruebe la fuente de 
alimentación.

Insufficient Voltage Continuo Parpadeo 
rápido

La tensión de DC IN es demasiado baja (nivel 2). La 
grabación se detiene.
Conecte a una fuente de alimentación distinta.
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Es posible que los siguientes mensajes de precaución y funcionamiento aparezcan en el centro de la 
pantalla. Siga las instrucciones proporcionadas para resolver el problema.

1) Se muestra “Media (B)” para la tarjeta de la ranura B.

Mensajes de precaución y de funcionamiento

Mensaje del visor Causa y solución
Battery Error
Please Change Battery.

Se ha detectado un error en la batería.
Sustitúyala por una batería normal.

Backup Battery End
Please Change.

La capacidad restante de la batería de reserva es insuficiente.
Cargue la batería de reserva.

Unknown Media(A)1)

Please Change.

Se ha introducido una tarjeta de memoria particionada o una tarjeta de 
memoria que contiene más clips de los que puede manipular el 
camcorder.
La tarjeta no se puede utilizar en el camcorder y se debe sustituir.

Cannot Use Media(A)1)

Unsupported File System

Se ha introducido una tarjeta que utiliza un sistema de archivos diferente 
o que no se ha formateado.
La tarjeta no se puede utilizar en el camcorder y se debe sustituir o 
formatear con el camcorder.

Media Error

Media(A)1) Needs to be Restored

Se ha producido un error en la tarjeta de memoria y se debe restaurar.
Restaure la tarjeta de memoria.

Media Error

Cannot Record to Media(A)1)

Es posible que la tarjeta de memoria esté dañada y ya no se puede 
utilizar para la grabación.
La reproducción es posible, por tanto, se recomienda copiar y sustituir la 
tarjeta de memoria.

Media Error

Cannot Use Media(A)1)

Es posible que la tarjeta de memoria esté dañada y ya no se puede 
utilizar para la grabación ni la reproducción.
La tarjeta no se puede utilizar en el camcorder y se debe sustituir.

Media(A)1) Error
Recording Halted
Playback Halted

La grabación y la reproducción se han detenido a causa de un error que 
se ha producido mientras se utilizaba la tarjeta de memoria.
Si el problema continúa, sustituya la tarjeta de memoria.

Media Reached Rewriting Limit

Change Media(A)1) 

La tarjeta de memoria ha llegado al final de su vida útil.
Realice una copia de seguridad y sustituya la tarjeta inmediatamente Si 
continúa utilizando la tarjeta, es posible que no pueda grabar o 
reproducir.

Para obtener más información, consulte las instrucciones de 
funcionamiento de la tarjeta de memoria.

Fan Stopped El ventilador incorporado se ha detenido.
Evite utilizar el camcorder con temperaturas elevadas, desconecte la 
alimentación y póngase en contacto con el servicio de asistencia técnica 
de Sony.

Invalid setting value was reset:
Media/Clip Naming/Camera Position
Please save All File again

El ajuste de formato para darle nombre al clip se ha restablecido porque 
se ha cargado un archivo ALL no válido.
Configure los ajustes de formato deseados e intente guardar el archivo 
ALL de nuevo.
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LOS CONSUMIDORES PUEDEN UTILIZAR 
ESTE PRODUCTO BAJO LA 
AUTORIZACIÓN DE LA LICENCIA DE LA 
CARTERA DE PATENTES DE AVC PARA SU 
USO PERSONAL O PARA OTROS USOS, 
POR LOS CUALES NO SE RECIBE 
REMUNERACIÓN ALGUNA EN CASO DE
 
(i) CODIFICAR VÍDEO DE CONFORMIDAD 

CON EL ESTÁNDAR DE AVC (“VÍDEO 
AVC”) Y/O

(ii) DESCODIFICAR VÍDEO AVC 
CODIFICADO POR UN CONSUMIDOR 
COMO PARTE DE UNA ACTIVIDAD 
PERSONAL Y/U OBTENIDO DE UN 
PROVEEDOR DE VÍDEO CON LICENCIA 
PARA PROPORCIONAR VÍDEO AVC.

 
NO SE OTORGA NINGÚN TIPO DE 
LICENCIA O NO EXISTE NINGUNA 
LICENCIA IMPLÍCITA PARA NINGÚN 
OTRO USO.PUEDE OBTENER 
INFORMACIÓN ADICIONAL EN MPEG LA, 
L.L.C. CONSULTE 
HTTP://WWW.MPEGLA.COM

CUALQUIER OTRO USO DE ESTE 
PRODUCTO QUE DIFIERA DEL USO 
PERSONAL DEL CONSUMIDOR QUE 
CUMPLA CON EL ESTÁNDAR MPEG-2 
PARA LA CODIFICACIÓN DE 
INFORMACIÓN DE VÍDEO PARA 
PAQUETES AUDIOVISUALES ESTÁ 
EXPRESAMENTE PROHIBIDO SIN UNA 
LICENCIA DE PATENTES APLICABLES EN 
LA CARTERA DE PATENTES DE MPEG-2, 
CUYA LICENCIA SE PUEDE CONSEGUIR 
EN MPEG LA, L.L.C., 250 STEELE STREET, 
SUITE 300, DENVER, COLORADO 80206.
“PAQUETE AUDIOVISUAL” hace referencia a 
cualquier producto audiovisual que contenga 

información de vídeo MPEG-2, como las 
películas en DVD que se venden/distribuyen a los 
consumidores generales. Las personas que 
dupliquen o vendan PAQUETES 
AUDIOVISUALES necesitan obtener licencias 
de MPEG LA para realizar dicha actividad 
laboral. Para más información, no dude en 
ponerse en contacto con MPEG LA.
MPEG LA. L.L.C., 250 STEELE STREET, 
SUITE 300, DENVER, COLORADO 80206
http://www.mpegla.com

Este producto utiliza un software al que se aplica 
la licencia GPL/LGPL. Esto le informa de que 
tiene derecho a acceder, modificar y redistribuir 
el código fuente de estos programas de software 
de acuerdo con las condiciones de la GPL/LGPL.
El código fuente se proporciona en Internet. 
Utilice la siguiente URL y siga las instrucciones 
de descarga.
http://www.sony.net/Products/Linux/common/
search.html

Le rogamos que no se ponga en contacto con 
nosotros acerca de los contenidos del código 
fuente.

Para consultar el contenido de estas licencias, 
consulte “License1.pdf” en la carpeta “License” 
del CD-ROM suministrado.

Para visualizar archivos PDF es necesario tener 
Adobe Reader instalado en el ordenador.
Si Adobe Reader no está instalado en su 
ordenador, podrá descargarlo a través de la 
siguiente URL.
http://get.adobe.com/reader/

Licencias

Licencia de la cartera de patentes 
de MPEG-4 AVC

Licencia MPEG-2 Video Patent 
Portfolio

Obtención del software con la 
licencia GPL/LGPL
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IMPORTANT: 
BEFORE USING THE SOFTWARE 
CONTAINED IN THE SOLID STATE 
MEMORY CAMCORDER, PLEASE READ 
THIS END USER LICENSE AGREEMENT 
(“EULA”) CAREFULLY. BY USING THE 
SOFTWARE YOU ARE ACCEPTING THE 
TERMS OF THIS EULA. IF YOU DO NOT 
ACCEPT THE TERMS OF THIS EULA, YOU 
MAY NOT USE THE SOFTWARE.

This EULA is a legal agreement between you and 
Sony Corporation (“SONY”). This EULA 
governs your rights and obligations regarding the 
software of SONY and/or its third party licensors 
(including SONY’s affiliates) and their respective 
affiliates (collectively, the “THIRD-PARTY 
SUPPLIERS”) contained in the wireless adapter, 
together with any updates/ upgrades provided by 
SONY, any printed, on-line or other
electronic documentation for such software, and 
any data files created by operation of such 
software (collectively, the “SOFTWARE”).

Notwithstanding the foregoing, any software in 
the SOFTWARE having a separate end user 
license agreement (including, but not limited to, 
GNU General Public license and Lesser/Library 
General Public License) shall be covered by such 
applicable separate end user license agreement in 
lieu of the terms of this EULA to the extent 
required by such separate end user license 
agreement (“EXCLUDED SOFTWARE”).

SOFTWARE LICENSE
The SOFTWARE is licensed, not sold. The 
SOFTWARE is protected by copyright and other 
intellectual property laws and international 
treaties.

COPYRIGHT
All right and title in and to the SOFTWARE 
(including, but not limited to, any images, 
photographs, animation, video, audio, music, text 
and “applets” incorporated into the SOFTWARE) 
is owned by SONY or one or more of the THIRD-
PARTY SUPPLIERS.

GRANT OF LICENSE
SONY grants you a limited license to use the 
SOFTWARE solely in connection with the 
wireless adapter and only for your individual use. 
SONY and the THIRD-PARTY SUPPLIERS 
expressly reserve all rights, title and interest 
(including, but not limited to, all intellectual 
property rights) in and to the SOFTWARE that 
this EULA does not specifically grant to you.

REQUIREMENTS AND LIMITATIONS
You may not copy, publish, adapt, redistribute, 
attempt to derive source code, modify, reverse 
engineer, decompile, or disassemble any of the 
SOFTWARE, whether in whole or in part, or 
create any derivative works from or of the 
SOFTWARE unless such derivative works are 
intentionally facilitated by the SOFTWARE. You 
may not modify or tamper with any digital rights 
management functionality of the SOFTWARE. 
You may not bypass, modify, defeat or 
circumvent any of the functions or protections of 
the SOFTWARE or any mechanisms operatively 
linked to the SOFTWARE. You may not separate 
any individual component of the SOFTWARE 
for use on more than one wireless adapter unless 
expressly authorized to do so by SONY. You may 
not remove, alter, cover or deface any trademarks 
or notices on the SOFTWARE. You may not 
share, distribute, rent, lease, sublicense, assign, 
transfer or sell the SOFTWARE. The software, 
network services or other products other than 
SOFTWARE upon which the SOFTWARE’S 
performance depends might be interrupted or 
discontinued at the discretion of the suppliers 
(software suppliers, service suppliers, or SONY). 
SONY and such suppliers do not warrant that the 
SOFTWARE, network services, contents or other 
products will continue to be available, or will 
operate without interruption or modification. 

EXCLUDED SOFTWARE AND OPEN 
SOURCE COMPONENTS
Notwithstanding the foregoing limited license 
grant, you acknowledge that the SOFTWARE 
may include EXCLUDED SOFTWARE. Certain 
EXCLUDED SOFTWARE may be covered by 
open source software licenses (“Open Source 
Components”), which means any software 
licenses approved as open source licenses by the 
Open Source Initiative or any substantially 
similar licenses, including but not limited to any 
license that, as a condition of distribution of the 

CONTRATO DE LICENCIA DE 
USUARIO FINAL
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software licensed under such license, requires 
that the distributor make the software available in 
source code format. If and to the extent disclosure 
is required, please visit www.sony.com/linux or 
other SONY-designated web site for a list of 
applicable OPEN SOURCE COMPONENTS 
included in the SOFTWARE from time to time, 
and the applicable terms and conditions 
governing its use. Such terms and conditions may 
be changed by the applicable third party at any 
time without liability to you. To the extent 
required by the licenses covering EXCLUDED 
SOFTWARE, the terms of such licenses will 
apply in lieu of the terms of this EULA. To the 
extent the terms of the licenses applicable to 
EXCLUDED SOFTWARE prohibit any of the 
restrictions in this EULA with respect to such 
EXCLUDED SOFTWARE, such restrictions will 
not apply to such EXCLUDED SOFTWARE. To 
the extent the terms of the licenses applicable to 
Open Source Components require SONY to make 
an offer to provide source code in connection with 
the SOFTWARE, such offer is hereby made. 

USE OF SOFTWARE WITH 
COPYRIGHTED MATERIALS
The SOFTWARE may be capable of being used 
by you to view, store, process and/or use content 
created by you and/or third parties. Such content 
may be protected by copyright, other intellectual 
property laws, and/or agreements. You agree to 
use the SOFTWARE only in compliance with all 
such laws and agreements that apply to such 
content. You acknowledge and agree that SONY 
may take appropriate measures to protect the 
copyright of content stored, processed or used by 
the SOFTWARE. Such measures include, but are 
not limited to, counting the frequency of your 
backup and restoration through certain 
SOFTWARE features, refusal to accept your 
request to enable restoration of data, and 
termination of this EULA in the event of your 
illegitimate use of the SOFTWARE. 

CONTENT SERVICE 
PLEASE ALSO NOTE THAT THE 
SOFTWARE MAY BE DESIGNED TO BE 
USED WITH CONTENT AVAILABLE 
THROUGH ONE OR MORE CONTENT 
SERVICES (“CONTENT SERVICE”). USE OF 
THE SERVICE AND THAT CONTENT IS 
SUBJECT TO THE TERMS OF SERVICE OF 
THAT CONTENT SERVICE. IF YOU 

DECLINE TO ACCEPT THOSE TERMS, 
YOUR USE OF THE SOFTWARE WILL BE 
LIMITED. You acknowledge and agree that 
certain content and services available through the 
SOFTWARE may be provided by third parties 
over which SONY has no control. USE OF THE 
CONTENT SERVICE REQUIRES AN 
INTERNET CONNECTION. THE CONTENT 
SERVICE MAY BE DISCONTINUED AT ANY 
TIME.

INTERNET CONNECTIVITY AND THIRD 
PARTY SERVICES
You acknowledge and agree that access to certain 
SOFTWARE features may require an Internet 
connection for which you are solely responsible. 
Further, you are solely responsible for payment of 
any third party fees associated with your Internet 
connection, including but not limited to Internet 
service provider or airtime charges. Operation of 
the SOFTWARE may be limited or restricted 
depending on the capabilities, bandwidth or 
technical limitations of your Internet connection 
and service. The provision, quality and security of 
such Internet connectivity are the sole 
responsibility of the third party providing such 
service. 

EXPORT AND OTHER REGULATIONS
You agree to comply with all applicable export 
and re-export restrictions and regulations of the 
area or country in which you reside, and not to 
transfer, or authorize the transfer, of the 
SOFTWARE to a prohibited country or otherwise 
in violation of any such restrictions or 
regulations.

HIGH RISK ACTIVITIES
The SOFTWARE is not fault-tolerant and is not 
designed, manufactured or intended for use or 
resale as on-line control equipment in hazardous 
environments requiring fail-safe performance, 
such as in the operation of nuclear facilities, 
aircraft navigation or communication systems, air 
traffic control, direct life support machines, or 
weapons systems, in which the failure of the 
SOFTWARE could lead to death, personal injury, 
or severe physical or environmental damage 
(“HIGH RISK ACTIVITIES”). SONY, each of 
the THIRD-PARTY SUPPLIERS, and each of 
their respective affiliates specifically disclaim 
any express or implied warranty, duty or 
condition of fitness for HIGH RISK 
ACTIVITIES.
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EXCLUSION OF WARRANTY ON 
SOFTWARE
You acknowledge and agree that use of the 
SOFTWARE is at your sole risk and that you are 
responsible for use of the SOFTWARE. The 
SOFTWARE is provided “AS IS,” without 
warranty, duty or condition of any kind.

SONY AND EACH OF THE THIRD-PARTY 
SUPPLIERS (for purposes of this Section, SONY 
and each of the THIRD-PARTY SUPPLIERS 
shall be collectively referred to as “SONY”) 
EXPRESSLY DISCLAIM ALL 
WARRANTIES, DUTIES OR CONDITIONS, 
EXPRESS OR IMPLIED, INCLUDING, BUT 
NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY, 
NONINFRINGEMENT AND FITNESS FOR A 
PARTICULAR PURPOSE. SONY DOES NOT 
WARRANT OR MAKE ANY CONDITIONS 
OR REPRESENTATIONS (A) THAT THE 
FUNCTIONS CONTAINED IN ANY OF THE 
SOFTWARE WILL MEET YOUR 
REQUIREMENTS OR THAT THEY WILL BE 
UPDATED, (B) THAT THE OPERATION OF 
ANY OF THE SOFTWARE WILL BE 
CORRECT OR ERROR-FREE OR THAT ANY 
DEFECTS WILL BE CORRECTED, (C) THAT 
THE SOFTWARE WILL NOT DAMAGE ANY 
OTHER SOFTWARE, HARDWARE OR 
DATA, (D) THAT ANY SOFTWARE, 
NETWORK SERVICES (INCLUDING THE 
INTERNET) OR PRODUCTS (OTHER THAN 
THE SOFTWARE) UPON WHICH THE 
SOFTWARE’S PERFORMANCE DEPENDS 
WILL CONTINUE TO BE AVAILABLE, 
UNINTERRUPTED OR UNMODIFIED, AND 
(E) REGARDING THE USE OR THE 
RESULTS OF THE USE OF THE SOFTWARE 
IN TERMS OF ITS CORRECTNESS, 
ACCURACY, RELIABILITY, OR 
OTHERWISE. 

NO ORAL OR WRITTEN INFORMATION OR 
ADVICE GIVEN BY SONY OR AN 
AUTHORIZED REPRESENTATIVE OF SONY 
SHALL CREATE A WARRANTY, DUTY OR 
CONDITION OR IN ANY WAY INCREASE 
THE SCOPE OF THIS WARRANTY. SHOULD 
THE SOFTWARE PROVE DEFECTIVE YOU 
ASSUME THE ENTIRE COST OF ALL 
NECESSARY SERVICING, REPAIR OR 

CORRECTION. SOME JURISDICTIONS DO 
NOT ALLOW THE EXCLUSION OF IMPLIED 
WARRANTIES, SO THESE EXCLUSIONS 
MAY NOT APPLY TO YOU.

LIMITATION OF LIABILITY
SONY AND EACH OF THE THIRD-PARTY 
SUPPLIERS (for purposes of this Section, SONY 
and each of the THIRD-PARTY SUPPLIERS 
shall be collectively referred to as “SONY”) 
SHALL NOT BE LIABLE FOR ANY 
INCIDENTAL OR CONSEQUENTIAL 
DAMAGES FOR BREACH OF ANY EXPRESS 
OR IMPLIED WARRANTY, BREACH OF 
CONTRACT, NEGLIGENCE, STRICT 
LIABILITY OR UNDER ANY OTHER LEGAL 
THEORY RELATED TO THE
SOFTWARE, INCLUDING, BUT NOT 
LIMITED TO, ANY DAMAGES ARISING 
OUT OF LOSS OF PROFITS, LOSS OF 
REVENUE, LOSS OF DATA, LOSS OF USE 
OF THE SOFTWARE OR ANY ASSOCIATED 
HARDWARE, DOWN TIME AND USER’ S 
TIME, EVEN IF ANY OF THEM HAVE BEEN 
ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES. IN ANY CASE, EACH AND ALL 
OF THEIR AGGREGATE LIABILITY UNDER 
ANY PROVISION OF THIS EULA SHALL BE 
LIMITED TO THE AMOUNT ACTUALLY 
PAID FOR THE PRODUCT. SOME 
JURISDICTIONS DO NOT ALLOW THE 
EXCLUSION OR LIMITATION OF 
INCIDENTAL OR CONSEQUENTIAL 
DAMAGES, SO THE ABOVE EXCLUSION 
OR LIMITATION MAY NOT APPLY TO 
YOU.

CONSENT TO USE OF NON-PERSONAL 
INFORMATION, LOCATION DATA, DATA 
SECURITY
You acknowledge and agree that SONY and its 
affiliates, partners and agents may read, collect, 
transfer, process and store certain information 
collected from the SOFTWARE, including but 
not limited to information about (i) the 
SOFTWARE and (ii) the software applications, 
contents and peripheral devices that interact with 
your wireless adapter and the SOFTWARE 
(“Information”). Information includes, but is not 
limited to: (1) unique identifiers relating to your 
wireless adapter and its components; (2) 
performance of the wireless adapter, the 
SOFTWARE and their components; (3) 
123



configurations of your wireless adapter, the 
SOFTWARE and the software applications, 
contents and peripheral devices that interact with 
the wireless adapter and the SOFTWARE; (4) use 
and frequency of use of the functions of (x) the 
SOFTWARE, and (y) the software applications, 
contents and peripheral devices that interact with 
the SOFTWARE; and (5) location data, as 
indicated below. SONY and its affiliates, partners 
and agents may use and disclose Information 
subject to applicable laws in order to improve its 
products and services or to provide products or 
services to you. Such uses include, but are not 
limited to: (a) administering the functionalities of 
the SOFTWARE; (b) to improve, service, update 
or upgrade the SOFTWARE; (c) improving, 
developing and enhancing the current and future 
products and services of SONY and other parties; 
(d) to provide you with information about the 
products and services offered by SONY and other 
parties; (e) complying with applicable laws or 
regulations; and (f) to the extent offered, 
providing you with location-based services of 
SONY and other parties, as indicated below. In 
addition, SONY retains the right to use 
Information to protect itself and third parties from 
illegal, criminal or harmful conduct.

Certain services available through the 
SOFTWARE may rely upon location 
information, including, but not limited to, the 
geographic location of the wireless adapter. You 
acknowledge that for the purpose of providing 
such services, SONY, the THIRDPARTY 
SUPPLIERS or their partners may collect, 
archive, process and use such location data, and 
that such services are governed by the privacy 
policies of SONY or such third party. By 
reviewed the privacy policies applicable to such 
services and consent to such activities. 

SONY, its affiliates, partners and agents will not 
intentionally use Information to personally 
identify the owner or user of the SOFTWARE 
without your knowledge or consent. Any use of 
Information will be in accordance with the 
privacy policies of SONY or such third party. 

Please contact applicable contact address of each 
area or country for SONY’ s current privacy 
policy. Please contact applicable third parties for 
privacy policies relating to personally identifiable 

and other information you provide when you use 
or access third party software or services. 

Information may be processed, stored or 
transferred to SONY, its affiliates or agents which 
are located in countries outside of your country of 
residence. Data protection and information 
privacy laws in certain countries may not offer the 
same level of protection as your country of 
residence and you may have fewer legal rights in 
relation to Information processed and stored in, or 
transferred to, such countries. SONY will use 
reasonable efforts to take appropriate technical 
and organizational steps to prevent unauthorized 
access to or disclosure of Information, but does 
not warrant it will eliminate all risk of misuse of 
such Information.

AUTOMATIC UPDATE FEATURE
From time to time, SONY or the THIRD-PARTY 
SUPPLIERS may automatically update or 
otherwise modify the SOFTWARE, including, 
but not limited to, for purposes of enhancement of 
security functions, error correction and 
improvement of functions, at such time as you 
interact with SONY’ s or third parties' servers, or 
otherwise. Such updates or modifications may 
delete or change the nature of features or other 
aspects of the SOFTWARE, including, but not 
limited to, functions you may rely upon. You 
acknowledge and agree that such activities may 
occur at SONY’ s sole discretion and that SONY 
may condition continued use of the SOFTWARE 
upon your complete installation or acceptance of 
such update or modifications. Any updates/
modifications shall be deemed to be, and shall 
constitute part of, the SOFTWARE for purposes 
of this EULA. By acceptance of this EULA, you 
consent to such update/modification.

ENTIRE AGREEMENT, WAIVER, 
SEVERABILITY
This EULA and SONY’ s privacy policy, each as 
amended and modified from time to time, 
together constitute the entire agreement between 
you and SONY with respect to the SOFTWARE. 
The failure of SONY to exercise or enforce any 
right or provision of this EULA shall not 
constitute a waiver of such right or provision. If 
any part of this EULA is held invalid, illegal, or 
unenforceable, that provision shall be enforced to 
the maximum extent permissible so as to maintain 
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the intent of this EULA, and the other parts will 
remain in full force and effect.

GOVERNING LAW AND JURISDICTION
The United Nations Convention on Contracts for 
the International Sale of Goods shall not apply to 
this EULA. This EULA shall be governed by the 
laws of Japan, without regards to conflict of laws
provisions. Any dispute arising out of this EULA 
shall be subject to the exclusive venue of the 
Tokyo District Court in Japan, and the parties 
hereby consent to the venue and jurisdiction of 
such courts.

EQUITABLE REMEDIES
Notwithstanding anything contained in this 
EULA to the contrary, you acknowledge and 
agree that any violation of or noncompliance with 
this EULA by you will cause irreparable harm to 
SONY, for which monetary damages would be 
inadequate, and you consent to SONY obtaining 
any injunctive or equitable relief that SONY 
deems necessary or appropriate in such 
circumstances. SONY may also take any legal 
and technical remedies to prevent violation of 
and/or to enforce this EULA, including, but not 
limited to, immediate termination of your use of 
the SOFTWARE, if SONY believes in its sole 
discretion that you are violating or intend to 
violate this EULA. These remedies are in addition 
to any other remedies SONY may have at law, in 
equity or under contract.

TERMINATION
Without prejudice to any of its other rights, 
SONY may terminate this EULA if you fail to 
comply with any of its terms. In case of such 
termination, you must: (i) cease all use, and 
destroy any copies, of the SOFTWARE; (ii) 
comply with the requirements in the section 
below entitled “Your Account Responsibilities”.

AMENDMENT
SONY RESERVES THE RIGHT TO AMEND 
ANY OF THE TERMS OF THIS EULA AT ITS 
SOLE DISCRETION BY POSTING NOTICE 
ON A SONY DESIGNATED WEB SITE, BY 
EMAIL NOTIFICATION TO AN EMAIL 
ADDRESS PROVIDED BY YOU, BY 
PROVIDING NOTICE AS PART OF THE 
PROCESS IN WHICH YOU OBTAIN 
UPGRADES/ UPDATES OR BY ANY OTHER 
LEGALLY RECOGNIZABLE FORM OF 
NOTICE. If you do not agree to the amendment, 

you should promptly contact SONY for 
instructions. Your continued use of the 
SOFTWARE after the effective date of any such 
notice shall be deemed your agreement to be 
bound by such amendment.

THIRD-PARTY BENEFICIARIES
Each THIRD-PARTY SUPPLIER is an express 
intended thirdparty beneficiary of, and shall have 
the right to enforce, each provision of this EULA 
with respect to the SOFTWARE of such party. 

Should you have any questions concerning this 
EULA, you may contact SONY by writing to 
SONY at applicable contact address of each area 
or country.

Copyright © 2012 Sony Corporation.

En base a los contratos de licencia entre Sony y 
los propietarios del copyright del software, este 
producto utiliza software libre.
Para cumplir los requisitos de los propietarios del 
copyright del software, Sony se ve obligado a 
informarle acerca del contenido de estas 
licencias.
Para consultar el contenido de estas licencias, 
consulte “License1.pdf” en la carpeta “License” 
del CD-ROM suministrado.

Licencias de software libre
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Masa Aprox. 2,0 kg (solo el cuerpo)
Dimensiones

(Unidad: mm, solo el cuerpo)1) 

1) Los valores de las dimensiones son aproximados.

Requisito de alimentación
12 V de CC (de 11 V a 17,0 V)

Consumo de energía
Aprox. 19 W (cuerpo, objetivo 
SELP28135G, grabación XAVC-I 
QFHD a 59.94P, visor activado)

Temperatura de funcionamiento
De 0 °C a 40 °C

Temperatura de almacenamiento
De −20 °C a +60 °C

Tiempo de funcionamiento continuo
Aprox. 60 minutos (con BP-U30)

Formato de grabación (vídeo)
XAVC Intra 
AVC/H.264 High 4:2:2 Intra Profile
QFHD: VBR, 600 Mbps máx.
4K: VBR, 600 Mbps máx.
HD: CBG, 222 Mbps

XAVC Long 
AVC/H.264 High Profile
QFHD: VBR, 150 Mbps máx., 4:2:0, 
Long
HD: VBR, 50 Mbps máx., 4:2:2, Long
MPEG HD422 
MPEG-2 Long GOP
Modo HD422: CBR, 50 Mbps, MPEG-2 
422P@HL
ProRes 422 HQ 1)

Apple ProRes 422 HQ
4:2:2, 10 bits, VBR, 220 Mbps máx.
ProRes 422 1)

Apple ProRes 422
4:2:2, 10 bits, VBR, 147 Mbps máx.

Formato de grabación (audio)
LPCM de 24 bits, 48 kHz, 4-canales

Velocidad de fotogramas de grabación
XAVC Intra 
4096 × 2160/59.94P, 50P, 29.97P, 
23.98P, 25P
3840 × 2160/59.94P, 50P, 29.97P, 
23.98P, 25P
1920 × 1080/59.94P, 50P, 59.94i, 50i, 
29.97P, 23.98P, 25P
XAVC Long 
3840 × 2160/59.94P, 50P, 29.97P, 
23.98P, 25P
1920 × 1080/59.94P, 50P, 59.94i, 50i, 
29.97P, 23.98P, 25P
MPEG HD 422 
1920 × 1080/59.94i, 50i, 29.97P, 
23.98P, 25P
1280 × 720/59.94P, 50P, 29.97P, 
23.98P, 25P
ProRes 422 HQ 1)

1920 × 1080/59.94i, 50i, 29.97P, 25P, 
23.98P
ProRes 422 1)

1920 × 1080/59.94i, 50i, 29.97P, 25P, 
23.98P

Tiempo de grabación/reproducción
XAVC Intra 4096 × 2160/3840 × 2160 
59.94P

Aprox. 22 minutos: con QD-G128A
Aprox. 11 minutos: con QD-G64A

50P
Aprox. 26 minutos: con QD-G128A
Aprox. 13 minutos: con QD-G64A

Especificaciones

General
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29.97P
Aprox. 44 minutos: con QD-G128A
Aprox. 22 minutos: con QD-G64A

23.98P
Aprox. 55 minutos: con QD-G128A
Aprox. 27 minutos: con QD-G64A

25P
Aprox. 52 minutos: con QD-G128A
Aprox. 26 minutos: con QD-G64A

XAVC Intra 1920 × 1080 
59.94P

Aprox. 59 minutos: con QD-G128A
Aprox. 30 minutos: con QD-G64A

50P
Aprox. 71 minutos: con QD-G128A
Aprox. 35 minutos: con QD-G64A

59.94i
Aprox. 118 minutos: con 
QD-G128A
Aprox. 59 minutos: con QD-G64A

50i
Aprox. 141 minutos: con 
QD-G128A
Aprox. 70 minutos: con QD-G64A

29.97P
Aprox. 118 minutos: con 
QD-G128A
Aprox. 59 minutos: con QD-G64A

23.98P
Aprox. 147 minutos: con 
QD-G128A
Aprox. 74 minutos: con QD-G64A

25P
Aprox. 141 minutos: con 
QD-G128A
Aprox. 70 minutos: con QD-G64A

XAVC Long 3840 × 2160 
59.94P/50P

Aprox. 87 minutos: con QD-G128A
Aprox. 44 minutos: con QD-G64A

29.97P/23.98P/25P
Aprox. 131 minutos: con 
QD-G128A
Aprox. 66 minutos: con QD-G64A

XAVC Long 1920 × 1080 
Modo 50M

Aprox. 262 minutos: con 
QD-G128A
Aprox. 131 minutos: con QD-G64A

Modo 35M
Aprox. 374 minutos: con 
QD-G128A
Aprox. 187 minutos: con QD-G64A

Modo 25M
Aprox. 524 minutos: con 
QD-G128A
Aprox. 262 minutos: con QD-G64A

MPEG HD 422 
Aprox. 262 minutos: con 
QD-G128A
Aprox. 131 minutos: con QD-G64A

ProRes 422 HQ 1)

59.94i/29.97P
Aprox. 60 minutos: con QD-G128A
Aprox. 30 minutos: con QD-G64A

50i/25P
Aprox. 72 minutos: con QD-G128A
Aprox. 36 minutos: con QD-G64A

23.98P
Aprox. 74 minutos: con QD-G128A
Aprox. 37 minutos: con QD-G64A

ProRes 422 1)

59.94i/29.97P
Aprox. 90 minutos: con QD-G128A
Aprox. 45 minutos: con QD-G64A

50i/25P
Aprox. 108 minutos: con QD-
G128A
Aprox. 54 minutos: con QD-G64A

23.98P
Aprox. 112 minutos: con QD-
G128A
Aprox. 56 minutos: con QD-G64A

1) Con la unidad XDCA-FS7 (opcional) 
conectada

Nota

El tiempo de grabación/reproducción puede variar 
debido a las condiciones de uso y a las características de 
la memoria.
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Dispositivo de generación de imágenes (tipo)
Sensor de imagen CMOS equivalente al 
formato Súper de 35

Número de píxeles
11,6 megapíxeles (totales), 
8,8 megapíxeles@17:9/
8,3 megapíxeles@16:9 (efectivos)

Filtros ND
1: Clear
2: 1/4ND
3: 1/16ND
4: 1/64ND

Sensibilidad
Gamma de vídeo: T14 @ 24p
(2000 lx, reflectancia del 89,9 %, 
3200K)

Sensibilidad ISO
S-Log3 Gamma ISO2000 (fuente de luz 
D55)

Iluminación mínima
0.7 lx (18 dB, 23.98P, Shutter: OFF, ND 
Clear, F1.4)

Montura del objetivo
Montura E

Latitud 14 pasos
Relación señal-ruido (S/N) de vídeo

57 dB (Gamma de vídeo/Supresión de 
ruido: desactivado)

Velocidad del obturador
De 1/3 a 1/9000 de s (23.98P)

Ángulo del obturador
De 4,2° a 359,7°
De 5,6° a 180° (23.98P)
De 5,6° a 216° (59.94P)
De 5,6° a 300° (50P)

Movimiento a cámara lenta y rápida
XAVC QFHD: de 1 a 60P 
XAVC HD: de 1 a 180P

Balance de blancos
Modo predeterminado, Modo de 
memoria A o B (de 1500K a 50 000K)

Ganancia
−3, 0, 3, 6, 9, 12, 18 dB

Curva Gamma
STD1, STD2, STD3, STD4, STD5, 
STD6, HG1, HG2, HG3, HG4, HG7, 
HG8, S-Log2, S-Log3, USER1, USER2, 
USER3, USER4, USER5

Frecuencia de muestreo
48 kHz

Cuantificación
24 bits

Respuesta en frecuencia
De 50 Hz a 20 kHz (±3 dB o menos)

Rango dinámico
90 dB (típico)

Distorsión
0,08 % o inferior (nivel de entrada de
−40 dBu)

Altavoz integrado
Monoaural

Micrófono interno
Monoaural

Entradas
INPUT 1/2:

Tipo XLR, 3 contactos, hembra
Conmutable entre LINE / MIC / 
MIC+48V
MIC: −40, −50, −60 dBu de referencia

Salidas
SDI OUT 1/2:

Tipo BNC, 0,8 Vp-p, no equilibrada 
(salida 3G HD/1.5G HD)
Compatible con el estándar 292M, 
ST424/425 Level-A/B de la SMPTE
Audio de 4 canales

Auriculares (minitoma estéreo):
−16 dBu (salida del nivel de referencia, 
volumen máximo del monitor, carga de 
16 Ω)

HDMI: Tipo A, 19 contactos

Otras
DC IN: compatible con EIAJ, de 11 V a 17 V de 

CC
Conector de la unidad de extensión:

Específico (144 contactos)
Zapata de interfaz múltiple:

Específica (21 contactos)

Sección de la cámara Sección de audio

Sección de entrada/salida
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REMOTE:
Tipo D-sub de 3 polos y 2,5 Φ

USB: Compatible con el estándar 2,0, tipo 
mini-AB para almacenamiento masivo 
(1)
Tipo A para conexión W-LAN (1) 

VF: Específica (40 contactos)

Monitor LCD
Tamaño de la pantalla

Diagonal de 8,8 cm (3,5 pulgadas)
Relación de aspecto

16:9
Número de píxeles

960 (H) × 540 (V)

Ranuras de tarjetas XQD para grabación de vídeo 
(2)
Ranura de tarjetas UTILITY SD (1)

Visor (incluidos el ocular, la copa del ocular, la 
varilla y la abrazadera)
Control remoto de la empuñadura
Módulo LAN inalámbrico USB (IFU-WLM3)
Control remoto de infrarrojos (RMT-845)
Adaptador de CA

MPA-AC1 (solo el modelo para EE. UU. 
y Canadá)

Entrada nominal: de 100 V a 240 V 
CA, 50 Hz/60 Hz, de 0,4 A a 0,75 A
Salida nominal: 12 V CC, 3 A

AC-NB12A (excepto el modelo para EE. 
UU. y Canadá)

Entrada nominal: de 100 V a 240 V 
CA, 50 Hz/60 Hz, de 0,35 A a 
0,65 A
Salida nominal: 12 V CC, 2,5 A

Batería (BP-U30)
Tensión máxima: 16,4 V CC
Tensión nominal: 14,4 V CC
Capacidad: 28 Wh

Cargador de batería (BC-U1)
Requisitos de alimentación: de 100 V a 
240 V CA, 50 Hz/60 Hz
Consumo de energía: 38 W
Salida nominal: 16,4 V en carga, 1,9 A/
1,5 A

Cables de alimentación (2)
Cable mini USB (1)
Soporte de montaje opcional (1)
Tapa de la montura del objetivo (1)
Tapa protectora del conector del asa (incluidos 2 
tornillos M2) (1)
Tapa del módulo LAN inalámbrico USB (2)
Tapa de repuesto del conector W-LAN (1)
Tapa de repuesto del conector de la unidad de 
extensión (1)
Kit de la zapata de accesorios (zapata de 
accesorios (1), placa de la zapata (1), tornillos (4))
Antes de utilizar esta unidad (1)
Manual de instrucciones (CD-ROM) (1)

El diseño y las especificaciones están sujetos a 
cambios sin previo aviso.

Sección de visualización

Sección de la ranura multimedia

Accesorios suministrados
SONY NO SE HACE RESPONSABLE POR 
DAÑOS DE NINGÚN TIPO DEBIDOS A LA 
OMISIÓN DE LAS MEDIDAS DE 
SEGURIDAD ADECUADAS EN 
DISPOSITIVOS DE TRANSMISIÓN, 
FUGAS DE DATOS INEVITABLES 
DERIVADAS DE LAS ESPECIFICACIONES 
DE TRANSMISIÓN O PROBLEMAS DE 
SEGURIDAD DE CUALQUIER TIPO.
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Cuando utilice la unidad con una conexión de PC, 
descargue todos los controladores del dispositivo, 
los complementos y las aplicaciones de software 
que necesite de los siguientes sitios web.

Sitio web de productos de Sony Professional:

Sony Creative Software, página de descarga de 
software:
http://www.sonycreativesoftware.com/download/
software_for_sony_equipment

Notas
• Haga siempre un ensayo de grabación y 

verifique que se grabó bien.
SONY NO SE HACE RESPONSABLE POR 
DAÑOS DE NINGÚN TIPO, 
INCLUYENDO PERO NO LIMITADO A 
LA COMPENSACIÓN O PAGO POR 
FALLO EN HACER CUALQUIER TIPO DE 
CONTENIDO DE GRABACIÓN POR 
MEDIO DE ESTA UNIDAD O SU 
SOPORTE DE GRABACIÓN, SISTEMAS 
DE MEMORIA EXTERNA O CUALQUIER 
OTRO SOPORTE O SISTEMAS DE 
MEMORIA.

• Verifique siempre que esta unidad funciona 
correctamente antes de utilizarlo. SONY NO 
SE HACE RESPONSABLE POR DAÑOS 
DE NINGÚN TIPO, INCLUYENDO PERO 
NO LIMITADO A LA COMPENSACIÓN O 
PAGO POR LA PÉRDIDA DE 
GANANCIAS PRESENTES O FUTURAS 
DEBIDO AL FALLO DE ESTA UNIDAD, 
YA SEA DURANTE LA VIGENCIA DE LA 
GARANTÍA O DESPUÉS DEL 
VENCIMIENTO DE LA GARANTÍA NI 
POR CUALQUIER OTRA RAZÓN.

• SONY NO SE HACE RESPONSABLE POR 
RECLAMACIONES DE NINGÚN TIPO 
REALIZADAS POR USUARIOS DE ESTA 
UNIDAD O POR TERCEROS.

• SONY NO SE HACE RESPONSABLE POR 
LA PERDIDA, REPARACIÓN O 
REPRODUCCIÓN DE CUALQUIER DATO 
GRABADO EN EL SISTEMA DE 
ALMACENAMIENTO INTERNO, 
SOPORTES DE GRABACIÓN, SISTEMAS 
DE ALMACENAMIENTO EXTERNO O 
CUALQUIER OTRO SISTEMA DE 
ALMACENAMIENTO.

• SONY NO SE HACE RESPONSABLE DE 
LA FINALIZACIÓN NI DE LA 
INTERRUPCIÓN, POR LA 
CIRCUNSTANCIA QUE FUERA, DE 
CUALQUIER SERVICIO RELACIONADO 
CON ESTA UNIDAD.

Descargas de software

Estados Unidos http://pro.sony.com

Canadá http://www.sonybiz.ca

Latinoamérica http://sonypro-latin.com

Europa http://www.pro.sony.eu/pro

Oriente Medio y 
África

http://sony-psmea.com

Rusia http://sony.ru/pro/

Brasil http://sonypro.com.br

Australia http://pro.sony.com.au

Nueva Zelanda http://pro.sony.co.nz

Japón http://www.sonybsc.com

Asia Pacífico http://pro.sony-asia.com

Corea http://bp.sony.co.kr

China http://pro.sony.com.cn

India http://pro.sony.co.in
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XDCAM es una marca comercial de Sony 
Corporation.
• XAVC y  son marcas comerciales 

registradas de Sony Corporation.
• XQD y  son marcas comerciales de 

Sony Corporation.
• HDMI, el logotipo de HDMI y High-Definition 

Multimedia Interface son marcas comerciales o 
marcas comerciales registradas de HDMI 
Licensing, LLC en Estados Unidos y en otros 
países.

Todos los demás nombres de compañías y de 
productos son marcas comerciales registradas o 
marcas comerciales de sus respectivos 
propietarios. En este documento, no se utilizan 
los símbolos ® o ™ para indicar los elementos 
con marca registrada.

Marcas comerciales
131




	Lista de contenidos
	Descripción general
	Configuración del sistema
	Ubicación y función de los componentes
	Visor
	Ocular
	Objetivo (solo PXW-FS7K)
	Control remoto de la empuñadura
	Control remoto de infrarrojos
	Unidad de extensión (opcional)

	Visualización de la pantalla
	Pantalla del visor
	Pantalla de estado


	Preparación
	Fuente de alimentación
	Utilización de una batería
	Utilización de la alimentación por CA

	Acople de dispositivos
	Acople del soporte de micrófono
	Acople del visor
	Acople del ocular
	Acople de un objetivo
	Acople del control remoto de la empuñadura

	Ajuste del reloj
	Configuración del funcionamiento básico del camcorder
	Modo de filmación
	Espacio de color

	Utilización de tarjetas de memoria XQD
	Acerca de las tarjetas de memoria XQD
	Soportes recomendados
	Introducción de una tarjeta de memoria XQD
	Extracción de tarjetas de memoria XQD
	Intercambio de tarjetas de memoria XQD
	Formateo (inicialización) de tarjetas de memoria XQD
	Comprobación del tiempo de grabación restante

	Utilización de una tarjeta UTILITY SD
	Tarjetas SD compatibles
	Introducción de una tarjeta SD
	Extracción de la tarjeta SD
	Formateo (inicialización) de tarjetas SD
	Comprobación de la capacidad restante

	Uso de la XDCA-FS7
	Acople de la XDCA-FS7
	Extracción de la XDCA-FS7
	Colocación de la batería
	Extracción de la batería
	Cambio de la entrada/salida de código de tiempo

	Uso de las unidades HXR-IFR5 y AXS-R5
	Conexión de la HXR-IFR5 al camcorder
	Extracción de la HXR-IFR5

	Uso del control remoto de infrarrojos
	Uso del control remoto Wi-Fi

	Filmación
	Procedimiento básico de funcionamiento
	Ajuste automático del enfoque
	Ajuste manual del enfoque
	Control del audio
	Intercambio de tarjetas de memoria XQD

	Cambio de la configuración básica
	Selección del formato de grabación
	Ajuste del brillo
	Ajuste de colores naturales (balance de blancos)
	Especificación del audio que se va a grabar
	Especificación de los datos de tiempo

	Funciones útiles
	Botones/diales asignables
	Movimiento a cámara lenta y rápida
	Grabación de memoria intermedia de imágenes (Picture Cache Rec)
	Revisión de una grabación (Rec Review)
	Modo Self Portrait (autorretrato)
	Visualización de la nitidez
	Visualización de cebra
	Obtención de la información de ubicación (GPS)
	Filmación en modo Cine El
	Grabación de vídeos RAW
	Adición de conectores de entrada de audio

	Conexión de dispositivos con LAN inalámbrica
	Acople del IFU-WLM3
	Acople del CBK-WA100
	Conexión con un toque de dispositivos con NFC (solo para el IFU-WLM3)

	Visualización del control remoto Wi-Fi

	Pantalla de imágenes en miniatura
	Pantalla de imágenes en miniatura
	Diseño de la pantalla

	Reproducción de clips
	Reproducción de clips grabados

	Operaciones con clips
	Operaciones con el menú de imágenes en miniatura
	Elementos del menú Thumbnail


	Pantalla de menús y ajustes
	Configuración del menú de ajustes y jerarquía
	Organización del menú de configuración

	Operaciones del menú de configuración
	Lista del menú de configuración
	Menú User
	Menú Edit User
	Menú Camera
	Menú Paint
	Menú Audio
	Menú Video
	Menú VF
	Menú TC/UB
	Menú Recording
	Menú Thumbnail
	Menú Media
	Menú File
	Menú System


	Conexión de dispositivos externos
	Conexión de dispositivos de grabación y monitores externos
	Sincronización externa
	Gestión/Edición de clips con un ordenador
	Conexión con un cable USB


	Apéndice
	Precauciones de uso
	Limitaciones y formatos de salida
	Formatos de vídeo y señales de salida

	Advertencias de funcionamiento
	Mensajes de error
	Mensajes de advertencia
	Mensajes de precaución y de funcionamiento

	Licencias
	Licencia de la cartera de patentes de MPEG-4 AVC
	Licencia MPEG-2 Video Patent Portfolio
	Obtención del software con la licencia GPL/LGPL
	CONTRATO DE LICENCIA DE USUARIO FINAL
	Licencias de software libre

	Especificaciones
	General
	Sección de la cámara
	Sección de audio
	Sección de entrada/salida
	Sección de visualización
	Sección de la ranura multimedia
	Accesorios suministrados
	Descargas de software
	Marcas comerciales





